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Introduction

This section provides information that you should know 
before reading the User’s Guide for the ELC-MVS01 Live 
Production Control Software.  

Configuration of This Guide

The User’s Guide explains how to set up and operate the 
ELC-MVS01 software. It is composed of the following 
groups: 

Overview 
Chapter 1 explains the basic concepts of the ELC-MVS01 
software, its four component applications, system 
configurations, and workflow. 
Chapter 2 explains the names and functions of each part in 
the five major windows of the ELC-MVS01 software:  
Initial Setup, Icon Manager, ELC Plug-in, Playlist Viewer, 
and OA Playlist. 

Preparations
The Chapters from 3 to 5 explain preparations and setup 
that mainly technical directors or system integrator should 
be responsible for before making news programs: making 
the initial setup with the Initial Setup application, creating 
Icons with the Icon Manager, and making cues in the ELC 
Plug-in application.  If necessary, ELC operators can refer 
to and change required settings.
Chapter 6 provides preparation that technical directors 
should be responsible for when they use advanced 
functions of the software, such as switching multiple 
snapshots and videos, manually.

Operations 
Chapters 7 and 8 instruct ELC operators on how to create 
a playlist based on a rundown they have created on NRCS 
(ELC Plug-in/Playlist Viewer applications). Chapter 9 
provides information on how to create and edit a playlist 
using the Playlist Viewer application from scratch.
Chapter 10 explains a series of procedures to play out the 
created playlist with the OA Playlist application. 
Chapter 11 explains how to execute the settings made in 
Chapter 6; how to recall multiple snapshots, such as 2Box 
effects, manually, and how to switch video manually 
(Manual Switching).

Appendix
The section consists of glossary and index.

Notational Conventions

• The plus sign (+) is used to indicate that two keys on the 
keyboard should be pressed at the same time. For 
example, Ctrl + C means to press the C key while 
holding the Ctrl key down.

• Square brackets ([  ]) are used to indicate a menu that 
should be used or button command that should be 
clicked to perform an intended operation.

• The greater than sign (>) is used to indicate that a menu 
subcommand is located below another menu command.
For example, [Tools] > [Plug-in] means that the [Plug-
in] command is a subcommand of the [Tools] command.

Notice for the pictures on this guide
The pictures used in this guide may be different from the 
ones actually displayed and are subject to change without 
notice.



Overview
This section explains the basic concepts of the ELC-MVS01 
software, its component applications, system configurations, 
workflows, and elements of a playlist.  It also explains the names and 
functions of each part in the major windows of the ELC-MVS01 
software:  Initial Setup, Icon Manager, ELC Plug-in, Playlist Viewer, 
and OA Playlist. 

Chapter 1   Overview....................................................................... 11

Chapter 2   Names and Functions of Parts.................................... 20
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Features

The ELC-MVS01 Live Production Control Software 
provides an automation solution for the News Room 
Computer System (hereinafter referred to as “NRCS” in 
this manual), taking full advantage of the unprecedented 
high performance and multifunctionality of the Sony 
MVS-8000 Multi Format Switcher system. The following 
are some of the principal features of this software.

NRCS Centric
The ELC-MVS01, when incorporated into an existing 
NRCS-centric broadcast system, allows you to utilize the 
existing workflows to create programs. It automates 
control over devices which used to be manually controlled 
by a specialized operator. 

Complex device control taking advantage of the  
Sony MVS-8000 network
Coupled with an MVS-8000 system, the ELC-MVS01 
automates control over robotic cameras, audio mixer, disk 
recorder, audio servers, playout server, or any other MVS-
8000 system components.

Enhanced flexibility with manual operations
In addition to its versatile automation features, the ELC-
MVS01 also provides flexible manual on-air operations, 
including adjustment of audio levels, or inserting or 
deleting the DSK.

Real-time synchronization and update of playlists
If NRCS rundown changes occur, real-time 
synchronization updates the ELC-MVS01 playlist 
(referred to as “ELC playlist” in this manual), so that you 
can cope with last minute modifications.

An easy-to-use graphic user interface 
The ELC-MVS01 software offers an easy-to-use graphic 
user interface which navigates you through a series of 
program creation procedures: allocating frequently-used 
settings to an icon, using icons to create a cue, using cues 
to create a playlist, and finally playing out a playlist, all in 
integrated, simple-to-operate operation windows.

ELC-MVS01 Software 
Products

The ELC-MVS01 Live Production Control Software 
system consists of the following software components, 
products, and optional software products.

Software Components Products

The ELC-MVS01 Live Production Control Software 
consists of the following applications:

• ELC Plug-in (including a five-user license)
This application allows you to register frequently-used 
scenes as a “cue” (Quick Cue), and set or edit a cue (Cue 
Edit). It also allows you to create a playlist.
(The software works as a plug-in to the NRCS client 
software.)

• ELC Playlist Viewer (including a five-user 
license)
This application allows you to view playlists 
corresponding to rundowns created with NRCS. It also 
allows you to create and edit playlists from scratch.
(The software works as an independent application.)

• Icon Manager 
This application is used to associate frequently-used 
device settings with Video, Audio, Transition, and 
Effect Icons for easily creating playlists.

• ELC OA Playlist
This application is used to play out created playlists. 

• Initial Setup
This application is used to set up the system 
occasionally, for example, when a new news program is 
planned.
11Features / ELC-MVS01 Software Products
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• System Setup
This application is used to set up the system for system 
integration purposes. To use this application, access to 
the Sony web site for the system setup.  
For details, contact your Sony service representative.

• Alarm Monitor
This application is used to monitor system services and 
applications. 
The Alarm Monitor application also allows the operator 
to view a list of errors that have occurred.

Optional Software Products 

As an optional software product, the ELC-MVS01 Live 
Production Control Software offers the following:

• BZEL-MVS11 Sony Redundant Control 
Software
This product is used to configure a redundant system for 
ELC-MVS01. Using this software to configure two PCs, 
one as the main PC, and one as the backup, allows you 
to continue working, even if the main PC experiences a 
problem. Switchover is accomplished by means of a 
simple operation.

• BZEL-MVS21 Sony NRCS Plug-in Software
This product contains an additional five-user licenses for 
the ELC Plug-in application and the Playlist Viewer. 
These are floating licenses. 

• BZEL-MVS41 Sony Audio Mixer I/F Software
This product aims to control an audio mixer from the 
ELC-MVS01.

• BZEL-MVS51 Sony Camera Robotics I/F 
Software
This product aims to control robotic cameras from the 
ELC-MVS01.
ELC-MVS01 Software Products
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System Configurations

Basic System Configuration

The ELC-MVS01 Live Production Control Software 
supports flexible NRCS-centric system configurations 
with an MVS-8000 system, audio mixer, robotic camera, 
audio server, playout server, CG and other devices. 

The following illustration shows an example image of the  
basic system configuration with the NRCS.

Equipment to be Used in the System 

This section explains major devices to be used with the 
ELC-MVS01 Live Production Control Software system: 

Devices required for ELC-MVS01 control 
(Shown on a gray background  in the 
system configuration diagram)
• Shot Box Module

The shot box module is used for allocating a variety of 
manual operations to its 96 operation buttons. This 
module is required when you forward an ELC playlist 
with the TAKE button, or inserting or deleting the DSK. 
Up to two modules can be connected, each module can 
be assigned to identical or different function tables.

• Audio Fader Panel
The audio fader panel allows you to associate a total of 
16 audio mixer channels with its eight faders, and to 
adjust audio levels, change PFL(Cue) and Mix-minus 
settings, and turn the channels on and off.
Its front eight faders automatically change their 
assignment settings and adjust audio levels according to 
the process in a playlist. For the back eight faders, the 
assignments are fixed and audio levels should be 
adjusted manually.
13System Configurations
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Devices under ELC-MVS01’s control
(Connected with black dash-dot lines in 
the system configuration diagram)
The following devices perform on-air operations 
according to the ELC playlist under the ELC-MVS01’s 
control:
• Video Switcher

The switcher uses an M/E for OA video effects and 
another M/E for NEXT video effects, and uses PGM/
PST to switch OA and NEXT video signals.
It controls Keys manually or automatically according to 
the ELC-MVS01’s settings, and controls the DSK 
manually. The ELC-MVS01 does not make the DSK 
settings, but it uses the settings (Initial Snapshot) 
automatically loaded when the OA Playlist application is 
started.

• DDR (VDCP)
The DDR (VDCP) is a disk recorder that the ELC-
MVS01 can control with VDCP (Video Disk Control 
Protocol). You should register and list necessary video 
files to be used in the ELC-MVS01 in advance by using 
the Initial Setup application. 

• DDR (SonyVTR)
The DDR (SonyVTR) is a disk recorder that the ELC-
MVS01 can control with Sony VTR Protocol. You can 
use the desired video materials in the recorder by 
specifying the IN point.

• Audio Server
You should register and list necessary audio files to be 
used in the ELC-MVS01 in advance by using the Initial 
Setup application. While preparing a cue, you can 
specify the file names in the list.

• Robotic Camera
The ELC-MVS01 recalls the shots of the robotic camera. 
Since manual control from the ELC-MVS01 is not 
available, the controllers supplied with the robotic 
camera system is to be used.

• Audio Mixer
The ELC-MVS01 controls the audio levels, Ch On/Off, 
changes in Mix-minus settings, and the function of the 
audio mixer, automatically. Use of the audio fader panel 
enables manual control of audio channels for 16 faders.
Depending on the type of input signals, there are two 
types of audio mixers: 
- Stereo fader mixer: handles stereo signals for each 

input channel fader. This type of mixer is referred to as 
a “stereo fader mixer” in this manual. 

- Mono fader mixer: handles monaural signals for each 
input channel fader. This type of mixer is referred to as 
a “mono fader mixer” in this manual.

• Studio Monitor
The ELC-MVS01 controls images output to the studio 
monitors that are connected to the AUX buses of the 
video switcher.

 Devices beyond ELC-MVS01’s control 
(Connected with black solid lines in the 
system configuration diagram)
The following devices usually interface to NRCS and get 
Rundown. They have their own playlist creation functions. 
A change in the NRCS rundown is directly reflected, while 
changes in the ELC playlist in the OA Playlist application 
will not be reflected and manual changes are required. To 
control manual operation, you need the control panel 
supplied with each device.

• CG (Character Generator)
CG is the server of CG or still images. After receiving   
Off from the Tally of the switcher, it prepares the next 
materials.

• Playout Server
The playout server is an audio and video server that 
contains daily-changing materials. The server receives a 
GPI from the ELC-MVS01, and plays the materials. 
Usually, the ELC-MVS01 does not specify files or make 
channel settings, which are specified or made in the 
NRCS system, but specifying a specific channel to be 
used is also possible.
System Configurations
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Basic Operation Flow

The following flowchart shows an example of the 
operations when the system is installed.
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• Creating Icons (page 90)

• Creating Categories (page 102)

• Editing Cues (iNEWS:page 174 /ENPS: page 182 /
Without NRCS: page 195)

• Creating a Playlist (iNEWS:page 169 /ENPS: page 180 /
Without NRCS: page 188)

• Viewing a Playlist (iNEWS:page 176 /ENPS: page 184)
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• Playing out a Playlist (page 201)

• Toggling the Duration Between Fixed/
Unfixed (page 208) 

• Changing the Playlist Order (page 210)

• Controlling Downstream Keys
 (page 212)

• Controlling Keys (page 214)

• Adjusting Audio Level (page 215)

• Changing the Side Flag Settings 
(page 206)

• Editing Cues in the OA Playlist or 
Playlist Viewer Window (page 220)

• Switching Multiple Snapshots 
Manually (page 222)

• Switching Video Manually (page 224)

• Outputting GPI Trigger Pulses (page 226)

• Getting Cues that are Not on the 
Playlist to the Air (page 227)

• Enabling/Disabling Camera or Audio 
Mixer Control (page 229, page 230)

• Overriding the Transition Settings for 
the NEXT Cue (page 231)

• Switching a Video or Audio Device to 
Its Backup (page 232, page 233)

• Creating Cues (page 118)

• Editing Cues (page 132)

• Making Initial Setup (page 50)

Frequently-used manual operations Advanced or occasional manual operations
15Basic Operation Flow
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Overview of Playlist Creation

Playlist Creation Flow

The ELC-MVS01 provides the ELC Plug-in application 
for the NRCS client software to create a playlist, and the 
Playlist Viewer application to view the created playlist. 
The images below show how an ELC operator uses both 
applications to create a rundown and view a playlist in a 
news room.
You can create a playlist easily by adding a cue from the 
Quick Cue of the ELC Plug-in to the NRCS client window 
as an ELC object, which is called “Production cue” for 
iNEWS and “Item” for ENPS.

Whether you use iNEWS or ENPS as an NRCS, the 
windows and playlist creation operations differ. See either 
of the sections below according to your NRCS type.

In addition to the ELC Plug-in application, the ELC-
MVS01 also provides the Playlist Viewer application that 
enables you to create and edit playlists. 

For details, see “Creating a Playlist without Using 
NRCS” on page 186.

When using iNEWS

A playlist can be created, viewed, and played out as 
follows: 

For ELC production cue settings, see “Rules in setting 
ELC production cues” on page 171.

ELC Plug-in
(Quick Cue)

iNEWS

ELC Playlist

Cue 
Each icon 
represents a 
cue, i.e., 
frequently-
used scenes.

Location Purpose Operator Operations in the iNEWS window Display in the ELC Playlist Ref.page

News- 
room

Creating 
a news 
program

Producer A Create a rundown (baseline of a program) 
using the iNEWS client. (Conventional 
operation)

. Rundown is created.

b At this time, there are no ELC 
settings made for the rundown.

. Playlist is not created.

ELC 
Operator

B Add a cue in the Quick Cue of the ELC  
Plug-in to the iNEWS rundown as a 
production cue with a drag-and-drop 
operation.

b

D Production cues with the 
same page number make an 
ELC story. Cues appear in a 
playlist.

. Playlist is created.

page 
169

C Assign channels for CG or playout server 
for the iNEWS client. Then save the 
rundown.(Conventional operation)

page 
171

3

Overview of Playlist Creation
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When using ENPS

A playlist can be created, viewed, and played out as 
follows: 

For ELC production cue settings, see “Rules in setting 
ELC items” on page 182.

Control 
Sub 
room

On the 
air

Producer Change the rundown order in the iNEWS 
client. (Conventional operation)

b

Changes in the rundown will be 
reflected.

ELC 
Operator

• Add a production cue or edit cues even 
while on the air (except for the OA Cue).

• Change the channel assigned for the CG or 
playout server for the iNEWS client. 
(Conventional operation)

• Skip stories on the rundown separately on 
the iNEWS client, on each device, or in the 
ELC Plug-in application.(Conventional 
operation)

page 
174
pages 
14, 171

page 14

Location Purpose Operator Operations in the iNEWS window Display in the ELC Playlist Ref.page

ELC Plug-in
(Quick Cue)

ENPS ELC Playlist

Cue 
Each icon 
represents a 
cue, i.e., 
frequently-
used scenes.

Location Purpose Operator Operations in the ENPS window Display in the ELC Playlist Ref.page

News- 
room

Creating 
a news 
program

Producer A Create a rundown (baseline of a program) 
using the ENPS client. (Conventional 
operation)

. Rundown is created.

b At this time, there are no ELC 
settings made for the rundown.

. Playlist is not created.

ELC 
Operator

B Add a cue in the Quick Cue of the ELC  
Plug-in to the ENPS rundown as an Item 
with a drag-and-drop operation.

b

D Items with the same Slug 
make an ELC story. Cues 
appear in a playlist.

. Playlist is created.

page 
180

A Assign channels for CG or playout server 
for the ENPS client. Then save the 
rundown. (Conventional operation)

3

17Overview of Playlist Creation
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When not using NRCS
A playlist can be created from scratch and edited in the 
Playlist Viewer window without using NRCS. It can be 
used for playout operation, too, as follows: 

Control 
Sub 
room

On the 
air

Producer Changing the rundown order in the ENPS 
client. (Conventional operation)

b

Changes in the rundown will be 
reflected.

ELC 
Operator

• Add an Item or edit cues even while on the air 
(except for the OA Cue).

• Change the channel assigned for the CG or 
playout server for the ENPS client. 
(Conventional operation)

• Skip stories on the rundown separately on 
the ENPS client, on each device, or in the 
ELC Plug-in application.(Conventional 
operation)

page 
182
pages 
14, 182

page 14

Location Purpose Operator Operations in the ENPS window Display in the ELC Playlist Ref.page

Location Purpose Operator Operations Ref.page

News- 
room

Creating 
a news 
program

Producer 
or ELC 
Operator

Create a playlist using the Playlist Viewer application by adding cues prepared in the 
Quick Cue window, and editing cues.

. Playlist is created.

page 
186

Control 
Sub 
room

On the 
air

Producer 
or ELC 
Operator

On-air operations using the OA Playlist application.
Even while the playlist is being used for on-air operation, the both Playlist Viewer 
application in the full-edit mode and the OA Playlist application allow you the 
following operations, respectively. (The OA Cue cannot be edited or deleted though.)
• The Playlist Viewer application allows editing, adding, deleting, and moving of a 

cue, as well as editing, adding, deleting, and moving of a story.
• The OA Playlist application allows editing of a cue.

page 
201

page 
191
page 
220
Overview of Playlist Creation
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Elements of a Playlist

This section explains the elements of a playlist. The 
following shows the relationship between an Icon, a cue, a 
story, and a playlist in the Playlist Viewer application:

 

Icon
An Icon is a graphic representing settings of a video 
switcher, audio mixer, and devices for materials including 
cameras, servers, and CG.  
There are the following four types of Icons:

• Video Icon
A Video Icon represents video materials from the 
camera, playout server, CG, and DDR. 

• Audio Icon
An Audio Icon represents audio materials from an audio 
server, or video server. 

• Transition Icon
A Transition Icon represents a transition setting. 

• Effect Icon
An Effect Icon represents a setting of compound video 
effects. 

Cue
A cue is composed of Icons and their detailed settings. It is 
the minimum unit, a frequently-used scene, to be taken by 
the TAKE button. A cue can be registered in advance in the 
ELC Plug-in application or in the Quick Cue window of 
the Playlist Viewer application. You can then easily set a 

pre-registered cue in the playlist in the Playlist Viewer 
window. You can also open the Cue Edit window from the 
Playlist Viewer application and OA Playlist application, 
and edit previously created cues.

ELC Story
An ELC Story definition differs between iNEWS and 
ENPS:
• In iNEWS: A group of cues with the same NRCS Page 

number is defined as an ELC story.
• In ENPS: A group of cues with the same NRCS Slug is 

defined as an ELC story.

Playlist
A playlist is a list of ELC stories placed in the order to be 
played out. 

ELC Story

Icon

Cue

Playlist 

Slug

Page
19Overview of Playlist Creation
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Names and Functions of 
Parts
Initial Setup Window

The Initial Setup application is designed for technical 
directors to make required setup for routine operations 
when a new program is planned or there is a change on a 
device on a studio. 
To open the Initial Setup main menu, double-click the 
Initial Setup icon on the desktop. From the Initial Setup 
Main Menu, you can select the following sub menus:

• Video Switcher Settings: It allows you to associate 
a V/K pair number of the video switcher with an Icon. 

• Audio Mixer Settings: It allows you to associate the 
input fader number of the audio mixer with an Icon, and 
specifies audio level options of the ELC-MVS01. It also 
associates each fader number of the Audio Fader panel 
with a device icon registered in the ELC-MVS01, so that 
automatic or manual control from the ELC-MVS01 
becomes enabled. 

• Shot Box Module Assign: It allows you to assign  
functions to be used for manual on-air operations to the 
buttons on the shot box module.

• DDR(VDCP) File List Creation: It allows you to 
register the files of DDR(VDCP) to be used in the ELC-
MVS01 software.

• Audio Server File List Creation: It allows you to 
register the files of the audio server to be used in the 
ELC-MVS01 software.

• Studio Monitor Settings: It allows you to make the 
settings required for the AUX buses for studio monitors.

You can also view the windows of the Initial Setup 
application in the System Setup application.

Initial Setup Main Menu

1 Menu bar

2 Sub menus
Initial Setup Window
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a  Menu bar
The Menu bar provides menus for using the Initial Setup.

• File menu: 
Exit: Exits the Initial Setup menu.

• Help menu: 
Version: Displays the Initial Setup version number.
Help: Displays this User’s Guide.

b Sub menus
Click the desired sub menu line to open the setting window 
for the selected menu option.

For the Initial Setup Application, see “Starting the Initial 
Setup Application” on page 51.

Video Switcher Settings Window

a V/K Pair No. Setup list
Allocate the V/K pair number of switcher to an ELC-
MVS01 Video Icon:

• V/K Pair No.: A fixed number between 1 to 128 is 
displayed, which has been specified by the switcher.

• Source Name:  The source name of the video specified 
by the switcher is displayed in up to 16 alphanumeric 
characters. 

• Device(V): Select the device to be used for the  video 
signal, which corresponds to a V/K pair number, to be 
displayed in the selected Class.

• Device(K): Select the device to be used for the key 
signal. 
This setting is for a DDR(VDCP) device only, and is not 
necessary when the device for video and the device for 
the key signal are identical.

• Backup Device(V): Select the backup device for 
Device(V).

b Import button
Press this button to import the source names of the video 
signals from the switcher.

c Class drop-down list box
Select the desired class to narrow down the devices to be 
displayed for the selected line on the list, since devices are 
classified into classes.

d Video Transition Rate Setting block
Select an option for the video transition rate to be 
displayed in the Cue Edit window.

e Key Transition Rate Setting block
Select an option for the key transition rate to be displayed 
in the Cue Edit window.

f Save button
Press this button to save the settings.

1 V/K Pair No. Setup 
list

5 Key Transition Rate 
Setting block

2 Import button

7 Close button

4 Video Transition 
Rate Setting block

6 Save button

3 Class drop-down list 
box
21Initial Setup Window
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g Close button
Press this button to close the Video Switcher Settings 
window.

For the settings on the Video Switcher Settings window, 
see “Making the Video Switcher Settings” on page 53.

Audio Mixer Settings Window

There are two tabs in the Audio Mixer Settings window: 
the Fader No. Setup tab and the Mix-Minus Bus tab.

The Audio Level setting block, Fade IN/Out Time Setting 
block, Save and Close buttons are shared by the two tabs.

3 Fade In/Out Time 
Setting block

5 Close button

4 Save button

1 Fader No. Setup 
/ Mix-Minus Bus 
tabs

2 Audio Level Setting 
block
Initial Setup Window
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a Fader No. Setup tab/Mix-Minus Bus tab

1 Fader No. setup list
Depending on the type of the audio mixer used, either, a 
stereo fader mixer or a mono fader mixer, the contents of 
the window differ.
This list is used to allocate the input Fader number of the 
audio mixer to an Audio Icon:

• Fader No.: A fader number of an audio mixer panel is 
displayed according to the Device Setup settings of the 
System Setup application.
For a mono fader mixer, the fader number displayed in 
this column may differ from that displayed on the audio 
mixer panel. 

• Source Name: The source name of the audio input 
specified with the mixer is displayed in up to eight 
alphanumeric characters. 
When a mono fader mixer is being used and the fader is 
paired, the source name for the odd fader number is 
displayed.
When an audio mixer that does not allow you to import 
the source names specified on it is used, you can enter 
source names of up to eight alphanumeric characters in 
this window.

• Control: Enable or disable automatic or manual fader 
control from the ELC-MVS01 system. (Including 
assignment of an Audio Icon to the audio fader panel.)

• Device: Select the device in the selected Class 
corresponding to the input Fader number. 

• Backup Device: Select the backup device in the 
selected Class corresponding to the input Fader number.

• Stereo/Mono*: Displays the Device Setup settings of 
the System Setup application for how the fader is 
controlled, in stereo or monaural:
Stereo: The fader is paired and controlled in stereo.
Mono: The fader is used and controlled monaurally.

• MonoCh*: Displays the channels actually controlled 
according to the Stereo/Mono setting of the Device 
Setup of the System Setup application. 

* Displayed only when a mono fader mixer is being used.

2 Import button
Press this button to import the source name of the input 
audio from the audio mixer.

3 Class drop-down list box
Select the desired class to narrow down the devices to be 
displayed for the selected line on the list, since devices are 
classified into classes.

2 Import button 3 Class drop-down list box

1 Fader No. setup listFader No. Setup tab
23Initial Setup Window
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1 Mix-minus bus list
The name of each AUX bus of the audio mixer is 
displayed. You can rename it in up to eight alphanumeric 
characters.

b Audio Level Setting block
Set the Audio Level options to be displayed in the Cue Edit 
window.

c Fade In/Out Time Setting block
Set the Fade In/Out Time options to be displayed in the 
Cue Edit window.

d Save button
Press this button to save the settings.

e Close button
Press this button to close the Audio Mixer Settings 
window.

For the settings on the Audio Mixer Settings window, see 
“Making the Audio Mixer Settings” on page 57.

1 Mix-minus bus list

Mix-Minus Bus tab
Initial Setup Window
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Shot Box Module Assign Window

a Table Assign
Select the table to be assigned to the shot box module.
When there are two modules, the modules can be assigned 
to the identical or different tables.

b Assign List
The list of functions assignment to buttons on the shot box 
module is displayed.

• Table No.:  The number of the table on which the 
functions are assigned to the shot box module buttons. 

• BANK 1 to 4 tabs: Select the desired BANK tab 
corresponding to the BANK button on the shot box 
module. 

• No.:  The button number for the selected BANK on the 
shot box module to which the function is assigned. 

• Name: The name of the assigned function, which is 
displayed on the relevant button on the shot box module. 
You can rename it in up to eight alphanumeric characters 
by clicking the relevant column.

• Function: The function assigned on the button is 
displayed.  

c Delete button
Press this button to delete the selected function from the 
Assign List.

d Button Layout
The button layout of the shot box module is displayed, to 
help you identify the location of the button specified in the 
“No.” column of the Assign List.

e CADD button
Press this button to add the selected function of the 
Function List to the Assign List.

f Function List
Select the function that you want to assign to a button on 
the shot box module. 
Functions are grouped. Select the desired group using the 
Function Group drop-down list box to narrow down the 
functions to be displayed.

g Save button
Press this button to save the settings.

h Close button
Press this button to close the Shot Box Module Assign  
window.

For the settings on the Shot Box Module Assign window, 
see “Assigning Functions to the Shot Box Module 
Buttons” on page 65.

2 Assign List

5 CADD button

8 Close button

7 Save button

6 Function List

4 Button Layout

3 Delete button

1 Table Assign
25Initial Setup Window
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DDR(VDCP) File List Creation Window

a Device box
Select the desired DDR(VDCP) device for which you 
would like to create a file list. 

b File List
A list of files added from the DDR(VDCP) which are 
ready for use with the ELC-MVS01 is displayed.
• No.: Series numbers of the added files.
• Video: The name, up to 23 alphanumeric characters of 

the video file stored on the DDR(VDCP).
• Key: The name, up to 23 alphanumeric characters of the 

key file stored on the DDR(VDCP).
• Duration: The length of the file stored on the 

DDR(VDCP) in HH:MM:SS:FF.  

c Delete button
Press this button to delete the selected file from the File 
List.

d Import button
Press this button to import the File Name and Duration 
information of the files from the DDR(VDCP). 

e CADD button
Press this button to add the selected file of the Source 
Library to the File List.

f Video/Key Select box
Select Video or Key to switch the display on the Source 
Library when using key files from a different device (unit/
channel) from the device used for video files. 

The device for the key files should be specified in the 
Video Switcher Settings window in advance.

g Source Library
The files stored on the device selected in the Device box 
and to be added to the File List are displayed. The 
displayed files differ, depending on the selection in the 
Video/Key Select box.
• No.:  Series numbers of the files stored in the 

DDR(VDCP).
• File Name: The name, up to 23 alphanumeric 

characters of the file stored on the DDR(VDCP).
• Duration: The length of the file stored on the 

DDR(VDCP) in HH:MM:SS:FF.  
For a device that is controlled by the simple VDCP, 
however, the durations are not displayed.

Select the line of the file you want to add to the File List.

h Save button
Press this button to save the settings.

i Close button
Press this button to close the DDR(VDCP) File List 
Creation window.

For the settings on the DDR(VDCP) File List Creation 
window, see “Managing Video Material - Creating the 
DDR(VDCP) File List” on page 73.

2 File List

5 CADD button

3Delete button

9 Close button

8 Save button

7 Source Library

1 Device box

4 Import 
button

6 Video/Key 
Select box
Initial Setup Window
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Audio Server File List Creation Window

a Device box
Select the desired device for which you would like to 
create a file list, so that the files will be displayed both in 
the File List and the Source Library. 

b File List
Displays the list of files added from the audio server which 
are ready for use with the ELC-MVS01.
• No.:  Series numbers of the added files.
• File Name: The name, up to 23 alphanumeric 

characters of the file stored on the audio server.
• Duration: The length of the file stored on the audio 

server in HH:MM:SS:FF.  

c Delete button
Press this button to delete the selected file from the File 
List.

d CADD button
Press this button to add the selected file of the Source 
Library to the File List.

e Source Library
The files stored on the audio server are displayed.
• No.:  Series numbers of the files stored in the audio 

server.
• File Name: The name, up to 23 alphanumeric 

characters of the file stored on the audio server.
• Duration: The length of the file stored on the audio 

server in HH:MM:SS:FF.  
Select the line of the file you want to add to the File List.

f Import button
Press this button to import the File Name and Duration 
information of the files from the audio server. 

g Save button
Press this button to save the settings.

h Close button
Press this button to close the Audio Server File List 
Creation window.

For the settings on the Audio Server File List Creation 
window, see “Managing Audio Material - Creating the 
Audio Server File List” on page 77.

2 File List

3Delete button

1 Device box 4 CADD button

8 Close button

6 Import button

7 Save button

5 Source Library
27Initial Setup Window
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Studio Monitor Settings Window

a AUX bus setup list
The list of AUX buses of the switcher and the settings for 
the respective buses is displayed. The AUX buses are used 
for output signals to the studio monitors.

• Output: A fixed AUX bus number for the switcher 
between AUX 1 to AUX 48 is displayed.

• Name: The name of the studio monitor connected to the 
AUX bus, which is displayed in the Cue Edit window. 
You can rename it in up to eight alphanumeric characters 
by clicking the relevant column. 

• Control: Enable or disable control of the AUX bus 
from the ELC-MVS01 software.

• Initial Source (Device): Select the desired device so 
that the video from that device will be displayed on the 
corresponding studio monitor when no Video icon is 
specified for it.

• Delay: Specify the delayed value between 0 to 99 
frames, when there is a delay in performing the operation 
after the device accepted a command from the ELC-
MVS01 software.

b Class drop-down list box
Select the desired class to narrow down the devices to be 
displayed for the Initial Source (Device) on the selected 
line of the list, since devices are classified into classes.

c Save button
Press this button to save the settings.

d Close button
Press this button to close the Studio Monitor Settings 
window.

For the settings available on the Studio Monitor Settings 
window, see “Making the Studio Monitor Settings” on 
page 80.

1 AUX bus setup list

4 Close button

3 Save button

2 Class drop-down list 
box
Initial Setup Window



  C
hapter 2  N

am
es and F

unctions of P
arts
Icon Manager Window

The Icon Manager application is designed for ELC 
operator create an Icon, symbolizing frequently-used 
settings of a video switcher, audio mixer, or other device, 
so that you can use them to register a cue. There are four 

types of Icons: Video, Audio, Transition, and Effect. The 
created Icons are then saved in the relevant category. 
To open the Icon Manager window, double-click the Icon 
Manager icon on the desktop. 

Icon Manager Main Window

a Menu bar
The Menu bar provides menus for using the Icon Manager:

• File menu: 
Exit: Exits the Icon Manager menu.

• Help menu: 
Version: Displays the Icon Manager version number.
Help: Displays this User’s Guide.

b Icon types tabs
Click the desired tab which stands for an Icon type you can 
register in the ELC-MVS01: Video, Audio, Transition, 
and Effect.

For the overview of Icons handled on the Icon Manager 
Main window, see “Starting the Icon Manager 
Application” on page 89.

2 Icon list

3 Icon 
Library

2 Icon types tabs

1Category list

1 Menu bar
29Icon Manager Window
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1 Category list

a Category list
The system and user-defined categories are listed. Click 
the desired category so that the relevant Icons are 
displayed in the Icon list.

b Create New button
Click this button to display the Category window to create 
a new category.

c  Edit button
Click this button to display the Category window to edit 
the selected category in the category list.

d Delete button
Click this button to delete the selected category in the 
category list.

For details, see “Category Window” on page 37.

For the operations using the Category list, see “Managing 
Categories” on page 102.

2 Icon list

a Icon list
Stores icons you register according to a category from the 
Icon Library. Among the registered Icons, only the Icons 
in the selected category in the Category list are displayed. 

b Delete button
Click this button to delete the selected Icon in the Icon list 
from the category.

c Import button (On the Video tab only)
Click this button to open the Import from Camera Robotics 
dialog box. This dialog box is used to import the “shots” 
from robotic cameras as Video Icons of the selected 
category.
 

For the operations using the Icon list, see “Registering an 
Icon in a Category” on page 107, and “Importing Camera 
Shots and Creating Icons” on page 110.

2 Create New button

1 Category list

3 Edit button

4 Delete button

1 Icon list

2 Delete button

3 Import button
Icon Manager Window
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3 Icon Library

a ADD button
Click this button to add the selected Icon in the Icon 
Library to the Icon list of the selected category.

b Search block
Check the desired check box of either Name or Class, that 
you want to use for searching for Icons. Then click 
[Search] to search for Icons of the selected search option. 
The Icons found are displayed in the Icon Library.

c Delete button
Click this button to delete the selected Icon in the Icon 
Library.

d Edit button
Click this button to display the Audio, Video, Transition, 
or Effect Icon window to edit the selected Icon in the Icon 
Library.

e Create New button
Click this button to display the Audio, Video, Transition, 
or Effect Icon window to create an Icon.

f Icon Library
Stores the icons that you create or locate.
All the icons belonging to the selected Icon type tab are 
displayed.   

For details, see “Video Icon Window” on page 32, “Audio 
Icon Window” on page 33, “Transition Icon Window” on 
page 34, or “Effect Icon Window” on page 35.

For the operations on the Icon list, see “Registering an 
Icon in a Category” on page 107.

2 Search block1 ADD button

5 Create New 
button

6 Icon Library

4 Edit button

3 Delete button
31Icon Manager Window
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Video Icon Window

The Video Icon window allows you to create or edit a 
Video Icon. To display the window, click [Create New] on 
the Icon Library of the Video tab.

a Icon preview
Thumbnail and name of the created Video Icon is 
displayed.

b Icon property setting block
Specify the following for a Video Icon:

• Icon Name: Input the desired Icon name in up to eight 
alphanumeric characters. 

• Thumbnail: Click [Ref.] to display an image list and 
select the desired image for the thumbnail.

• Class: Select the desired class for a new Icon to narrow 
down the devices to be displayed, since devices are 
classified into classes.

• Device: Select the device according to the class you 
select for a new Icon.

c Camera Control block
When you select an Icon whose class is Camera, specify 
the following:

• Manual/Auto: Specify whether you control the camera 
manually or automatically. When you check [Auto] the 
following Show and Shot boxes become enabled.

• Show: According to the device you select, the 
corresponding Shows are displayed. From among these 
Shows, select the desired Show. 

• Shot: According to the Show you select, the 
corresponding Shots are displayed. From among these 
Shots, select the desired Shot.

• Import: Click to recall the Show/Shot information.

d OK/Cancel/Save/Save as buttons
When you create a new Icon, OK and Cancel buttons are 
displayed. When you edit an existing Icon, Save, Save as, 
and Cancel buttons are displayed.

• OK:  Adds the created Icon to the Icon Library.

• Cancel: Cancels the settings and returns to the Icon 
Manager main window.

• Save: Saves the settings, overwriting the existing Icon.

• Save as: Saves the settings as a new Icon.

For the operations on the Video Icon window, see “Video 
Icons” on page 91.

1 Icon preview 

2 Icon property setting block

4 OK/Cancel/Save/Save as   
      buttons

3 Camera Control block
Icon Manager Window
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Audio Icon Window

The Audio Icon window allows you to create or edit an 
Audio Icon. To display the window, click [Create New] on 
the Icon Library of the Audio tab.

a Icon preview
Thumbnail and name of the created Audio Icon is 
displayed.

b Icon property setting block
Specify the following for an Audio Icon:

• Icon Name: Input the desired Icon name in up to eight 
alphanumeric characters. 

• Thumbnail: Click [Ref.] to display an image list and 
select the desired image for the thumbnail.

• Class: Select the desired class for a new Icon to narrow 
down the devices to be displayed, since devices are 
classified into classes.

• Device: Select the device according to the class you 
select for a new Icon.

c OK/Cancel/Save/Save as buttons
When you create a new Icon, OK and Cancel buttons are 
displayed. When you edit an existing Icon, Save, Save as, 
and Cancel buttons are displayed.

• OK:  Adds the created Icon to the Icon Library.

• Cancel: Cancels the settings and returns to the Icon 
Manager main window.

• Save: Saves the settings, overwriting the existing Icon.

• Save as: Saves the settings as a new Icon.

For the operations on the Audio Icon window, see “Audio 
Icons” on page 93.

1 Icon preview        

3 OK/Cancel/Save/Save as
      buttons

2 Icon property setting block
33Icon Manager Window
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Transition Icon Window

The Transition Icon window allows you to create or edit a 
Transition Icon. To display the window, click [Create 
New] on the Icon Library of the Transition tab.

a Icon preview
Thumbnail and name of the created Transition Icon is 
displayed.

b Icon property setting block
Specify the following for a Transition Icon:

• Icon Name: Input the desired Icon name in up to eight 
alphanumeric characters. 

• Thumbnail: Click [Ref.] to display an image list and 
select the desired image for the thumbnail.

• Class: Select the desired class for a new Icon to narrow 
down the devices to be displayed, since devices are 
classified into classes.

c Detailed setting block
Depending on the Class you select, the necessary settings 
items are enabled. Set the following:

• Pattern No.: Input the desired Pattern number.

• Direction: Select either Normal or Reverse.

• Snapshot No.: Specify the snapshot number.

• Number of DME CH: Select DME channel number the 
Icon is to use.

• Macro: Select Macro No., Macro Duration, Next Start 
Delay, and Play Timing.

d OK/Cancel/Save/Save as buttons
When you create a new Icon, OK and Cancel buttons are 
displayed. When you edit an existing Icon, Save, Save as, 
and Cancel buttons are displayed.

• OK:  Adds the created Icon to the Icon Library.

• Cancel: Cancels the settings and returns to the Icon 
Manager main window.

• Save: Saves the settings, overwriting the existing Icon.

• Save as: Saves the settings as a new Icon.

For the operations on the Transition Icon window, see 
“Transition Icons” on page 94.

1 Icon  preview

3 Detailed settings block

2 Icon property setting block

4 OK/Cancel/Save/Save as
      buttons
Icon Manager Window
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Effect Icon Window

The Effect Icon window allows you to create or edit an 
Effect Icon. To display the window, click [Create New] on 
the Icon Library of the Effect tab.

a Icon preview
Thumbnail and name of the created Effect Icon is 
displayed.

b Icon property setting block
Specify the following for an Effect Icon:

• Icon Name: Input the desired Icon name in up to eight 
alphanumeric characters. 

• Thumbnail: Click [Ref.] to display an image list and 
select the desired image for the thumbnail.

• Class: Select the desired class for a new Icon to narrow 
down the devices to be displayed, since devices are 
classified into classes.

c Bus Settings block
The buses that can be used for a switcher are displayed. 
Select the bus to be used.

d Snapshot Settings block
Depending on the Class you select, the necessary settings 
items are enabled. Set the following:

• Number of Snapshot Groups: Select how many 
snapshot groups should be used (1 to 4). 

• Standby Group#: Specify the first snapshot which 
will be recalled when the corresponding cue is on the air. 

• Group Item: Specify the corresponding region and 
register numbers for the snapshot to be recalled by 
pressing the associated buttons on the Shot Box Module. 
A group stands for a combination of snapshots registered 
as a group. 

• Number of DME CH: Select the number of DME 
channels to be used in the Icon.

1 Icon preview

4Snapshot Settings block 

3 Bus Settings 
     block 

2 Icon property 
     setting block

6 OK/Cancel/Save/Save as 
     buttons

5Manual Switching setting 
    block
35Icon Manager Window
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e Manual Switching settings block
Setting the manual switching operation while on the air:

• Off: Manual switching becomes disabled.

• On: Manual switching becomes effective. 

f OK/Cancel/Save/Save as buttons
When you create a new Icon, OK and Cancel buttons are 
displayed. When you edit an existing Icon, Save, Save as, 
and Cancel buttons are displayed.

• OK:  Adds the created Icon to the Icon Library.

• Cancel: Cancels the settings and returns to the Icon 
Manager main window.

• Save: Saves the settings, overwriting the existing Icon.

• Save as: Saves the settings as a new Icon.

For the operations on the Effect Icon window, see “Effect 
Icons” on page 97.

Source Window

The Source window allows you to change source settings 
of the bus, create or edit an Effect Icon. To display the 
window, double-click the desired thumbnail in the Bus 
Settings block of the Effect Icon window.

a Not Demand /Demand option buttons
Select whether you set a Video Icon to the bus:  

• Not Demand: Select this option so that you will not be 
prompted to select an image for the Bus in the Cue Edit 
window.

• Demand: Select this option so that you will be 
prompted to select an image for the Bus in the Cue Edit 
window.

b Bus Name
Input the desired bus name in up to eight alphanumeric 
characters.

c OK/Cancel buttons
Saves or cancels the bus settings:

• OK:  Executes the Bus settings and returns to the Effect 
Icon window.

• Cancel: Cancels the Bus settings and returns to the 
Effect Icon window.

For the operations on the source window, see “Setting in 
the source window” on page 98.

3OK/Cancel buttons

2 Bus  Name1 Not Demand/Demand
      option buttons
Icon Manager Window
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Category Window

The Category window allows you to create a new category 
to accommodate icons. To display the window, click 
[Create New] or [Edit] on the Category List of the Icon 
Manager window.

a Category property setting block
Specify the following for an Icon:
• Category Name: Input the category name in up to 25 

alphanumeric characters.

• Category Type: Select the desired type according to 
the Icons that you want to save in the category.

b Delete button
Click to delete the Icon selected in the Icon Library.

c Icon preview
Thumbnail and name of the Icon selected from the Icon 
Library are displayed.

d Icon Library
According to the selected category type, registered Icons 
are displayed. 

e OK/Cancel buttons
When you create or edit a category, click the OK or Cancel 
button.

• OK:  Adds the category to the end of the Category List 
in creating a new category, or executes the settings in 
editing a category. Then returns to the Icon Manager 
main window.

• Cancel: Cancels the operation and returns to the Icon 
Manager main window.

For the operations on the Category window, see “Setting 
Categories” on page 103.

1 Category property setting 
     block

4Icon Library 

5OK/Cancel buttons

2 Delete button 

3 Icon preview 
37Icon Manager Window



38

  C
hapter 2  N

am
es and F

unctions of P
arts
ELC Plug-in Window

The ELC Plug-in application is designed so ELC operators 
can drag a cue from the Quick Cue and paste it into an 
NRCS rundown as an ELC object, so that an ELC playlist 
is created easily. The application is also used to create and 
edit a cue. 

The ELC Plug-in window is displayed as part of the NRCS 
client window. The ELC Plug-in application is composed 
of the following two modules: 
• Quick Cue 
• Cue Edit

When using iNEWS
To display the ELC Plug-in application, first start the 
iNEWS client workspace, and select [Menu] > [Plug-in] > 
[ELC Plug-in]. 

For the operations on the ELC Plug-in window, see 
“Preparing Cues (ELC Plug-in)” on page 116, “Creating 
a Playlist for iNEWS (ELC Plug-in/Playlist Viewer)” on 
page 167, and “Editing an ELC Production Cue added to 
an iNEWS rundown” on page 174.

1 iNEWS menu bar and toolbar
The menu bar and toolbar provide iNEWS menus and tool 
buttons.  For details, see the user’s guide of the iNEWS.

2 iNEWS queue panel
The panel displays the rundown selected in the directory 
panel, where the stories are listed in the order they are to 
rundown.

2 iNEWS 
queue 
panel

4 iNEWS 
story text 
panel

1 iNEWS menu 
bar and 
toolbar

1 Plug-in 
windows tabs

2 Version 
button

3 Quick Cue 
or Cue Edit 
tab

3 iNEWS 
story form 
panel

5 iNEWS 
instruction 
panel1, 2, 3, 4, 5 :Parts of iNEWS client window

1, 2, 3 :Parts of  ELC Plug-in window 
ELC Plug-in Window
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3 iNEWS story form panel
The panel shows the information about the iNEWS story, 
which contains fields for data that typically appear in the 
rundown: the playout server channel, VID-ID setting, the 
story title, the length of the story, and the status of the 
story. 
To display the status of the playout server in the ELC 
playlist, it is required to fill in the VID-ID and CH 
columns.

4 iNEWS story text panel
The panel displays the text or script of the selected story in 
the Queue panel. You can  drag and drop a cue from the 
Quick Cue window to add a new production cue.

5 iNEWS instruction panel
The panel displays the production cue of the selected 
iNEWS story.

1 Plug-in windows tabs
Click the Quick Cue or the Cue Edit tab to display relevant 
tab.

2 Version button
Click the icon to show the version number of the ELC 
Plug-in application.

3 Quick Cue or Cue Edit tab
The window displays either the Quick Cue or the Cue Edit 
tab.

When using ENPS
To display the ELC Plug-in application, first start the 
ENPS client workspace, and click the rover (green dot) of 
the Media Control icon on the bottom bar of the window, 
and select [ELC Plug-in] from the displayed menu. 

For the operations on the ELC Plug-in window, see 
“Preparing Cues (ELC Plug-in)” on page 116, “Creating 
a Playlist for ENPS (ELC Plug-in/Playlist Viewer)” on 
page 178, and “Editing an ELC Item added to an ENPS 
rundown” on page 182.

4 ENPS 
editing 
window 
(script)

1 ENPS 
list 
window

1 Plug-in 
windows 
tabs

2 Version 
button

3 Quick Cue 
or Cue Edit 
tab

3 ENPS 
folders, 
search 
window, and 
icons bar

1, 2, 3, 4 :Parts of ENPS client window

1, 2, 3 :Parts of ELC Plug-in window

2 ENPS 
rundown 
39ELC Plug-in Window
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1 ENPS list window
The list window displays the folder list, from which you 
can select and open a rundown.

2 ENPS rundown
The window displays the rundown selected and opened 
from the ENPS list window. On the rundown, the stories 
are listed in the order they should be aired.

3 ENPS folders, search window, and icons bar
The bar contains folders, a search window, and the icons 
including My ENPS, Printer, and Media Control from 
which you can launch the ELC Plug-in application. 

4 ENPS editing window (script)
The window displays the script of the item selected on the 
rundown. You can  drag and drop a cue from the Quick 
Cue window to add a new item. 

1 Plug-in windows tabs
Click the Quick Cue or the Cue Edit tab to display relevant 
tab.

2 Version button
Click the icon to show the version number of the ELC 
Plug-in application.

3 Quick Cue or Cue Edit tab
The window displays either the Quick Cue or the Cue Edit 
tab.

Quick Cue Tab

The Quick Cue tab is used to set a production cue/an item 
to the NRCS client window. 
The Playlist Viewer and OA Playlist applications also 
provide a window having the Quick Cue tab. 

For the operations on the Quick Cue tab, see “Creating a 
Cue” on page 118 and “Editing a Cue Registered in Quick 
Cue” on page 132.

a Cue folder list
The folders containing cues are listed. Click the desired 
cue folder so that the cues in it are displayed in the cue list.

b Cue list
Thumbnails of the cues contained in the cue folder selected 
in the cue folder list are displayed.

2 Cue list1 Cue folder 
list
ELC Plug-in Window
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Cue Edit Tab

The Cue Edit tab is used to edit a cue created in the Quick 
Cue tab.
In addition to the ELC Plug-in window, the Playlist 
Viewer and OA Playlist applications also provide a 
window having the Cue Edit tab. 

For the operations on the Cue Edit tab, see “Managing 
Cues” on page 118, “To set a new production cue after 
checking the content of a cue” on page 170 (for iNEWS), 
and “To set a new item after checking the content of a cue” 
on page 181 (for ENPS).

a Object list
The panel lists the settings you can change for the item 
currently selected on the Current Cue panel.
When the Video or Key Icon display block is selected, the 
list shows the related items to be specified for image 
composition. When the Audio or Studio Monitor display 
block on the Current Cue panel is selected, the list shows 
the settings for the respective audio channels or studio 
monitors.
When using iNEWS, the object list items can be switched 
using the following keys, too.
• For video settings: Alt+V
• For audio settings: Alt+A
• For transition settings: Alt+T
• For output to studio monitor settings: Alt+M

b Current cue
Displays the settings of the cue currently selected or being 
edited. The content differs depending on the cue settings.
For details on cues, see “1 Cue” on page 45. 

• Unlike the OA Playlist and Playlist Viewer windows, the 
Cue Edit tab does not show the playout server and 
camera status. The duration indicator does not start a 

countdown, either, on the Cue Edit tab, when the cue is 
put on the air.

• When the window is not wide enough to display all the 
items of the current cue, the scroll buttons  
will be displayed.

c Detailed settings
The panel displays the detailed settings of the items 
selected on the object list.

d Icon/File list
The list displays thumbnails of the Icons contained in the 
selected category in the Category list.

e Category list
The list displays the categories created in the Icon 
Manager application. The displayed categories will 
change, depending on the item selected on the object list.

f Save/Save as buttons 
When you edit an existing cue by right-clicking it and 
selecting Edit menu, the following buttons are displayed.

• Save: Saves the setting, overwriting the existing one.

• Save as: Saves the settings as a new cue by opening a 
dialog box to name the cue.  

1 Object list
3 Detailed 

settings

5Category list

4Icon /File list

1 iNEWS buttons

2Current cue

7 Registration icon

8 Apply button (ENPS only)

1 to 8 :Parts of ELC Plug-in window
1 :Parts of iNEWS client window

6 Save/Save as 
buttons

Notes
41ELC Plug-in Window
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g Registration icon
When you double-click an existing cue in the Quick Cue 
window, the registration icon is displayed. This icon is 
used to register the cue loaded in the current cue onto the 
NRCS rundown.

h Apply button (ENPS only) 
This button appears depending on the content of the 
editions. It is used to finish editing and send the data to 
ENPS when you double-click and edit an Item pasted on 
the ENPS editing window (script).

1 iNEWS buttons
The buttons appear depending on the contents of editions. 
The buttons are used when double-clicking and editing a 
Production cue pasted on the iNEWS story panel:

• OK:  Reflects the changes in settings and the ELC Plug-
in window is closed.

• Apply: Reflects the changes in settings.

• Cancel: Cancels the settings and the ELC Plug-in 
window is closed.
ELC Plug-in Window
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OA Playlist and Playlist Viewer Windows

The OA Playlist window is designed for ELC operators  to 
play out a playlist created in the ELC Plug-in application.  
The Playlist Viewer window is designed to check a playlist 
created on NRCS (read-only mode). It is also used to 
create and edit a playlist from scratch (full-edit mode). 
The OA Playlist window and the Playlist Viewer windows 
in the two modes look the same, except for the menu bar 
items. Differences in functions will be explained in the 
explanations in this section. 
To start the OA Playlist application or Playlist Viewer 
application, double-click the relevant icon on the desktop. 

For the operations on the OA Playlist and Playlist Viewer 
windows, see the following:

• For operations with iNEWS: See “Creating a Playlist” 
on page 169, “Displaying a Playlist in the Playlist 
Viewer Application” on page 176, and “On-Air 
Operations” on page 201.

• For operations with ENPS: See “Creating a Playlist” on 
page 180, “Displaying a Playlist in the Playlist Viewer 
Application” on page 184, and “On-Air Operations” on 
page 201.

• For operations required to create a playlist from scratch 
without using NRCS: See “Creating a Playlist without 
Using NRCS” on page 186.

a Playlist name
The playlist name (up to 25 alphanumeric characters) 
provided by the NRCS client software is displayed, which 
is the same as the name of the NRCS rundown.

b Menu bar
The bar provides the menus for using the OA Playlist and 
Playlist Viewer:
• File menu: 

Open: Opens a playlist on the OA Playlist or Playlist 
Viewer window.
Close: Closes the playlist on the OA Playlist or Playlist 

Viewer window
Exit: Exits the OA Playlist or Playlist Viewer window.

• Edit menu (Playlist Viewer window only):
Edit: Displays the window used to edit the selected 
story or cue.
Copy1): Copies the selected story or cue to the copy 
buffer.
Create New Story1): Creates a new story at the 
specified position on the playlist.
Cut1): Moves the selected story or cue to the copy 
buffer.
Delete1): Deletes the selected story or cue.

1Playlist name

9Current
     button

7 ELC story

1 Cue

2Menu bar

3ELC playlist

4Page/Slug 

5 Error/Update 
mark

6Error monitor

8 Commercial 
break story
43OA Playlist and Playlist Viewer Windows
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Paste1): Pastes the story or cue stored in the copy buffer 
at the specified position on the playlist.

• Tools menu:
Quick Cue: Displays the Quick Cue window, which 
provides the Quick Cue and the Cue Edit tabs. 
Shot Box Folder2): Allows you to select the cue folder 
in which the cues to be played out using the shot box 
buttons are stored from the folders specified as “shot box 
candidates.”

• Playlist menu (OA Playlist window only):
Start: Starts the on-air operation.
End: Ends the on-air operation.

• Help menu:
Version: Displays the version number.
Help: Displays this User’s Guide.

1) Full-edit mode only
2) OA Playlist window only

c ELC playlist
The stories are listed in the order that they are played out.

d Page/Slug
Displays the page and slug, set by the NRCS, of the story 
to which an ELC production cue/item is registered. 

e Error/Update mark

f Error monitor
Displays the error details of a cue beside which an error 
mark is displayed: 

The selected cue is displayed with a blue selection frame. 
To display all the errors one by one, click  or . To 
select a cue directly, click the desired cue on the playlist.
If the subject cue of the error monitor is not displayed on 

the playlist, double-click on the error monitor, and the 
playlist will be scrolled to show the subject cue.

g ELC Story
An ELC Story definition differs between iNEWS and 
ENPS:
• In iNEWS: A group of cues of the same NRCS Page 

number is defined as an ELC story.
• In ENPS: A group of cues of the same NRCS Slug is 

defined as an ELC story.

h Commercial Break Story
When a Commercial Break Story is specified on an NRCS 
rundown, it appears on the playlist as a purple line. A 
Commercial Break Story basically represents a time slot in 
which a system/device other than the NRCS performs an 
on-air operation, such as when it runs a commercial 
message.
Note that, in iNEWS, even if a cue is specified in a 
Commercial Break Story, it will not be shown.
In ENPS, Commercial Break Stories are not colored purple 
if the settings related to the MOS protocol have not been 
made on ENPS.

i Current button
While scrolling a playlist manually, press this button to 
enter into the auto scrolling mode and to display the cue 
being on the air on the second line from the top 
immediately.  

Mark Appears when: Description

The corresponding cue 
has a problem or 
problems.

Without addressing or 
solving the problem(s), it 
will be difficult to execute 
the cue. 
The error details are 
displayed in the error 
monitor area.

The corresponding cue 
has been edited in the 
OA Playlist or Playlist 
Viewer window

The update mark will 
disappear when the 
revision is registered in 
the NRCS.

Page number Error message

Error number
OA Playlist and Playlist Viewer Windows
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1 Cue
A unit to be on the air with a TAKE operation.
The content differs depending on the cue settings. The 
following is an example:

a Duration
Displays the duration specified for the cue displayed. It 
will start the countdown when the cue starts to be 
displayed on the air. If there is a “Fixed” mark, the next cue 
will be taken automatically after the specified duration has 
elapsed.

b Transition Icon
The thumbnail of the Transition Icon is displayed.

c Video Icon
The thumbnail of the Video Icon is displayed:
• When an Effect Icon is set: The Effect Icon 

thumbnail is displayed.
• When no Effect Icon is set: The thumbnail of Video 

Icon set to A Bus is displayed. 
When the playout server (no channel determined) is set, 
the following system icon is displayed, together with the 
name of the icon, before any channel is set. 

When a certain channel is set, the corresponding icon, 
which has been created by the user, and the name of the 
icon are displayed.

d Keys
Displays thumbnails and names of Video Icons assigned to 
keys 1 to 4. When the playout server (no channel 
determined) is set, the system icon for an as-yet-
undetermined channel, together with the icon’s name, is 

displayed before any channel is set on the NRCS. After a 
certain channel is set, the corresponding icon, which has 
been created by the user, and the name of the icon are 
displayed.

e Playout server status
The status of multiple channels of the playout server is 
obtained from the NRCS and displayed*:

* Only two channels with the highest and the second 
highest priorities, which correspond to the first and the 
second channels listed from the top of the object list, are 
displayed.

2Transition Icon

7Audio4Keys3Video Icon

5Playout server status

6Camera status

9OA Cue

0NEXT Cue

1Duration 8Studio Monitors

Playout server Icon for an as-yet-undetermined 
channel (Supplied by the system)

Example of a playout server Icon for channel A
(Created by the user)

Status Icon Description

No 
Response

The playout server does not 
respond.  

Not Filed No files are saved in the playout 
server. 

Filed
OA

NEXT

Other

Files to be used are saved. 

Cued
OA

NEXT

Other

Files are cued up (stand-by).

Play Files are being played.

Channel number

Status
45OA Playlist and Playlist Viewer Windows
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The status icon may differ, or may not be displayed depending on the 
corresponding setting in the System Setup application.

When the Icon for a specific channel of the playout server 
is specified, however, the channel number and the status 
are not displayed.

f Camera status
The status of robotic cameras 1 to 8 is displayed*:

* Only two devices with the highest and the second highest 
priorities, which correspond to the first and the second 
devices listed from the top of the object list, are 
displayed.

The status icon may differ, or may not be displayed depending on the 
corresponding setting in the System Setup application.

g Audio
The panel displays the settings of audio fader numbers 1 to 
8: names of the Audio Icons, level, Fade In/Out settings. 
When the playout server (no channel fixed) is set, the name 
of the system icon automatically set is displayed before the 
channels are set. After the channel is set, the name of the 
icon the user specifies for each channel is displayed.

h Studio Monitors
The panel displays the settings of Studio Monitor numbers 
1 to 5: Video Icons and names of the AUX buses used to 
output signals to the studio monitors. When the playout 
server (no channel determined) is set, the system icon for 

an as-yet-undetermined channel, together with the icon’s 
name, is displayed before any channel is set on the NRCS. 
After a certain channel is set, the corresponding icon, 
which has been created by the user, and the name of the 
icon are displayed.

i OA Cue
The cue being on the air is displayed in green. In the auto 
scroll mode, it is always placed on the second line from the 
top. 

j NEXT Cue
The cue to be on the air next is displayed in yellow. When 
the NEXT cue is not ready, it flashes in yellow. Then it 
lights in yellow when it is ready.

Undefined The playout server returns 
unexpected status information.

Note

Status Icon Description

No 
Response

The camera does not respond.  

Not Ready Although the camera responds, no 
shot is recalled. 

Ready
OA

NEXT

Other

The camera is on standby. If there is 
a shot, shot is recalled. 

Manual
OA

NEXT

Other

The status of a manually-set camera 
is always displayed.
Even if the camera control setting is 
“Off,” the status is displayed.

Status Icon Description

Device number 
or device name

Status
OA Playlist and Playlist Viewer Windows
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Alarm Monitor Window

Alarm Monitor Application

The Alarm Monitor application is designed for use by ELC 
operators to check if errors have occurred in ELC services 
and applications.
It can be started by clicking [All Programs ] > [Sony ELC] 
> [ELC  Tools] > [Alarm Monitor] from the Windows start 
button.
When the Alarm Monitor application is in operation, the 
ELC Alarm Monitor icon  appears in the Windows system 
tray.  

The color of the ELC Alarm Monitor icon changes 
depending on the status of the various ELC services and 
applications.

Right-clicking the ELC Alarm Monitor icon displays a 
menu, and clicking [Setting] from that menu opens the 
Setting dialog box.

The following two items are specified in the Setting dialog 
box.
• Interval (5 - 100 seconds): Specify the time interval for 

the Alarm Monitor application to access the ELC 
database to check errors.

• Autostart: Check this box to make the Alarm Monitor 
application start automatically upon start-up of the 
computer. 

Right-clicking the ELC Alarm Monitor icon, and clicking 
[Open] from the menu displayed opens the Alarm Monitor 
window. 

Icon Status

No error occurred.

(Flashing)
An error has occurred.

(Steady)
Failed to connect to the ELC database in 
which errors are registered.

An error occurred and has been checked.

ELC Alarm Monitor icon 
(No error occurred)

Setting dialog box
47Alarm Monitor Window
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Alarm Monitor Window

The Alarm Monitor window is provided for use by ELC 
operators to check the history of errors in system services 
and applications.

a Error records
The errors registered in the ELC database are displayed. 
The newest record appears at the top of the list.

• Host Name:  Host name of the computer where the 
error occurred.

• Module Name: Name of the module in which the error 
occurred, if available.

• Error Code

• Error Message: Description of the error. When the 
message is too long to be fully displayed in the column, 
roll the mouse pointer over the message to display the 
entire message.

• Date: Date and time when the error was detected and 
registered in the database.

b Refresh button
Updates the display of error records. 

c Close button
Closes the Alarm Monitor window.

1 Error records

2 Refresh button 3Close button
Alarm Monitor Window



Preparations
The section explains preparations and setup that technical directors 
or a system integrator should do before making news programs: 
making the initial setup with the Initial Setup application, creating 
Icons with the Icon Manager, and making cues in the ELC Plug-in 
application.  If necessary, ELC operators can refer to and change 
required settings.
Chapter 6 explains required preparations that directors should do 
when they use advanced functions of the software: switching 
multiple snapshots and videos manually.

Chapter 3   Making the Initial Setup ............................................. 50

Chapter 4   Preparing Icons (Icon Manager)................................ 85

Chapter 5   Preparing Cues (ELC Plug-in)................................. 116

Chapter 6   Preparing for Advanced or Occasional Manual 
Operations .................................................................. 137
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hapter
CMaking the Initial Setup
Overview

Before starting routine operations of the ELC-MVS01 software, when a new 
news program is planned, or when there is a change on a device in the studio, a 
technical director can set up the following items of the system using the Initial 
Setup application:

• Video Switcher Settings (see page 53)
It allows you to associate each video input signal of the video switcher with a 
Video Icon registered in the ELC-MVS01 software.
It also specifies transition rate options for the Transition Icons.

• Audio Mixer Settings (see page 57)
It allows you to associate each audio input signal of the audio mixer with an 
Audio Icon registered in the ELC-MVS01 software or a back fader of the 
audio fader panel.
It also specifies names for the AUX buses, audio level options, and fade-in/
fade-out time options.

• Shot Box Module Assign (see page 65)
It allows you to assign the functions to be used for manual on-air operations 
to the buttons on the shot box module.

• DDR(VDCP) File List Creation (see page 73)
It allows you to select the video files used in the news programs from all the 
files stored on the DDR(VDCP), so that they will be listed upon creating cues 
and easily added to a playlist.

• Audio Server File List Creation (see page 77)
It allows you to select the audio files used in the news programs from all the 
files stored on audio server, so that they will be listed upon creating cues and 
easily added to a playlist.

• Studio Monitor Settings (see page 80)
It allows you to make the settings required for the AUX buses. The AUX 
buses are used to output signals to studio monitors.
Overview
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Starting the Initial Setup Application

1 Double-click the InitSetup icon (Initial Setup) on the Windows desktop.
Or, double-click the InitSetup.exe file in the “Sony\ELC\InitialSetup” 
folder on the drive where the ELC-MVS01 software is installed.

The Initial Setup application starts and the Initial Setup Main Menu is 
displayed.

2 Select a sub menu on the Initial Setup Main Menu, depending on the desired 
setup items.

The window corresponding to the selected sub menu is displayed.

Example: Video Switcher Settings window
51Starting the Initial Setup Application
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Only one Initial Setup application can be operated in a system at a time. If the 
Initial Setup application is already operating on the same computer, or on a 
different computer in the system, you cannot start the application.

Exiting the Initial Setup application

1 Select [File] > [Exit] from the menu bar of the Initial Setup Main Menu.

The Initial Setup application is closed.

Note
Starting the Initial Setup Application
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Making the Video Switcher Settings

The Video Switcher Settings window is used to associate each video input 
signal of the video switcher with a Video Icon used in the ELC-MVS01 
software.
The Icon Manager application is used to associate each video device with a 
Video Icon. The Video Switcher Settings window of the Initial Setup 
application is used to register associations between the video devices and the 
video input signals, which correspond to V/K pair numbers, of the video 
switcher.

For details on the Icon Manager, see “Creating Icons” on page 90.

The Video Switcher Settings window also enables you to specify the transition 
rate options to be used when editing cues.

Associating the V/K Pair Numbers with Video Icons

1 On the Initial Setup Main Menu, click the Video Switcher Settings sub 
menu.

The Video Switcher Settings window is displayed.

The Initial Setup application enables you to import and view the source 
names for the V/K pair numbers specified on the video switcher, so that you 
can check the device you want to associate with a certain V/K pair number.

For details, see “To import source names from the video switcher” on page 
54.

Note

Import button
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2 Select the desired V/K pair number on the list.

3 Narrow down the device list, if necessary, by selecting the desired class 
using the Class drop-down list box. 

You can select from the following options.

4 Select the device to be associated with the selected V/K pair number, using 
the Device(V) drop-down list box.

Now the V/K pair number and the Video Icon that represents the selected 
device are associated.

5 Repeat steps 2 to 4 for all the V/K pair numbers to be used in the system.

6 Click [Save] to save the modified settings.

To import source names from the video switcher
Click [Import] in the Video Switcher Settings window.
A warning message is displayed.
Click [OK] to import the source names from the video switcher.
The names are displayed in the Source Name column.

Class Descriptions

All All devices will be displayed in the Device drop-down 
list box.

Camera Select this option to specify a camera.

CG/Still Store Select this option to specify a CG or Still Store. 
Tip
The CG/Still Store is a server having a playlist 
function. The CG/Still Store controller type with a 
playlist function and a storage type can be a different 
device.The ELC-MVS01 does not control the CG/Still 
Store and does not perform file operations. With the 
tally off signal from the switcher, next piece of 
material on the playlist will be loaded for standby.

DDR(VDCP) Select this option to specify a DDR(VDCP).
Tip
A disk recorder without a playlist function is 
supported. It can be used to handle frequently-used 
daily materials.

DDR(SonyVTR) Select this option to specify a DDR(SonyVTR). 
Use this option for a digital disk recorder that can be 
controlled by the Sony VTR protocol.

Ext/Others Select this option to specify a Color Background or 
Re-Entry device within the switcher. 

Frame Memory Select this option to specify a Frame Memory within 
the switcher.

PO Server Select this option to specify a playout server. 
Tip
A playout server is a server having a playlist function. 
It can be used to handle daily-changing materials. 
The playout server controller type with a playlist 
function and a storage type can be a different device. 
The ELC-MVS01 controls the playback function and 
does not select files. 

Remote Select this option to specify a remote device.
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To specify a different device for the key used with the DDR(VDCP)
Selecting the DDR(VDCP) class in step 3 enables the Device(K) drop-down list 
box. Select the device to be used for the key. It will be used with the device 
selected in the Device(V) drop-down list box in step 4.
When Device(K) is left blank here, the same device (unit and channel) as that 
specified previously in Device(V) will be used. 
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Specifying the Transition Rate Options

The following procedure specifies the two sets of transition rate options: video 
transition rate options and key transition rate options. They will appear in the 
Cue Edit window of the ELC Plug-in application or the Playlist Viewer 
application as the options available for switching two cues and for a key event, 
respectively.

1 In the Video Switcher Settings window, specify the number of frames for 
each of the four transition rate options using the spin boxes in the Video 
Transition Rate section.

You can enter the desired number of frames (0 to 999) into each spin box, 
or increase/decrease the setting by clicking the spin buttons.

The transition rate for an option will be displayed in the “SS:FF” format in 
the Cue Edit window.

In the same way, specify the number of frames for each of the four transition 
rate options that are used for a key event, using the spin boxes in the Key 
Transition Rate section.

2 Click [Save] to save the modified settings.

Note
Making the Video Switcher Settings
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Making the Audio Mixer Settings

The Initial Setup application shows the Audio Mixer Settings window, in which 
a technical director makes the following settings related to the audio mixer.

• Associating a fader number of the audio mixer with an Audio icon
This makes the fader of the audio mixer accept automatic control from the 
ELC-MVS01 system. An Audio Icon registered in the system is associated 
with a fader number of the audio mixer.

• Associating a fader number of the audio mixer with a back fader of the 
audio fader panel for constant manual operation
Besides automatic control from the ELC-MVS01 system, this makes the fader 
of the audio mixer accept manual control from the ELC-MVS01 system. One 
of the eight back faders (B1 - B8) of the audio fader panel is associated with 
a fader number of the audio mixer.

• Disabling control of a fader of the audio mixer from the ELC-MVS01 
system
This disables control of a fader of the audio mixer from the ELC-MVS01 
system.

The Audio Mixer Settings window is also used for:
• Specifying the name for an AUX bus for Mix-minus feature

This specifies the names for the AUX buses of the audio mixer for Mix-minus 
feature.

• Specifying the audio level options
This specifies the audio level options for automatic fader control from the 
ELC-MVS01 system.

• Specifying the fade in/out time options
This specifies the audio fade in/out time options for automatic control from 
the ELC-MVS01 system.

Audio Fader Panel
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Associating Fader Numbers with Audio Icons

1 On the Initial Setup Main Menu, click the Audio Mixer Settings sub menu.

The Audio Mixer Settings window is displayed.

For details, see “Audio Mixer Settings Window” on page 22.

2 Select the Fader No. Setup tab, if it is not displayed on top.

Depending on the type of audio mixer you are using, the Initial Setup 
application enables you to import and view the source names for the fader 
numbers specified on the audio mixer, so that you can check the device you 
want to associate with a certain fader number. 

For details, see “To import source names from the audio mixer” on page 
59.

3 Select [Enable] in the Control drop-down list box for a fader number.

4 Associate the desired Audio Icon with the fader number.
Narrow down the device list, by selecting the desired class using the Class 
drop-down list box. 

You can select from the following options.

Note

Class Descriptions

All All devices will be displayed in the Device drop-down 
list box.

Audio Server Select this option to specify an audio server. 

Import button
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5 Select the device to be associated with the selected fader number, using the 
Device drop-down list box.

The fader on the audio mixer and the Audio Icon that represents the selected 
device are now associated.
While a cue with the associated Audio Icon is on the air, the audio level will 
be adjusted to the level specified in the cue automatically. You can also use 
the corresponding fader on the audio fader panel.

For details on on-air operations, see “Starting/Ending On-Air Operation” 
on page 204, and “Controlling the Audio Level Manually” on page 215.

6 Repeat steps 3 to 5 to associate another fader number with an Audio Icon.

7 Click [Save] to save the modified settings.

To import source names from the audio mixer
Click [Import] in the Audio Mixer Settings window.
A warning message is displayed.
Click [OK] to import the source names from the audio mixer.
The names are displayed in the Source Name column.

CG/Still Store Select this option to specify a CG or Still Store. 
Tip
The CG/Still Store is a server having a playlist 
function. The CG/Still Store controller type with a 
playlist function and a storage type can be a different 
device. The ELC-MVS01 does not control the CG/Still 
Store and does not perform file operations. With the 
tally off signal from the switcher, next piece of 
material on the playlist will be loaded for standby.

DDR(VDCP) Select this option to specify a DDR(VDCP).
Tip
A disk recorder without a playlist function is 
supported. It can be used to handle frequently-used 
daily materials. 

DDR(SonyVTR) Select this option to specify a DDR(SonyVTR). 
Use this option for a digital disk recorder that can be 
controlled by the Sony VTR protocol.

Ext/Others Select this option to specify an audio device for which 
the device control is not required. 

PO Server Select this option to specify a playout server. 
Tip
A playout server is a server having a playlist function. 
It can be used to handle daily-changing materials. 
The playout server controller type with a playlist 
function and a storage type can be a different device. 
The ELC-MVS01 controls the playback function and 
does not select files.

Remote Select this option to specify a remote device.

Class Descriptions
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To enter source names
If your audio mixer is not one that allows you to import source names, enter the 
source names for the fader numbers specified on the audio mixer, as follows: 
Click the Source Name area to make the source name editable. Enter the source 
name for the fader number using up to eight characters and symbols, then press 
the Enter key.
Note that the source name should be identical to that specified on the audio 
mixer.

Associating Fader Numbers with Back Faders of the Audio Fader Panel for 
Constant Manual Operation

1 In the Audio Mixer Settings window, select the Fader No. Setup tab, if it is 
not displayed on top.

Depending on the type of audio mixer you are using, the Initial Setup 
application enables you to import and view the source names for the fader 
numbers specified on the audio mixer, so that you can check the device you 
want to associate with a certain fader number. 

For details, see “To import source names from the audio mixer” on page 
59.

2 Select one of the [Enable&BackFader1] to [Enable&BackFader8] options 
in the Control drop-down list box on the line for a fader number of the audio 
mixer.

The fader on the audio mixer now accepts manual fader control from the 
ELC-MVS01 system. 
During on-air operation, the specified back fader (B1 - B8) of the audio 

Note
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fader panel can be used for manual control.
If a device is specified in the Device column for that fader number, hence 
the fader number is associated with an Audio Icon, it also accepts the 
automatic fader control using the associated Audio Icon. 

3 Repeat step 2 to associate another fader number of the audio mixer with a 
back fader of the audio fader panel.

4 Click [Save] to save the modified settings.

To display the source names on the source buttons
When you imported the source names for the fader numbers specified on the 
audio mixer, they are displayed on the source buttons on the audio fader panel 
for the back faders specified for manual fader control (channels B1 to B8).

For details, see “To import source names from the audio mixer” on page 59.

When this is not possible, you can enter source names in the Audio Mixer 
Settings window.

For details, see “To enter source names” on page 60.

Disabling Control of Faders of the Audio Mixer from the ELC-MVS01 System

1 In the Audio Mixer Settings window, select the Fader No. Setup tab, if it is 
not displayed on top.

2 Select [Disable] in the Control drop-down list box for a fader number.
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The fader on the audio mixer can no longer be controlled from the ELC-
MVS01 system. 

3 Repeat step 2 to disable control of other faders from the system.

4 Click [Save] to save the modified settings.

Specifying the Name for an AUX Bus for the Mix-Minus Feature

The following procedure allows you to specify names for the AUX buses of the 
audio mixer that are used for the Mix-minus feature. The specified names 
appear in the ELC plug-in window.

1 In the Audio Mixer Settings window, select the Mix Minus Bus Settings tab, 
if it is not displayed on top.

2 Click the Name column on the line for the desired Mix-minus bus, and enter 
the name for the bus using up to eight alphanumeric characters and symbols.

The entered name will be combined with the AUX bus number, such as 
“Remote1(AUX1),” and appears as a Mix-minus option when editing a cue.

3 Repeat step 2 if you want to specify the name for another Mix-minus bus.

4 Click [Save] to save the modified settings.

If you leave the name of a Mix-minus bus blank, the default name corresponding 
to the Mix-minus bus will be used.

Note
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Specifying the Audio Level Options

The following procedure specifies the audio level options available for 
automatic fader control from the ELC-MVS01 system. The audio level options 
will be used in the Cue Edit window of the ELC Plug-in application or the 
Playlist Viewer application when editing cues.
When a cue is taken during on-air operation, the audio level will automatically 
be adjusted to the one specified for the cue.

For details on editing cues, see“Setting Audio” on page 125.

1 In the Audio Mixer Settings window, specify the audio level for each of the 
three audio level options using the spin boxes in the Level section.

You can enter the desired number (-99 to 0) into each spin box, or increase/
decrease the setting by clicking the spin buttons.

When editing cues, there is one more audio level option “0” that is set at 
–∞ dB, besides these three options and it cannot be modified.

2 Click [Save] to save the modified settings.
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Specifying the Fade In/Out Time Options

The following procedure specifies the audio fade in/out time options available 
for automatic fader control from the ELC-MVS01 system. The fade in/out time 
options will be used in the Cue Edit window of the ELC Plug-in application or 
the Playlist Viewer application when editing cues.
When a cue is taken during on-air operation, the fade in/out time specified for 
the cue is used for playout automatically.

1 In the Audio Mixer Settings window, specify the number of frames for each 
of the four fade in/out time options, using the spin boxes in the Fade In/Out 
Time section.

You can enter the desired number of frames (0 to 999) into each spin box, 
or increase/decrease the setting by clicking the spin buttons.

The fade in/out time for an option will be displayed in the “SS:FF” format 
in the Cue Edit window.

2 Click [Save] to save the modified settings.

Note
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Assigning Functions to the Shot Box Module Buttons

The Shot Box Module Assign window is used to assign manual on-air functions 
to the buttons on the ELC-MVS01 shot box module. This setup enables an ELC 
operator to use the assigned manual function easily during on-air operation, by 
selecting the corresponding button.
The Initial Setup application enables you to create up to two “Assign List” 
tables. When there are two shot box modules, each shot box module can be 
assigned to identical or different Assign List tables.

During on-air operation, a change in setting will not be reflected immediately. 
The next time you open a playlist with the OA Playlist application, the windows 
will reflect the changes.  

Assigning a Function to a Button

The following procedure assigns functions to shot box module buttons of an 
Assign List table.

1 On the Initial Setup Main Menu, click the Shot Box Module Assign sub 
menu.

The Shot Box Module Assign window is displayed.

Note

Button layout
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2 Select the number of the table to which you want to assign the functions.

The current settings of the table are displayed.

3 Select the tab corresponding to the bank to which you want to assign the 
functions.

The functions that have already been assigned to the buttons of the selected 
bank are displayed in the Assign List.

4 Select the number corresponding to the button to be assigned to the function 
on the Assign List.
Or, if you are going to assign more than one function, select the lowest 
numbered button to which you want to assign the functions. In this case, the 
functions will be assigned to the buttons of the selected and the subsequent 
numbers.

5 If necessary, narrow down the functions displayed on the Function List 
using the Function Group drop-down list box.

The following function groups are available in the Function Group drop-
down list box.

* “xxx” stands for the name of the device for which a backup device is specified.
** Only the numbers specified for functions (n) for camera control assigned in the System Setup 

application are displayed.
*** Only the numbers specified for functions (n) for GPI port number assigned in the System Setup 

application are displayed. “xxx” stands for the GPI port name also assigned in the System Setup 
application.

6 Select the function(s) to be assigned on the Function List.
You can select more than one function by using the Ctrl or Shift key.

The following functions are available on the Function List.

Function Group Functions

All All functions

Backup Audio xxx Backup Audio* 

Backup Video xxx Backup Video* 

Camera Control CAMn** Control

Cue Cue 1 - 24

DSK DSK1 - 4 ON/OFF, DSK 1 - 4 AUTO, DSK 1 - 4 LINK

Fixed Duration Fixed Duration ON/OFF

GPI OUT GPIn(xxx)***

Key Key 1 - 4 ON/OFF, Key 1- 4 AUTO,
Free M/E Key 1 - 4 ON/OFF, 
Free M/E Key 1 - 4 AUTO

Manual Switching Manual Switching 1 - 6, 
Free M/E Manual Switching 1 - 6

Mixer Control Mixer Control

Side Flag Side Flag for A Bus, Side Flag for B Bus,
Free M/E Side Flag for A Bus,
Free M/E Side Flag for B Bus

Snapshot Group Snapshot Group 1 - 4, 
Free M/E Snapshot Group 1 - 4

Transition Override PRESET, CUT, MIX, Transition Rate 1 - 4
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Function Description

TAKE Takes the NEXT cue on the playlist while on the air.

DSK1 - 4 ON/OFF Cuts DSK 1 to 4 in or out alternately.

Key 1 - 4 ON/OFF Cuts Key 1 to 4 in or out alternately.

Free M/E Key 1 - 4 ON/
OFF

Cuts Key 1 to 4 for the free M/E in or out alternately.

DSK1 - 4 AUTO Inserts or deletes DSK 1 to 4 alternately using the 
transition type and rate specified on the switcher. 

Key 1 - 4 AUTO Inserts or deletes Key 1 to 4 alternately, using the 
transition type and rate specified in the cue.

Free M/E Key 1 - 4 
AUTO

Inserts or deletes Key 1 to 4 for the free M/E 
alternately, using the transition type and rate 
specified in the cue.

DSK1 - 4 LINK Takes the NEXT cue on the playlist, and 
simultaneously inserts or deletes DSK 1 to 4 using 
the transition type and rate specified on the 
switcher.

Snapshot Group 1 - 4 Recalls the snapshot specified for Snapshot Group 
1 to 4 Effect Icon.
For details, see “Effect Icons” on page 97.

Free M/E Snapshot 
Group 1 - 4

Recalls the snapshot specified for Snapshot Group 
1 to 4 Effect Icon for the free M/E.

Manual Switching 1 - 6 Switches to the video signal of the first to sixth 
Video Icon listed for manual switching.
For details, see “Required Settings in the ELC Plug-
in Application” on page 148.

Free M/E Manual 
Switching 1 - 6

Switches to the video signal of the first to sixth 
Video Icon (specified for the free M/E) listed for 
manual switching.

Side Flag for A Bus Toggles the Side Flag for the A bus of the NEXT cue 
between on and off.

Free M/E Side Flag for 
A Bus

Toggles the Side Flag for the free M/E A bus of the 
NEXT cue between on and off.

Side Flag for B Bus Toggles the Side Flag for the B bus of the NEXT cue 
between on and off.

Free M/E Side Flag for 
B Bus

Toggles the Side Flag for the free M/E B bus of the 
NEXT cue between on and off.

PRESET, CUT, MIX Overrides the transition type of the NEXT cue.
For details, see “Overriding the Transition Settings 
for the NEXT Cue” on page 231.

Transition Rate 1 - 4 Overrides the transition rate of the NEXT cue.
For details, see “Overriding the Transition Settings 
for the NEXT Cue” on page 231.

Fixed Duration ON/OFF Toggles the duration specified for the OA cue 
between fixed/unfixed. 
For details, see “To toggle the duration of the OA 
cue between fixed/unfixed” on page 208.

Cue 1 - 24 Selects one of the cues in the cue folder that was 
selected as the “shot box folder” to be the NEXT 
cue. The shot box folder must be assigned as a shot 
box candidate in the Quick Cue in advance, and 
selected in the OA Playlist application. 
For details, see “Assigning Individual Cues to Shot 
Box Module Buttons” on page 154 and “Getting 
Cues Assigned to Shot Box Module Buttons on the 
Air” on page 227.
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* Only the numbers specified for functions (n) for camera control assigned in the System Setup 
application are displayed.

** Only the numbers specified for functions (n) for GPI port number assigned in the System Setup 
application are displayed. 
“xxx” stands for the GPI port name also assigned in the System Setup application.

*** “xxx” stands for name of the device for which a backup device is specified.

7 Click [CADD].

The selected function(s) are assigned to the button(s), and displayed on the 
Assign List.

8 Repeat steps 3 to 7 if you want to assign another function to a shot box 
module button.

9 Click [Save] to save the modified settings.

CAMn* Control Disables/enables robotic camera control from the 
ELC-MVS01 system.

Mixer Control Disables/enables audio mixer control from the ELC-
MVS01 system. 

GPIn(xxx)** Outputs a GPI pulse.

xxx*** Backup Audio Switches to the backup specified for the device.
For details, see “Switching an Audio Device to Its 
Backup” on page 233.

xxx*** Backup Video Switches to the backup specified for the device.
For details, see “Switching a Video Device to Its 
Backup” on page 232.

Function Description
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Assigning a Table to a Shot Box Module

The following procedure assigns a table number to the shot box module(s).

1 In the Shot Box Module Assign window, select the table number to be 
assigned to the first shot box module, using the Module1 drop-down list 
box.

2 Select the table number to be assigned to the second shot box module, if any, 
using the Module2 drop-down list box.
This can be either the identical number to or a different number from the 
first shot box module.

3 Click [Save] to save the modified settings.

This table number represents the displayed assign list. 
The table number you select in steps 1 and 2 
corresponds to an option in this drop-down list.
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Specifying the Name of a Button

The following procedure specifies/edits the name for a button on the shot box 
module.

When one of the Snapshot Group 1 to 4 functions is assigned to a button, the 
name of the corresponding Snapshot Group will appear on the button. In this 
case, the Initial Setup application does not allow you to edit the name of the 
button. Use the Icon Manager to edit the name of a Snapshot Group.

For details on editing the name of a Snapshot Group, see “Required Settings in 
the Icon Manager Application” on page 138.

When one of the Manual Switching 1 to 6 functions is assigned to a button, the 
name of the corresponding Video Icon will appear on the button. In this case as 
well, the Initial Setup application does not allow you to edit the name of the 
button. 

For details on the Video Icons used for manual switching, see “Required 
Settings in the ELC Plug-in Application” on page 148.

When one of the Cue 1 to 24 functions is assigned to a button, the name of the 
corresponding cue will appear on the button. In this case as well, the Initial 
Setup application does not allow you to edit the name of the button. 

For details on assigning cues to shot box module buttons, see “Assigning 
Individual Cues to Shot Box Module Buttons” on page 154.

Note
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1 In the Shot Box Module Assign window, select the number of the table to 
be edited.

The current settings of the table is displayed.

2 Select the tab corresponding to the desired bank.

The functions assigned to the buttons of the selected bank are displayed in 
the Assign List.

3 Click the Name column on the line for the desired button, and enter the 
name for the button.

• You can enter up to eight alphanumeric characters and symbols. Use a 
“ | ” symbol to insert a line break, which appears only on the shot box 
module.

• Although you can enter both upper and lower case letters here, the names 
will be shown in capital letters on the shot box module.

4 Repeat steps 2 and 3 if you want to specify the name for another button.

5 Click [Save] to save the modified settings.

Notes
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Removing the Assigned Function

The following procedure removes the function assigned to a button on the shot 
box module.

1 In the Shot Box Module Assign window, select the number of the table to 
be edited.

The current settings of the table is displayed.

2 Select the tab corresponding to the desired bank.

The functions assigned to the buttons of the selected bank are displayed in 
the Assign List.

3 Select the line of the button from which you want to remove the assigned 
function on the Assign List.

4 Click [Delete].

A confirmation message is displayed.

5 Click [OK] to remove the function.

The selected function disappear from the list.

6 Repeat steps 2 to 5 if you want to remove the function from another button.

7 Click [Save] to save the modified settings.
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Managing Video Material
- Creating the DDR(VDCP) File List

The Initial Setup application shows the DDR(VDCP) File List Creation 
window, in which a technical director can select the video files to be used in the 
news programs from all the files stored on the DDR(VDCP). The selected files 
will be shown on a list when the DDR(VDCP) is selected during creating or 
editing cues, so that the desired video files can be added to a playlist easily.

• All the video files to be used in the ELC-MVS01 system must be listed in 
advance using this DDR(VDCP) File List Creation setup tool.

• Before creating the DDR(VDCP) file list, make the video switcher settings. 
The DDR(VDCP) File List Creation window only allows you to select a 
device (unit/channel) that has already been associated with a V/K pair number 
as Device(V) when creating the file list.

For details on making the video switcher settings, see “Making the Video 
Switcher Settings” on page 53.

Creating the File List

1 On the Initial Setup Main Menu, click the DDR(VDCP) File List Creation 
sub menu.

The DDR(VDCP) File List Creation window is displayed. 

Notes
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2 Select the desired device for which you would like to create a file list in the 
Device drop-down list box.

If the information on the DDR(VDCP) files of the selected device has 
already been imported, the files are displayed on the File List and the Source 
Library.

When the Source Library list, which shows the DDR(VDCP) files stored on 
the selected DDR(VDCP) is blank, or when you want to update the list, 
proceed to the next step.
When the Source Library list does not need to be updated, proceed to step 5.

3 Click [Import].

A warning message appears.

4 Click [OK] to import the file information.

Importing of the file information starts.
When importing is completed, a message box appears. Clicking [OK] in the 
message box displays information on the video files obtained from the 
DDR(VDCP) on the Source Library list.

5 Select [Video] in the Video/Key Select drop-down list box.

6 Select the desired file(s) on the Source Library list.
You can select more than one file by using the Ctrl or Shift key.

The File List holds up to 999 files. 

7 Click [C ADD].

The selected file(s) are added in the Video column at the bottom of the File 
List.

8 When using a different device (unit/channel) for the key, specify a file to be 
used as the key for each video file.
This step is not necessary when the device for the video and the key is the 
same, that is, Device(K) is not specified in the Video Switcher Settings 
window.

For details, see “To specify the key file for a video file” (below).

9 Click [Save] to save the modified settings.

Note
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To specify the key file for a video file

1 Select [Key] in the Video/Key Select drop-down list box.

2 Select the desired key file(s) on the Source Library list.
You can select more than one file by using the Ctrl or Shift key.

3 Select the video file to be paired with the selected key file on the File List.
If you selected more than one key file in step 2, select the top one of the 
corresponding video files.
The selected key files will be added to the selected and subsequent lines on 
the File List. 

4 Click [C ADD].

The selected key file is added, and appears in the Key column on the File 
List.

Changing the Order of the Files

The following procedure changes the order of the files on the File List. You can 
arrange the list, so that files can easily be found when creating/editing cues. 

1 Select the desired device in the Device drop-down list box.

The file information created for the DDR(VDCP) is displayed on the File 
List.

2 Drag the desired file and drop it to the desired position on the File List.

The file is inserted at the position where it was dropped.

3 Repeat step 2 if you want to move another file on the list.

4 Click [Save] to save the modified settings.
75Managing Video Material - Creating the DDR(VDCP) File List



76

  C
hapter 3  M

aking the Initial S
etup
Deleting Files from the List

The following procedure deletes the selected files from the File List.

1 Select the desired device in the Device drop-down list box.

The file information created for the DDR(VDCP) is displayed on the File 
List.

2 Select the file(s) to be deleted.
You can select more than one file by using the Ctrl or Shift key.

3 Click [Delete].

A confirmation message is displayed.

4 Click [OK] to delete the file(s).

The selected file(s) disappear from the File List. The remaining files are 
rearranged on the list without any space between them.

5 Click [Save] to save the modified settings.
Managing Video Material - Creating the DDR(VDCP) File List
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Managing Audio Material
- Creating the Audio Server File List

The Initial Setup application shows the Audio Server File List Creation window, 
in which a technical director can select the audio files to be used in the news 
programs from all the files stored on the audio server. The selected files will be 
shown on a list when the audio server is selected while creating or editing cues, 
so that the desired audio files can be added to a playlist easily.

All the audio files to be used in the ELC-MVS01 system must be listed in 
advance using this Audio Server File List Creation setup tool.

Creating the File List

1 On the Initial Setup Main Menu, click the Audio Server File List Creation 
sub menu.

The Audio Server File List Creation window is displayed.

2 Select the desired device for which you would like to create a file list in the 
Device drop-down list box.

If the information on the audio files of the selected device has already been 
imported, the files are displayed on the File List and the Source Library.

Note
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When the Source Library list, which shows the audio files stored on the 
selected audio server, is blank, or when you want to update the list, proceed 
to step 3. When it does not need to be updated, proceed to step 5.

3 Click [Import].

A warning message appears.

4 Click [OK] to import the file information.

Importing of the file information starts.
When importing is completed, information on the audio files obtained from 
the audio server appears on the Source Library list.

5 Select the desired file(s) on the Source Library list.
You can select more than one file by using the Ctrl or Shift key.

The File List holds up to 999 files. 

6 Click [CADD].

The selected file(s) are added at the bottom of the File List.

7 Repeat steps 5 and 6 if you want to add more files to the File List.

8 Click [Save] to save the modified settings.

Changing the Order of the Files

The following procedure changes the order of the files on the File List. You can 
arrange the list so that files can easily be found when creating/editing cues. 

1 Select the desired audio server in the Device drop-down list box.

The file information created for the audio server is displayed on the File 
List.

2 Drag the desired file, and drop it to the desired position on the File List.

The file is inserted at the position where it was dropped.

3 Repeat step 2 if you want to move another file on the list.

4 Click [Save] to save the modified settings.

Note
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Deleting Files from the List

The following procedure deletes the selected files from the File List.

1 Select the desired audio server in the Device drop-down list box.

The file information created for the audio server is displayed on the File 
List.

2 On the File List, select the file(s) to be deleted.
You can select more than one file by using the Ctrl or Shift key.

3 Click [Delete].

A confirmation message is displayed.

4 Click [OK] to delete the file(s).

The selected file(s) disappear from the File List. The remaining files are 
rearranged on the list without any space between them.

5 Click [Save] to save the modified settings.
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Making the Studio Monitor Settings

The Initial Setup application shows the Studio Monitor Settings window, in 
which a technical director makes the following settings related to the AUX 
buses of the video switcher that outputs signals to the studio monitors.

• Enabling control of an AUX bus from the ELC-MVS01 system
This enables control of an AUX bus from the ELC-MVS01 system.

• Specifying the initial source for an AUX bus
This specifies the initial source device for an AUX bus. Video signals from 
the device will be output to the connected studio monitor when no Video Icon 
to be output is specified. This will prevent studio monitors from displaying an 
unexpected image displayed on its screen.

• Specifying the name for an AUX bus
The specified names for AUX buses appear in the ELC plug-in window and 
on playlists. Usually, a name that represents the connected studio monitor is 
used.

• Specifying the length of delay for switching the OA and NEXT cues
This makes switching video displayed on a studio monitor synchronous with 
switching the OA and NEXT cues.

Enabling Control of an AUX Bus from the ELC-MVS01 System

1 On the Initial Setup Main Menu, click the Studio Monitor Settings sub 
menu.

The Studio Monitor Settings window is displayed.

2 Select [Enable] in the Control drop-down list box for an AUX bus to enable 
control of that AUX bus from the ELC-MVS01 system.

3 Repeat step 2 for another AUX bus.
Making the Studio Monitor Settings
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4 Click [Save] to save the modified settings. 

To disable control of an AUX bus from the system
Select [Disable] in the Control drop-down list box for the desired AUX bus in 
step 2 in the procedure described above.

Specifying the Initial Source Device for an AUX Bus

1 In the Studio Monitor Settings window, select the AUX bus for which you 
want to specify the initial source device.

2 Narrow down the device, if necessary, by selecting the desired class using 
the Class drop-down list box. 

You can select from the following options.

Class Descriptions

All All devices will be displayed in the Initial Source 
(Device) drop-down list box.

Camera Select this option to specify a camera.

CG/Still Store Select this option to specify a CG or Still Store. 
Tip
The CG/Still Store is a server having a playlist 
function. The CG/Still Store controller type with a 
playlist function and a storage type can be a different 
device.The ELC-MVS01 does not control the CG/Still 
Store and does not perform file operations. With the 
tally off signal from the switcher, the next piece of 
material on the playlist will be loaded for standby.
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3 Select the desired device using the Initial Source (Device) drop-down list 
box.

4 Repeat steps 1 to 3 for another AUX bus.

5 Click [Save] to save the modified settings. 

DDR(VDCP) Select this option to specify a DDR(VDCP).
Tip
A disk recorder without a playlist function is 
supported. It can be used to handle frequently-used 
daily materials. 
The ELC-MVS01 software does not control the 
device. It only selects crosspoints from a DDR.

DDR(SonyVTR) Select this option to specify a DDR(SonyVTR). 
Use this option for a digital disk recorder that can be 
controlled by the Sony VTR protocol.
Tip
The ELC-MVS01 software does not control the 
device. It only selects crosspoints from a DDR.

Ext/Others Select this option to specify a Color Background or 
Re-Entry device within the switcher. 

Frame Memory Select this option to specify a Frame Memory within 
the switcher.

Remote Select this option to specify a remote device.

Class Descriptions
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Specifying the Name for an AUX Bus

1 In the Studio Monitor Settings window, click the Name column on the line 
for the desired AUX bus, and enter the name for the bus using up to eight 
alphanumeric characters and symbols.

2 Repeat step 1 if you want to specify the name for another AUX bus.

3 Click [Save] to save the modified settings.

You cannot leave the name of an AUX bus blank. If you delete the name, the 
default name corresponding to the AUX bus will be used.

Note
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Specifying the Length of Delay for Switching the OA and NEXT Cues

If there is a delay in performing the operation after the studio monitor accepted 
a command from the ELC-MVS01 software, specify the delayed value in the 
Studio Monitor Settings window. When this is set, other devices are controlled 
to be delayed according to the delay of the studio monitor, so that switching 
video displayed on a studio monitor is synchronous with switching the OA and 
NEXT cues. 

1 Specify the delayed value from 0 to 99 frames, using the spin box in the 
Delay column for the AUX bus in the Studio Monitor Settings window.

2 Repeat steps 1 if you want to specify the length of delay for another AUX 
bus.

3 Click [Save] to save the modified settings. 
Making the Studio Monitor Settings
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Overview of Icons 

The Icon Manager application allows you to create Video, Audio, Transition, 
and Effect Icons, which are elements to make a cue. The software also provides 
categories to classify Icons. This section provides an overview of Icons and 
categories you can create with the Icon Manager application.

Icons
An Icon symbolizes frequently-used settings of a video switcher, audio mixer, 
or devices for materials such as a camera, server, or CG. The following four 
types of Icons are available:

• Video Icon 
A Video Icon represents video materials of cameras, video servers, CG, and 
DDR. It is used to change video materials.

• Audio Icon
An Audio Icon represents audio materials of an audio server, or video server. 
It is used to change audio materials.

• Transition Icon
A Transition Icon represents a video transition setting. Various video 
transition settings are registered as a “snapshot” in the switcher, and the 
Transition Icon represents the snapshot.  It is used to make the transition from 
one cue to the next one.

• Effect Icon
An Effect Icon represents a setting of compound video effects. A frequently-
used effect is registered as a “snapshot” in the switcher, and the Effect Icon 
represents the snapshot. It is used to set a video effect.

 

An Effect Icon contains a Video Icon as an element.  Create an Effect Icon after 
the Video Icon is created.

In addition, the following icon is supplied by the system:

System Icons
The following System Icons are prepared by the ELC-MVS01 software and the 
users are thus not required to prepare them. Their categories are also created by 
the ELC-MVS01 software, automatically.

Note
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• Continuous
Audio and Video Icons for which class is designated as Continuous are used  
when identical material is used both in the OA cue and the NEXT cue.
If the same material is set in two consecutive cues, functions such as Play or 
Shot Recall of Camera will operate again from the beginning with the TAKE 
operation. To use the same material without repeating those operations, use 
this Icon. 

Example 1: When you want to make a Key On setting using a 
TAKE operation

In the above example, the Key On setting is set with a TAKE operation and 
the CG1 is superimposed on the DDR image. Playback of the DDR image 
continues in the next cue. 

Example 2: When you want to adjust the audio level using a TAKE 
operation

In the above example, the audio level is reduced with a TAKE operation while 
switching cues. Playback of the audio file continues in the next cue.

Example 3: When you want to continue to play the video file of the 
previous cue on a different bus

Camera image displayed in full screen 
(A bus) and playout server image in 
the inset screen (Key 1 bus)

Playout server image displayed 
in full screen (A bus)
Overview of Icons
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In the above example, a video file stored on the playout server is played on the 
Key 1 bus and hence superimposed as a picture-in-picture video, at first. This 
file continues to be played on the A bus, so that it enlarges to full-screen size, 
with a TAKE operation.

• PO Server
Video and Audio Icons for which class is designated as PO Server.
There are two types of PO Server Icons: one for an as-yet-undetermined 
channel that is supplied by the system, and the other for each channel. The 
user must create an Icon for each channel to display it in a playlist. 
If the Icon for an undetermined channel of the PO Server is used in a cue, it 
will be replaced with the Icon corresponding to the channel when the Icon is 
actually pasted in the NRCS client window and the channel is set. 

Categories
The Icon Manager allows you to create categories to be used to classify Icons. 
Categories are created to narrow down the Icons to be displayed in the Cue Edit 
window, so that you can select an appropriate Icon easily. 
Create categories, and then register the Icons in the respective categories.
There are the following exceptions:
• The Icons of DDR(VCDP) and Audio Server classes, which show file lists 

when the category is selected will be automatically registered in the relevant 
class categories when their category types are specified. 

• The Icons of PO Server and Continuous classes, which are supplied by the 
system, will be automatically registered in the relevant categories that are 
created by the system.

Workflow for creating icons and categories
The following provides an overview of the workflow for creating icons and 
classifying icons into categories:

Create an Icon by clicking [Create New] in the Icon Library.

See “Creating Icons”  (page 90).

m

Create a category by clicking [Create New] in the Category List.

See “Creating Categories”  (page 102).

m

Select a category registered in the Category List, select an Icon 
that you want to register in the Icon List, and then click [ADD] to 

add an icon to the category.

See “Registering an Icon in a Category”  (page 107).
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The ELC-MVS01 system enables you to import “Shots” from robotic cameras 
in the system as Video (Camera) Icons. The workflow is different from the one 
shown above when importing shots from robotic cameras as Video (Camera) 
Icons.

See “Importing Camera Shots and Creating Icons” on page 110 for details on 
this operation.

Note
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Starting the Icon Manager Application

Before you start the Icon Manager
To create Icons in the Icon Manager, the following preparations are necessary:

• Building up the database
In the System Setup, Device Resources should be set up. Without these 
settings, options such as Class and Device are not displayed in the Icon 
Manager. 

• Creating graphic data for thumbnails
In the Icon Manager, Icons are displayed graphically using the prepared 
graphic data.

• Creating snapshots with the video switcher
The Icon Manager reproduces transition, key, and other video effects by 
recalling snapshots, so snapshots should be prepared in advance.

• Creating a macro with the video switcher
Some types of transitions, such as CG Wipe, can use a macro of the video 
switcher, so macros should be prepared in advance.

1 Double-click the Icon Manager icon on the Windows desktop.
Or, double-click the IconManager.exe file in the “Sony\ELC\IconMgr” 
folder on the drive where the ELC-MVS01 software is installed.

The Icon Manager starts and the Icon Manager window is displayed.

 

Only one Icon Manager application can be operated in a system at a time. If the 
Icon Manager application is already operating on the same computer, or on a 
different computer in the system, you cannot start the application.

Exiting the Icon Manager application

1 Click [File] > [Exit] from the menu bar of the Icon Manager Main Menu.

If there is an unsaved operation, the Icon Manager application asks you 
whether you want to save it. Save it if necessary. The Icon Manager 
application is closed.

Note
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Managing Icons

This section explains how to create and set in detail an icon. You can also edit 
or delete a created icon.

Creating Icons

This section explains how to create an Icon, an element for creating a cue. 

For details of each Icon settings, see “Setting Icons” on page 91.

1 Click the desired tab, Video, Audio, Transition, or Effect, in the Icon 
Manager.

The window for the selected tab is displayed.

2 Click [Create New] on the Icon Library. 
Or, right-click on the Icon Library, and select [Create New] from the menu 
displayed.

The Icon creation window is displayed.

Icon preview
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3 Input the desired name of up to eight alphanumeric characters in the Icon 
Name text box.

The input name appears under the Icon thumbnail of the Icon preview block.

4 Click [Ref.] next to the Thumbnail box to display the image list contained 
in the relevant Windows folder. Then select the desired image for the 
thumbnail.

It is recommended that you use a graphic (jpeg/bmp) file displayed at 80 x 
45 pixels. 

Sample icon graphic files from Sony are supplied free for your use in the 
“Sony\ELC\BitmapIcon”  folder on the drive where the ELC-MVS01 
software is installed. 

5 Make the required settings to create a new Icon.

For details, see “Setting Icons” on page 91.

6 Click [OK].

The selected Icon window is closed. The created Icon is added to the end of 
the Icon Library.

Setting Icons

Video Icons 
You can create and edit Video Icons in the Video Icon window. 

1 Select the class where the desired device is classified from the Class drop-
down list box.

You can select from the following options. According to the class selected 
here, the rest of the menus show different options. 

Tip

Class Descriptions

Camera Select this option to create a camera Icon.

Icon preview
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You can set the Class only when you are creating a new Icon. When you edit 
an existing Icon, the Class boxes are disabled.

2 Select the desired device from the Device drop-down list box. 

You can select from the devices of the selected class as follows. Depending 
on the class you have selected in step 1, the type of devices differs.

3 When you select [Camera] for the Class in step 1, specify the Camera 
Control options.

Check either the Manual or Auto option box:

CG/Still Store Select this option to create a CG or Still Store Icon. 
Tip
The CG/Still Store is a server having a playlist 
function. The CG/Still Store controller type with a 
playlist function and a storage type can be a different 
device. The ELC-MVS01 does not control the CG/Still 
Store and does not perform file operations. With the 
tally Off signal from the switcher, next piece of 
material on the playlist will be loaded for standby.

DDR(VDCP) Select this option to create a DDR(VDCP) Icon.
Tip
A disk recorder without a playlist function is 
supported. It can be used to handle frequently-used 
daily materials. You can specify files from the ELC-
MVS01.

DDR(SonyVTR) Select this option to create a DDR(SonyVTR) Icon. 
Use this option for a digital disk recorder that can be 
controlled by the Sony VTR protocol.

Ext/Others Select this option to create a Color Background or 
Re-Entry Icon within the switcher. 

Frame Memory Select this option to specify a Frame Memory Icon 
within the switcher. 

PO Server Select this option to create a playout server Icon.
Tip
A playout server is a server having a playlist function. 
It can be used to handle daily-changing materials. 
The playout server controller type with a playlist 
function and a storage type can be a different device. 
The ELC-MVS01 controls the playback function and 
does not select files. 

Remote Select this option to create a remote Icon.

Note

Class You can select:

Camera Devices classified as camera in the database.

CG/Still Store Devices classified as CG/Still Store in the database. 

DDR(VDCP) Devices classified as DDR(VDCP) in the database. 

DDR(SonyVTR) Devices classified as DDR(SonyVTR) in the database. 

Ext/Others Devices classified as Ext/Others in the database.

Frame Memory Devices classified as Frame Memory in the database.

PO Server Devices classified as PO Server in the database.
Select this option to create a PO Server Icon for each 
playout server channel.

Remote Devices classified as Remote in the database.

Class Descriptions
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• Manual: Select this option to control the switcher’s cross point selection 
only, and to control the camera manually. 

• Auto: Select this option to control both the switcher’s cross point 
selection and to perform automatic control (Shot Recall) over the robotic 
camera. 
When you select Auto, the Show and Shot boxes become enabled. 
Proceed with the settings as follows:

Audio Icons  
You can create and edit Audio Icons in the Audio Icon window. 

 

The Audio Icons classified as CG/Still Store, DDR(VDCP), DDR(SonyVTR), 
PO Server, and Remote will be created automatically when a Video Icon is 
created. 

For details, see “List of Required Settings in Icon Creation and Category 
Registration” on page 114.

1 Select the class where the desired device is classified from the Class drop-
down list box.

You can select from the following options. According to the class selected 
here, the rest of the menus show different options. .

You can set the Class only when you are creating a new Icon. When you edit 
an existing Icon, the Class boxes are disabled.

Options Descriptions

Show Click the down arrow to display the Show options of 
the selected Device. Select the desired show option.  

Shot Click the down arrow to display the Shot options of 
the selected Show. Select the desired shot option.

Import button Click the button to re-load the Show/Shot information 
from the robotic camera.

Note

Class Descriptions

Audio Server Select this option to create an audio server Icon. 

Ext/Others Select this option to create a piece of material Icon for 
which the device control is not required.

Note

Icon preview
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2 Select the desired Device for the Icon from the Device drop-down list box. 

You can select from the following options. Depending on the class you have 
selected in step 1, the type of devices differs.

Transition Icons  
You can create and edit Transition Icons in the Transition Icon window. 

1 Select the class where the desired device is classified from the Class drop-
down list box.

You can select from the following options. According to the class selected 
here, the rest of the menus show different options. 

1) The option cannot be used for a key.

Class You can select:

Audio Server Devices classified as audio server in the database.

Ext/Others Devices classified as Ext/Others in the database.

Class Descriptions

Mix Select this option to create a Mix icon.

NAM 1) Select this option to create a NAM icon.

Super Mix1) Select this option to create a Super Mix icon.

Wipe Snapshot1) Select this option to create a Wipe Snapshot icon.

DME Wipe Snapshot1) Select this option to create a DME Wipe Snapshot icon.

User Programmable 
DME

Select this option to create a User Programmable 
DME icon.

Resizer DME Wipe2) Select this option to create a Resize DME Wipe icon. 

Macro1) 3) Select this option to create a Macro icon.

Preset Color Mix1) Select this option to create a Preset Color Mix icon.

Icon 
preview
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2) The option can be used only for a key.
3) The option cannot be used for a studio monitor.

You can set the Class only when you are creating a new Icon. When you edit 
an existing Icon, the Class box is disabled.

2 Depending on the class you select in step 1, set the following options.

❐ When Wipe Snapshot or DME Wipe Snapshot is selected as 
Class

❐ When Mix, NAM, Super Mix, User Programmable DME, 
Resizer DME Wipe, or Preset Color Mix is selected as Class

Note

Options Descriptions

Pattern No. Specify the desired pattern number to be used, or 
leave this blank.
When this option is left blank, the pattern number 
specified in Wipe Snapshot or DME Wipe Snapshot 
will be used. When a pattern number is specified 
here, it will have priority. 

Direction This option is disabled. Register setting of this 
option in the Wipe Snapshot or DME Wipe 
Snapshot settings in advance.

Snapshot No. Specify a Wipe Snapshot or DME Wipe Snapshot 
number from 1 to 10. 

Number of DME CH Specify the number of DME channels to be used in 
the Icon from 0 to 4. 
Note
Specify the appropriate number when you use 
DME. The system will display insufficient-DME-
resource warning messages in a playlist based on 
this setting.

Macro This option is disabled.

Options Descriptions

Pattern No. Specify the desired pattern numbers to be enabled 
depending on the class you selected:
Resizer DME Wipe:
• 7001 to 7008
• 7021 to 7031
• 7201 to 7208
• 7221 to 7224
User Programmable DME:
• 1901 to 1999 (pattern using 1CH DME)
• 2901 to 2999 (pattern using 2CH DME)
• 3901 to 3999 (pattern using 3CH DME)

Direction Select either Normal or Reverse. You can set this 
option when User Programmable DME or Resizer 
DME Wipe is selected.

Snapshot No. This option is disabled.

Number of DME CH This option is disabled. 

Macro This option is disabled.
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❐ When Macro is selected as Class

Options Descriptions

Pattern No. This option is disabled. Register the setting of this 
option within the Macro.

Direction This option is disabled. Register the setting of this 
option within the Macro.

Snapshot No. This option is disabled. Register the setting of this 
option within the Macro.

Number of DME CH Specify the number of DME channels to be used in 
the Icon from 0 to 4. 
Note
Specify the appropriate number when you use DME. 
The system will display insufficient-DME-resource 
warning messages in a playlist based on this setting.

Macro This option is displayed only when Macro is selected 
for class.  Set the following in the Macro block:

Macro No. Specify the desired Macro number from 1 to 250.

Macro 
Duration

Specify the duration that has been specified for the 
Macro on the switcher from 0 to 999 frames.

Next Start 
Delay

If the start timing of the next cue image (device 
control) needs to be delayed against the start timing 
of a transition effect (CG Wipe) that is executed by a 
Macro, specify the length of the delay from 0 to 999 
frames. 

(Example: when the next cue B needs to be delayed)
Without a delay:

Play Timing If there is a delay between “start timing of the Macro” 
and “start timing of the transition effect that is 
included in the Macro,” specify the length of the delay 
from 0 to 999 frames. 
When this delay (Play Timing) is set, other devices 
are delayed according to the delay of the transition 
effect, so that the start of the transition effect is 
synchronous with the play timing of other devices.

With a delay:

R
Play starts

R
Play starts
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Effect Icons  
You can create and edit Effect Icons in the Effect Icon window.  

1 Select the class where the desired device is classified from the Class drop-
down list box.

You can select from the following options. According to the class selected 
here, the rest of the menus will show different options. 

You can set the Class only when you are creating a new Icon. When you edit 
an existing Icon, the Class box is disabled.

Icon 
preview

Class Descriptions

SPE Select this option to create a Special Effect Icon that 
allows you to perform picture effects using a 
snapshot. In addition to simple picture effects, you 
can register more complicated settings, such as 
manual switching of multiple snapshots while on the 
air (2box), or manual switching of the bus between 
random materials while on the air. 
For details, see “Preparing for Switching Multiple 
Snapshots Manually (2Box)” on page 137.

Note
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2 In the Snapshot Settings block, set the snapshots you will use in the Effect 
Icon.

For using multiple snapshots, you must make the required necessary 
settings in the Snapshot Settings block: the Standby Group#, Group Item 
Selection, and Group Name. 

For detailed settings, see “Preparing for Switching Multiple Snapshots 
Manually (2Box)” on page 137.

3 In the Manual Switching block, set the manual switching you will use in the 
Effect Icon.

For details, see “Preparing for Manual Switching” on page 143.

Setting in the source window
The Source window allows you to change the source settings of the bus. 

1 Double click on the desired thumbnail in the Bus Settings block on the 
Effect Icon window.

Options Descriptions

Number of Snapshot 
Groups

Specify how many snapshot groups should be used, 
from 1 to 4. 
A snapshot group represents a combination of 
snapshots, which you can recall by pressing the 
button assigned to a snapshot group on the shot box 
module. To recall one snapshot group, the number 
should be “1.” To recall multiple snapshot groups, 
select 2 to 4, corresponding to the number of snapshot 
groups that you want to recall.

• When “1” is selected:
Example: One snapshot is used and camera and 
CG are mixed. 

Group Item Put a check mark next to the places where you want to 
use snapshots, and then specify a snapshot number 
using the drop-down list box.

Number of DME CH Specify the number of DME channels to be used in the 
Icon. 
Note
Specify the appropriate number when you use DME. 
The system will display insufficient-DME-resource 
warning messages in a playlist based on this setting.
Managing Icons



  C
hapter 4  P

reparing Icons (Icon M
anager)
The Source window of the selected bus is displayed.

2 Select whether you will use the bus image in performing effects. 

• Not Demand: Select this option when you do not want to use the bus 
image. When you set an image in Cue Edit, you will not be prompted to 
select a Bus image.

•

• Demand: Select this option to use the Bus image in the image mix effect. 
When you set an image in Cue Edit, you will be prompted to select an 
image for the Bus.

3 Input the desired bus name of up to eight alphanumeric characters in the Bus 
Name text box.

4 Click [OK].

The settings take effect. The Source window is closed. The Effect Icon 
window is displayed again. 
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5 Select the desired bus in the Bus Settings block, and repeat steps 2 through 
4 to make the settings.

All the available buses to be used with the switcher are displayed. To change 
the settings, double-click on the thumbnail display block on the bus to 
display its source window.

Editing Icons

This section explains how to edit the settings of an Icon.

1 Click the desired tab, Video, Audio, Transition, or Effect, in the Icon 
Manager.

The window for the selected tab is displayed.

2 Click the desired Icon in the Icon Library, and click [Edit].
Or, right-click on the desired icon in the Icon Library, and select [Edit] from 
the menu displayed.

The Icon setting window is displayed.

You cannot edit an Icon in the Icon List.

3 Perform the desired settings.

For details, see “Setting Icons” on page 91.

4 Click either of the two to execute the settings.

• Save: Saves the settings, overwriting the existing Icon. The Icons in the 
Icon List is updated, reflecting the changes.
When saving is complete, the [Save] button becomes disabled.

• Save as: Adds a new Icon to the Icon Library.

Moving an Icon within the Icon Library

This section explains how to move an Icon to the desired place in the Icon 
Library.

Display examples Descriptions

The A bus is used. The bus name is displayed 
if it is specified. In the Cue Edit window, you 
will be prompted to select a Video Icon.

The A bus is not used. A bus name will not be 
displayed even if it is specified. Instead, Not 
Demand is displayed.

The A bus is used. The bus name is displayed 
if it is specified. Manual Switching is 
associated with the A bus.

Note
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1 Click the desired tab, Video, Audio, Transition, or Effect, in the Icon 
Manager.

The window for the selected tab is displayed.

2 Drag the desired Icon and drop it to the desired position in the Icon Library.

The Icon is moved.

Deleting Icons

This section explains how to delete an Icon from the Icon Library.

• When you delete an Icon belonging to a category in the Icon Library, the Icon 
will also be deleted from the category.

• Once an Icon is deleted, you cannot select it when creating a new cue. Even if 
it has already been used in an existing cue, you can still continue to use the 
Icon.

1 Click the desired tab, Video, Audio, Transition, or Effect, in the Icon 
Manager.

The window for the selected tab is displayed.

2 Click the desired Icon in the Icon Library, and click  [Delete].
Or, right-click on the desired icon in the Icon Library, and select [Delete] 
from the menu displayed.

A confirmation dialog box is displayed.

3 Click [OK].

The Icon is deleted from the Icon Library.

Notes
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Managing Categories

This section explains how to create and set in detail a category for classifying 
icons. You can also edit, move or delete a created category.

Creating Categories
This section explains how to create categories to store Icons.

For details of each category setting, see “Setting Categories” on page 103.

1 Click the desired tab, Video, Audio, Transition, or Effect, in the Icon 
Manager.

The window for the selected tab is displayed.

2 Click [Create New] in the Category List.
Or, right-click on the Category List, and select [Create New Category] from 
the menu displayed.

The category setting window is displayed.

Category 
list

Icon Library
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3 Click the Category Name text box to make the box in the input mode.

4 Input the desired name of up to 25 alphanumeric characters in the Category 
Name text box.

5 When you create a Video or Audio category, select the desired category 
type from the Category Type drop-down list box.

According to the category type selected here, the Icons are automatically 
selected and displayed in the Cue Edit window when you select a category.

• Once you select a category type, the relevant Icons are automatically 
selected and displayed in the Icon Library. You cannot register an Icon in 
the Icon Library manually.

• The system supplies the Continuous Icon and PO Server Icons for an as-
yet-undetermined channel, creates the respective categories for them, and 
allocates the Icons to the relevant categories, automatically. Selecting the 
Continuous or PO Server category in the Cue Edit window automatically 
displays these system-supplied Icons.

• For Transition and Effect categories, category type setting is not 
necessary.

For details, see “Setting Categories” (below).

6 Click [OK].

The category is added to the end of the Category List.

Setting Categories

When you create a category, you can select the following category types:

To create a category for free registration
This category is used to register Icons freely.  (For Audio and Video Icons)
To create a category, select Blank for the category type(1).

.

In the Icon Library (2), nothing is displayed. Setting an icon here is not 
necessary. 

Notes

Category name

Category type

Icon library
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When this type of category is selected in Cue Edit window, user-registered 
Icons are displayed.

To create a category designed for DDR(VDCP) 
This category is used to contain the files of the devices whose class is 
DDR(VDCP). (For Video Icons)
To create a DDR(VDCP) category, select DDR(VDCP) for the category 
type(1).

In the Icon Library(2), Icons classified as DDR(VDCP) are displayed. Select 
the Icon whose registered file list you want to use (3). To delete the setting, 
click [Delete] (4) next to the Icon preview.

To create a category designed for Audio Server
This category is used to contain the files of the devices whose class is Audio 
Server. (For Audio Icons)
To create an Audio Server category, select audio server for the category type 
(1).

.

Category name

Category type

Icon library 

Category name

Category type

Icon library 
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In the Icon Library (2), Icons classified as Audio Server are displayed. Select 
the Icon whose registered file list you want to use (3). To delete the setting, 
click [Delete] (4) next to the icon preview.

Editing Categories

This section explains how to change the category settings.

1 Click the desired tab, Video, Audio, Transition, or Effect, in the Icon 
Manager.

The window for the selected tab is displayed.

2 Click the desired category in the Category List, and click [Edit].
Or, right-click on the desired category in the Category List, and select [Edit] 
from the menu displayed.

The category setting window is displayed.

3 Perform the required settings.

For details, see the steps 3 through 5 of “Creating Categories” on page 
102.

4 Click [OK].

The settings take effect. The Category List reflects the changes.
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Moving Categories

This section explains how to move a category within the Category List.

1 Click the desired tab, Video, Audio, Transition, or Effect, in the Icon 
Manager window.

The window for the selected tab is displayed.

2 Drag the desired category and drop it to the desired position in the Category 
List.

The category is moved.

Deleting Categories

This section explains how to delete a category from the Category List.

1 Click the desired tab, Video, Audio, Transition, or Effect, in the Icon 
Manager window.

The window for the selected tab is displayed.

2 Click the desired category in the Category List, and click  [Delete].
Or, right-click on the desired category in the Category List, and select 
[Delete] from the menu displayed.

A confirmation dialog box is displayed.

3 Click [OK].

The category is deleted from the Category List.
Managing Categories



  C
hapter 4  P

reparing Icons (Icon M
anager)
Registering an Icon in a Category

This section explains how to register an Icon in a category. By categorizing 
Icons, you can display necessary Icons in the Cue Edit window, making Icon 
selection easier. 

• Once an Icon is registered in a category, you cannot move it to another 
category. To register the identical Icon to another category, add it from the 
Icon Library.

• You cannot add an Icon to a category whose category type is already 
specified. However, Icons in the PO Server class can be added in the PO 
Server category, as an exception.

1 Click the desired tab, Video, Audio, Transition, or Effect, in the Icon 
Manager window.

The window for the selected tab is displayed.

2 Click the desired category in the Category List.

The Icons currently registered in the category appear in the Icon list.

3 Click the Icon that you want to add to the category in the Icon Library.

To search for an Icon in the Icon Library
You can locate a desired Icon by using the controls in the search block.
1 Check the desired check box from Name, or  Class that you want to use 

for searching for Icons. 
2 When you select Name, enter the desired Icon name in the text box. 

When you select Class, select the desired class from the list box.

Notes

Icon List

Search block
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For the details of Class, see explanations of each icon in “Setting 
Icons” on page 91.

3 Click [Search].
The Icons found are added to the Icon Library. 

4 Click [Add].

The selected Icon is registered in the category and added to the end of the  
Icon List.

You can also use a drag & drop operation to register an Icon in a category.
Instead of steps 3 and 4 in the procedure above, drag the Icon that you want to 
add to the category in the Icon Library, and drop it at the desired position on the 
Icon List.

Moving an Icon within a Category

1 Click the desired tab, Video, Audio, Transition, or Effect, in the Icon 
Manager window.

The window for the selected tab is displayed.

2 Click the desired category in the Category List.

The Icons currently registered in the category appear in the Icon List.

3 In the Icon List, drag an Icon and drop it to the desired position.

The Icon is moved.

Deleting Icons from a Category

This section explains how to delete an Icon from a category. In this case, the 
Icon itself is not deleted, so the same Icon in another category or in the Icon 
Library is not deleted. 

You cannot delete an Icon from a category whose category type is already 
specified.
However, Icons of the PO Server class added in the PO Server category can be 
deleted, as an exception.

1 Click the desired tab, Video, Audio, Transition, or Effect, in the Icon 
Manager.

The window for the selected tab is displayed.

Tip

Note
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2 Click the desired category in the Category List.

The Icons currently registered in the category appear in the Icon list.

3 Click the desired Icon in the Icon List, and click  [Delete].
Or, right-click on the desired Icon in the Icon List, and select [Delete] from 
the menu displayed.

A confirmation dialog box is displayed.

4 Click [OK].

The Icon is deleted from the Icon List.

Icon List
109Registering an Icon in a Category



110

  C
hapter 4  P

reparing Icons (Icon M
anager)
Importing Camera Shots and Creating Icons

There is an Import button on the Video tab in the Icon Manager window. This 
button enables you to import “shots” from robotic cameras to create/update 
Video Icons of the Camera class.

1 Click the Video tab in the Icon Manager.

2 Select the category to which you want to import the camera shots as Icons.

3 Click [Import] on the Icon List. 
Or, right-click on the Icon List, and select [Import] from the menu 
displayed.

The Import from Camera Robotics dialog box appears. 
If you have imported shots from robotic cameras before, the imported shots 
are listed on the Camera Shot List.
Importing Camera Shots and Creating Icons
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4 Click [Import] in the Import from Camera Robotics dialog box.

The ELC-MVS01 software imports all the shows and shots from the 
robotics cameras in the system. When import is complete, an information 
message appears.

5 Click [OK] on the message.

All the imported shots are shown on the Camera Shot List.

6 Select the shots to be Icons on the Camera Shot List, then click [CAdd].
You can select more than one shot by using the Ctrl or Shift key.

The selected shots appear as Icons on the Icon List.

To search for shots
The Import from Camera Robotic dialog box provides functions to search 
for shots by specifying the device (robotics camera) and the show. 
1 In the Import from Camera Robotic dialog box, select the desired 

robotic camera from the Device drop-down list box.

2 Select the desired show from the Show drop-down list box.

The Camera Shot List only displays the shots of the selected camera and 
show.

3 To display all imported shots again, select [All] from the Device and 
Show drop-down list boxes.
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7 Click [OK] in the Import from Camera Robotics dialog box.

The dialog box closes, and the created Icons are shown in the Icon List and 
Icon Library of the Icon Manager window.

Importing of the thumbnails from a robotic camera may not be possible, 
depending on the camera system you use.
In such a case, specify the desired thumbnail for each imported Icon.

For details on this operation, see “Editing Icons” on page 100 and “Creating 
Icons” on page 90.

To delete an Icon from the Icon List 
The following procedure deletes the selected Icons from the Icon List of the 
Import from Camera Robotics dialog box.

1 Select the Icons to be deleted on the Icon List.
You can select more than one icon by using the Ctrl or Shift key.

2 Click [Delete].

The selected Icons are deleted from the list.

Note

Device and Show 
drop-down list boxes 
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To move an Icon on the Icon List 
The following procedure moves an Icon to the desired place on the Icon List of 
the Import from Camera Robotics dialog box.
The order of the Icons on the list will be reflected when the imported Icons are 
displayed in the Icon Library.

Drag the desired Icon, and drop it to the desired position on the Icon List of the 
Import from Camera Robotics dialog box.
The Icon is moved.

To rename an Icon
For a newly imported Icon, the first eight characters of its shot name will be its 
name. If an Icon created from the same device, show, and shot already exists in 
the Icon Library, the name for the existing Icon will be used. 
You can rename each Icon on the Icon List, if necessary.

Click the name of the Icon, then enter the desired name using up to eight 
alphanumeric characters.
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List of Required Settings in Icon Creation and 
Category Registration

Depending on the type or class of an Icon, the following settings are required in 
creation, classification, and categorization.

Icons type Class Creating an Icon Creating a category Registering an Icon 
in a category

Video Camera An Icon should be created for each 
Video input.

You can create categories 
freely.

Required

CG/Still Store An Icon should be created for each 
Video channel.

You can create categories 
freely.

Required

DDR(VDCP) An Icon should be created for each 
Video channel.

Category type should be 
specified.

Not required

DDR(SonyVTR) An Icon should be created for each 
Video input.

You can create categories 
freely.

Required

Continuous Not required. The Icon is supplied by 
the system.

Not required. The category 
is created automatically.

Not required

Ext/Others An Icon should be created for each 
Video input.

You can create categories 
freely.

Required

Frame Memory An Icon should be created for each 
Video input.

You can create categories 
freely.

Required

PO Server The Icon for an undetermined 
channel not required. 
An Icon should be created for each 
Video input.

Not required. The category 
is created automatically.

Not required for the 
Icon for an as-yet-
undetermined 
channel.
Required for an Icon 
corresponding to 
individual Video input.

Remote An Icon should be created for each 
Video input.

You can create categories 
freely.

Required

Audio Audio Server An Icon should be created for each 
Audio input.

Category type should be 
specified.

Not required

CG/Still Store Not required. An Icon is created 
automatically with the Video Icon.

You can create categories 
freely.

Required

DDR(VDCP) Not required. An Icon is created 
automatically with the Video Icon.

You can create categories 
freely.

Required

DDR(SonyVTR) Not required. An Icon is created 
automatically with the Video Icon.

You can create categories 
freely.

Required

Continuous Not required. The Icon is supplied by 
the system.

Not required. The category 
is created automatically.

Not required

Ext/Others An Icon should be created for each 
Audio input.

You can create categories 
freely.

Required

PO Server Not required. An Icon is created 
automatically with the Video Icon.

Not required. The category 
is created automatically.

Not required for the 
Icon for an as-yet-
undetermined 
channel.
Required for an Icon 
corresponding to 
individual Audio input.

Remote Not required. An Icon is created 
automatically with the Video Icon.

You can create categories 
freely.

Required
List of Required Settings in Icon Creation and Category Registration



  C
hapter 4  P

reparing Icons (Icon M
anager)
Transition Mix Icon creation is required. You can create categories 
freely.

Required

NAM

Super Mix

Wipe Snapshot

DME  Wipe 
Snapshot

User Programmable 
DME

Resizer DME Wipe

Macro

Preset Color Mix

Effect SPE Icon creation is required. You can create categories 
freely.

Required

Icons type Class Creating an Icon Creating a category Registering an Icon 
in a category
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Starting the ELC Plug-in Application

The ELC Plug-in application, working as a plug-in application for the NRCS client window, 
allows you to create and edit a cue. By registering a frequently-used scene as a cue, you can 
improve the efficiency of playlist creation. The ELC Plug-in application provides the following 
two applications:
• Quick Cue: Allows you to create a cue by registering the settings of frequently-used scenes.
• Cue Edit: Allows you to edit a cue created in Quick Cue. 

• In some cases, the Quick Cue and Cue Edit applications displayed in the ELC Plug-in window 
are referred to as the Quick Cue and Cue Edit windows in this guide.

• The Playlist Viewer and OA Playlist applications also have a window that provides the Quick 
Cue and Cue Edit applications on the respective tabs. 

1 Start the NRCS client window.

2 Depending on the NRCS client software you use, start the ELC Plug-in application as follows:

• iNEWS: Click [Tools ] > [Plug-in] > [ELC Plug-in] from the menu bar.
• ENPS: Click the rover (green dot) of the Media Control icon on the bottom bar of the ENPS 

client window, and select [ELC Plug-in] from the displayed menu. 

The ELC Plug-in window is displayed. (The window below is the iNEWS window.)

Tips
Starting the ELC Plug-in Application
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You can start as many ELC Plug-in applications simultaneously on different 
computers as the number of licenses you have. 

Exiting the ELC Plug-in application

1 Click  on the upper right of the ELC Plug-in window.

The ELC Plug-in application is closed.

 

If you do not save the settings, the revisions do not take effect.

Tip

ELC Plug-in window

Note
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Managing Cues

This section explains how to create a cue, setting its details, move or delete a 
cue, or copy a cue.

Creating a Cue

This section explains how to create cues to be used in a playlist. 
If there is no folder to contain cues, first create a folder.

For details, see “Creating a Cue Folder” on page 135. 

1 Click the Quick Cue tab of the ELC Plug-in window.

The Quick Cue window is displayed.

2 From the cue folder list, click the folder in which you want to create and 
save a new cue. 

The cues contained in the folder are displayed.

3 Right-click on the blank space of the cue list block, and click [Create New 
Cue] from the menu displayed.

The Cue Edit window is displayed. The new cue is loaded into the window 
as the current cue.

4 Make the required settings for a new cue.

For details, see “Details of Settings” below.

current cue
Managing Cues
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To delete Icons in the Cue Edit window
You can delete an Icon from the object list and the current cue row.

1 Right-click on the Icon that you want to delete, and select [Delete] from 
the menu displayed.
A confirmation dialog box is displayed.

2 Click [OK].
The Icon is deleted from the object list and the current cue row. 

5 Click [Save] or [Save as].

The Rename dialog box is displayed. The default name for the new cue is 
shown in the Rename dialog box.

6 Edit the name with up to eight alphanumeric characters for the cue, if 
necessary.

7 Click [OK].

The new cue is added at the end of the cue list.

Details of Settings

Setting Effect
You can set an Effect Icon in a new cue or an existing cue being displayed as 
the current cue in the Cue Edit window.  

1 Click the Video Icon display block in the current cue.

2 Click the Effect column on the object list.

3 Click the desired effect category in the category list.

In the category list, the effect categories created in the Icon Manager are 
displayed. 
When a category is selected, the Icons in the selected category are displayed 
in the Icon list.

4 Select the desired Icon in the Icon list.

The Icons classified in the effect category are listed. 

Video Icon display block in the current cue

Detailed settings
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When you select an Icon, the detailed settings block is updated to show the 
items for the selected Icon.

For selecting a Video Icon for each bus displayed on the object list, follow the 
procedures described in “Setting Video”(next).

For each Key detailed settings, follow the procedures described in “Setting 
Keys” on page 124.

Setting Video
You can set a Video Icon in a new cue or an existing cue being displayed as the 
current cue in the Cue Edit window. 

1 Click the Video Icon display block in the current cue.

2 Click the desired bus on the object list.

To use a free M/E
When there is another M/E in addition to the OA and NEXT M/Es on your 
switcher, you can specify its output to a bus to create more intricate effects. 
For details, see “Using a free M/E” on page 123.

3 Click the desired category in the category list.

In the category list, the video categories created in the Icon Manager are 
displayed. 
When a category is selected here, the Icons in the selected category are 
displayed in the Icon list.

4 Select the desired Icon in the Icon list.

Category type Descriptions

Continuous The Continuous icons supplied by the system are 
displayed. There are several Icons for continuously playing 
video on a different bus from the previous cue, too.
For details, see “Continuous” on page 86.

DDR(VDCP) DDR(VDCP) files registered as video files with the Initial 
Setup are displayed on the file list. 

File list

Object list

Video Icon display block in the current cue
Managing Cues
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The selected Icon is displayed in both the current cue and the object list.

5 Depending on the settings made in previous steps, change the detailed 
settings.

❐When you select a Video Icon classified as DDR(SonyVTR) 
in step 3
A detailed block for setting the IN point is displayed. Specify the IN point 
of the video materials. Specify the desired time codes for the IN point in 
the HH:MM:SS:FF format using the spin boxes. 

❐When you select bus A or bus B in step 2
A block for setting Side Flag is displayed. If necessary, make the Side 
Flag settings. 

PO Server The PO Server icon for an as-yet-undetermined channel 
supplied by the system, and the PO Server icon for each 
channel that was registered in the PO Server category are 
displayed. 
Tip
Select a PO Server icon for an as-yet-undetermined 
channel when the channel should be assigned on the 
NRCS. To specify the channel in the ELC-MVS01 system, 
select the PO Server icon for the corresponding channel.

Others The Icons registered in the selected category are 
displayed.

Option Descriptions

HH 00 - 23

MM 00 - 59

SS 00 - 59

FF 00 - 29 or 00 - 24 depending on the system you are using.

Option Descriptions

On Enables the Side Flag function. At both sides of a 4:3 source 
image,  Util1 images are displayed so that the aspect ratio of the 
image becomes 16:9.

Off Disables the Side Flag function. The input image is used as it is.

Category type Descriptions

In point settings
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• To change the Side Flag settings for the NEXT cue just before the on-
air operation, you can execute the Side Flag function by assigning it to 
the shot box module. This change in the settings on the shot box 
module, however, is not reflected in the Cue Edit window.
For details, see “Assigning Functions to the Shot Box Module Buttons” 
on page 65

• When you want to use the same Util1 image without changing it for 
cues, use the Initial Snapshot setting.

• When you use the Side Flag function for a cue where multiple 
snapshots (2box) or manual switching is specified, the Side Flag 
function may not work properly when switching as specified in the Cue 
Edit window. Make sure to arrange a rehearsal in advance.

• For inputs where you may activate the Side Flag function, set the video 
switcher so that the aspect ratio is 4:3. When you set the aspect ratio to 
16:9, you cannot add the Side Flags even if the the Side Flag function 
is set to On in the Cue Edit window.

❐When you select a Camera Icon for which the Shot Recall is 
set in step 4
A block for setting the Move for Shot Recall of Camera is displayed. If 
necessary, adjust the speed by setting the Move duration. 
To enable the Move function for Shot Recall with the TAKE operation, 
put a check mark in the Move check box. Then specify the desired 
duration for moving the current camera position to the next position for 
the next shot in the SS:FF format: 

Tips

Notes

Option Descriptions

SS 00 - 59

FF 00 - 29 or 00 - 24 depending on the system you are using.

5  Side Flag settings

Move for Shot Recall 
settings
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When you want to specify the start point for moving in advance, create a 
cue where the start point is specified before the cue with the Move setting.

Using a free M/E
When there is another M/E in addition to the OA and NEXT M/Es on your 
switcher, you can specify its output to a bus in step 2 in the procedure above, to 
create more intricate effects. One of those effects might be, for example, 
combining yet another image, such as text, with the video in a separate two-
panel (2 Box) window.

1 Right-click on the desired Video column on the first layer of the object list, 
and select [Free M/E] on the displayed menu.

The thumbnail of free M/E appears.

2 Double-click the thumbnail of free M/E on the object list.

The object list is replaced with the one for free M/Es. It is similar to the one 
for main M/Es, but it does not display setting items that affect the entire cue 
in the detailed settings area when the Effect column on the object list is 
selected.

3 Make the necessary settings for the free M/E.

Note

First layer of the object list
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4 Click [Exit] displayed above the object list.

The object list returns to the one for main M/Es. 

Setting Keys

1 Click the Key display block in the current cue. 

The Key Bus icon is being selected on the object list.

2 Click the desired category in the category list.

When a category is selected here, the Icons in the selected category are 
displayed in the Icon list.

3 Select the desired Video Icon in the Icon list.

4 Select the desired key on mode from the drop-down list box in the Key On 
mode block.

Object list for free M/Es

Option Descriptions

Auto Key is automatically inserted on a TAKE operation.  
Transition type and rate specified in the cue will be used, if any. The 
Cut transition will be used if no transition type is specified.

Manual Key is not inserted on a TAKE operation. 
The operator will use the buttons on the shot box module to insert/
delete key.

Key display block in the current cue

Object list
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5 Click the desired Key Bus display block in the second layer on the object 
list.

6 Click the desired category in the category list.

In the category list, the transition categories created in the Icon Manager are 
displayed. 
When a category is selected, the Icons in the selected category are displayed 
in the Icon List.

Depending on the class, some Transition Icons are not available for the key. 

For details, see “Transition Icons” on page 94.

7 Select the desired Transition Icon in the Icon List.

The selected Icon is displayed in the object list.

8 Select the desired transition rate from the drop-down list box in the 
Transition Rate block.

For details, see “Specifying the Transition Rate Options” on page 56.

Adjusting the keys
Set the key type (chrome key/luminance key) or adjust the key modifier with 
either of the following operations:
• Using the key memory of the video switcher
• Setting the type to the snapshot

Setting Audio
You can set an Audio Icon in a new cue or an existing cue being displayed as 
the current cue in the Cue Edit window. 

1 Click the audio channel display block in the current cue. 

The desired audio channel is being selected on the object list.

2 Click the desired category in the category list.

Note

Option Descriptions

1(SS:FF) Transition in the period set as “1” in the Initial Setup application.

2(SS:FF) Transition in the period set as “2” in the Initial Setup application.

3(SS:FF) Transition in the period set as “3” in the Initial Setup application.

4(SS:FF) Transition in the period set as “4” in the Initial Setup application.

Object list
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In the category list, the audio categories created in the Icon Manager are 
displayed.  
When a category is selected, the Icons or the files in the selected category 
are displayed in the Icon list or in the file list. 

3 Select the desired Audio Icon in the Icon list.

The selected Icon is displayed in both the object list and the current cue. The 
detailed settings is activated only when an Audio Icon or file is set for the 
selected audio number.

You cannot use the audio material of a DDR(VDCP) or DDR(SonyVTR) 
Icon separately, since DDR(VDCP) and DDR(SonyVTR) Icons are shared 
with a video. If you set the audio materials in an audio Icon, only XPT 
control of the audio mixer is available. To open a file, we recommend you 
set the audio materials in a video Icon.

4 If necessary, change the detailed settings.

Category type Descriptions

Audio Server Audio Server files registered in the file list with the Initial 
Setup are displayed. 

PO Server The PO Server icon for an as-yet-undetermined channel 
supplied by the system and the PO Server icon for each 
channel that was registered in the PO Server category are 
displayed. 
Tip
Select a PO Server icon for an as-yet-undetermined channel 
when the channel should be assigned on the NRCS. To 
specify the channel in the ELC-MVS01 system, select the 
PO Server icon for the corresponding channel.

Continuous The Continuous icons supplied by the system are displayed. 
For details, see “Continuous” on page 86.
Note
The Fade In/Fade Out and Level settings are not retained, 
so you should make those settings for the next cue.

Others The Icons registered in the selected category are displayed.

Note

Audio channel in the current cue

Object list

File list
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• Fade In: Specify the fade in time from the following options:  

• Fade Out: Specify the fade out time from the following options:  

• Level: Specify the desired audio level from the following options:  

           a) xx: The value specified in the Initial Setup window. 

• MIX−: Specify the desired port for Mix-minus. This option is effective 
only when a piece of material classified as Remote is selected.

 

Depending on the audio mixer you are using, there may be restrictions on 
using the AUX Bus.

Setting Transition
You can set a Transition Icon in a new cue or an existing cue being displayed as 
the current cue in the Cue Edit window. 

1 Click the Transition Icon display block in the current cue.

The desired Transition Icon display block is being selected on the object list.

2 Click the desired category in the category list.

In the category list, the transition categories created in the Icon Manager are 
displayed. 
When a category is selected, the Icons in the selected category are displayed 
in the Icon list. 

Option Descriptions

0(SS:FF) Fade in zero second.

1(SS:FF) Fade in the period set as “1” in the Initial Setup application.

2(SS:FF) Fade in the period set as “2” in the Initial Setup application.

3(SS:FF) Fade in the period set as “3” in the Initial Setup application.

4(SS:FF) Fade in the period set as “4” in the Initial Setup application.

Option Descriptions

0(SS:FF) Fade out in zero second.

1(SS:FF) Fade out in the period set as “1” in the Initial Setup application.

2(SS:FF) Fade out in the period set as “2” in the Initial Setup application.

3(SS:FF) Fade out in the period set as “3” in the Initial Setup a location.

4(SS:FF) Fade out in the period set as “4” in the Initial Setup application.

Option Descriptions

3 (xx dB)a) The level set as “3” in the Initial Setup application is selected.

2 (xx dB)a) The level set as “2” in the Initial Setup application is selected.

1 (xx dB)a) The level set as “1” in the Initial Setup application is selected.

0 (–∞ dB) The level is set at –∞ dB.

Manual The mixer level at that point is selected.

Option Descriptions

Off Mix-minus is not be performed. 

AUX 1 − 
AUX18

Specify the port from AUX 1 to AUX 18. When outputting from the 
selected port, PGM OUT excluding the selected audio will be output.

Note
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3 Select the desired Transition Icon in the Icon list.

The selected Icon is displayed in both the current cue and the object list.

4 If necessary, change the detailed settings.

• Transition Rate: Specify the transition rate from the following options: 

For details, see “Specifying the Transition Rate Options” on page 56.

• BKGD/ALL: Select the transition region from the following options: 

Setting Studio Monitor
You can set a Video Icon to be output to a studio monitor in a new cue or an 
existing cue in the Cue Edit window.

1 Click the Studio Monitor number in the current cue.

2 Select the desired studio monitor number on the object list.

To use a free M/E
When there is another M/E in addition to the OA and NEXT M/Es on your 
switcher, you can specify its output for a studio monitor by right-clicking on 
the desired studio monitor number on the first layer of the object list, and 
selecting [Free M/E] on the displayed menu.
The procedure is similar to the one for using a free M/E for a video bus. For 
details, see “Using a free M/E” on page 123.

3 Click the desired category in the category list.

In the category list, the video categories created in the Icon Manager are 
displayed. 

Option Descriptions

1(SS:FF) Transition in the period set as “1” in the Initial Setup application.

2(SS:FF) Transition in the period set as “2” in the Initial Setup application.

3(SS:FF) Transition in the period set as “3” in the Initial Setup application.

4(SS:FF) Transition in the period set as “4” in the Initial Setup application.

Option Descriptions

BKGD Among the images composing a cue, only the background image 
will transition. 

ALL The whole image comprising of a cue will transition. Usually, use 
this option.

Transition Icon display block in the current cue

Object list
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When a category is selected here, the Icons in the selected category are 
displayed in the Icon list.

4 Select the desired Icon in the Icon list.

The selected Icon is displayed in both the current cue and the object list.

5 If necessary, change the detailed output settings.

* Only the AUX buses enabled in the Initial Setup application are displayed in the Output drop-down 
list box. 
“xxx” is the name of the studio monitor specified in the Initial Setup application.

6 If necessary, make the transition settings. 

Category type Descriptions

Continuous The Continuous Icons supplied by the system are 
displayed. There are several Icons for continuously playing 
video on a different bus from the previous cue, too.
For details, see “Continuous” on page 86.

DDR(VDCP) DDR (VDCP) files registered in the file list with the Initial 
Setup are displayed. 

PO Server The PO Server icon for an as-yet-undetermined channel 
supplied by the system and the PO Server icon for each 
channel that was registered in the PO Server category are 
displayed. 
Tip
Select a PO Server icon for an as-yet-undetermined 
channel when the channel should be assigned on the 
NRCS. To specify the channel in the ELC-MVS01 system, 
select the PO Server icon for the corresponding channel.

Others The Icons registered in the selected category are 
displayed.

Option Descriptions

Off No signal is output.

xxx(AUX1 - 48)* The image of the specified Video Icon is output to a studio 
monitor via the selected AUX bus.

File list

Object list

Studio Monitor display block in the current cue
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The Cut effect will be used when no transition settings are made.

Click the transition display block in the second layer on the object list.

7 Click the desired category in the category list.

In the category list, the transition categories created in the Icon Manager are 
displayed.
When a category is selected, the Icons in the selected category are displayed 
in the Icon List.

Depending on the class, some Transition Icons are not available for the 
studio monitor. 

For details, see “Transition Icons” on page 94.

8 Select the desired Transition Icon in the Icon List.

The selected Icon is displayed in the object list.

9 Select the desired transition rate from the drop-down list box in the 
Transition Rate block.

For details, see “Specifying the Transition Rate Options” on page 56.

A Transition Icon can be specified for any of the Studio Monitors 1 - 5. 
The maximum number of Transition Icons specified for the studio monitors in 
a cue depends on the settings made in the System Setup application.

Tip

Note

Option Descriptions

1(SS:FF) Transition in the period set as “1” in the Initial Setup application.

2(SS:FF) Transition in the period set as “2” in the Initial Setup application.

3(SS:FF) Transition in the period set as “3” in the Initial Setup application.

4(SS:FF) Transition in the period set as “4” in the Initial Setup application.

Note

Object list
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Specifying the duration for a cue
You can specify the duration for a cue, if necessary.
The specified duration will be shown on the playlist.
When you make the duration “fixed,” the next cue will be taken automatically 
after the specified duration has elapsed. 

1 Click the Video Icon display block in the current cue.

2 Click the Effect column on the object list.

The Duration spin boxes and Fixed check box appear in the detailed settings 
block.

3 Specify the desired duration for the cue in the MM:SS format.

To ensure the next cue will be taken automatically after the specified 
duration, place a check mark in the Fixed check box.

During on-air operation, you can toggle the duration of the OA cue between 
fixed/unfixed by assigning this function to a button on the shot box module.

For details on this operation, see “Getting a Cue to Be Taken Automatically” 
on page 208.

Option Descriptions

MM 00 - 59

SS 00 - 59

Tip

Video Icon display block in the current cue

Duration spin box and 
Fixed check box
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Editing a Cue Registered in Quick Cue

This section explains how to edit a cue already registered on the Quick Cue 
window. 

1 Click the Quick Cue tab of the ELC Plug-in window.

The Quick Cue window is displayed.

2 From the cue folder list of the Quick Cue window, click the folder which 
contains the cue that you want to edit. 

The cues contained in the folder are displayed.

3 Right-click on the desired cue and select [Edit] from the menu displayed.

The Cue Edit window is displayed. The selected cue is loaded into the 
window as the current cue.

4 Make the required settings for the cue.

For details, see “Details of Settings” on page 119.

To delete Icons in the Cue Edit window
You can delete an Icon from the object list and the current cue row.

1 Right-click on the Icon that you want to delete, and select [Delete] from 
the menu displayed.
A confirmation dialog box is displayed.

2 Click [OK].
The Icon is deleted from the Cue Edit window. 

5 Click either of the following two buttons to execute the settings.

 Current cue
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• Save: Saves the settings, overwriting the existing Cue.

• Save as:  Opens the dialog box used to input a new name. 
Input a new name and click [OK] so that a new Cue is added to the end of 
the Cue list.

Renaming a Cue

This section explains how to rename a cue in the Quick Cue window. 

1 In the cue list block of the Quick Cue window, right-click the cue that you 
want to rename, and select [Rename] from the menu displayed.

The Rename dialog box is displayed.

2 Input the desired name of up to eight alphanumeric characters for a cue.

3 Click [OK].

The cue is renamed and the Rename dialog box is closed.

Deleting a Cue

This section explains how to delete a cue in the Quick Cue window. 

1 In the cue list block of the Quick Cue window, right-click the cue that you 
want to delete, and select [Delete] from the menu displayed.

A confirmation dialog box is displayed. 

2 Click [OK].

The cue is deleted.

Restoring a Deleted Cue

This section explains how to restore a cue accidentally deleted in the Quick Cue 
window by using a cue on a rundown.

 

You cannot restore multiple cues at one time.

In the case of iNEWS

1 From the cue folder list of the Quick Cue window, select the folder in which 
you want to put the restored cue. 

Note
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2 From the iNEWS Story Text Panel, drag the desired Production Cue 
(*ELC) and drop it in the desired position in the cue list of the Quick Cue 
window. 

The cue appears at the position where it was dropped.

In the case of ENPS

1 From the cue folder list of the Quick Cue window, select the folder in which 
you want to put the restored cue. 

2 From the ENPS Editing window, drag the desired ELC Item and drop it in 
the desired position in the cue list of the Quick Cue window. 

The item appears as a cue at the position where it was dropped.

Moving a Cue within a Folder

This section explains how to move a cue so that the position it is displayed at 
changes within a folder. 

1 In the cue list block of the Quick Cue window, drag the desired cue and drop 
it in the desired position in the cue list. 

The cue is moved to the position where it was dropped.

 

You cannot select multiple cues at one time.

Copying a Cue to Another Folder

This section explains how to copy a cue to another folder in the cue folders block 
of the Quick Cue window. 

1 In the cue list block of the Quick Cue window, right-click the cue that you 
want to copy, and select [Copy] from the menu displayed.

2 From the cue folder list of the Quick Cue window, click the folder to which 
you want to copy the cue. 

The cues contained in the folder are displayed.

3 Right-click on the blank space of the cue list block, and select [Paste] from 
the menu displayed.

The cue is copied at the end of the cue list.

Note
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Managing Cue Folders

This section explains how to create cue folders so that you can classify cues and 
select appropriate cues easily when creating a playlist.

 

You cannot select multiple cue folders at one time.

Creating a Cue Folder

This section explains how to create a cue folder in the cue folder list in the left 
block of the Quick Cue window.

1 Right-click on any cue folder or on blank space of the cue folder list block, 
and select [Create New Folder] from the menu displayed.

The Rename dialog box is displayed.

2 Input the desired name of up to 25 alphanumeric characters for a cue folder.

3 Click [OK].

A new cue folder is created at the end of the cue folder list.

Renaming a Cue Folder

This section explains how to rename a cue folder in the Quick Cue window. 

1 In the cue folder list block of the Quick Cue window, right-click the cue 
folder that you want to rename, and select [Rename] from the menu 
displayed.

The Rename dialog box is displayed.

2 Input the desired name of up to 25 alphanumeric characters for a cue folder.

3 Click [OK].

The cue folder is renamed and the Rename dialog box is closed.

Note
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Deleting a Cue Folder

This section explains how to delete a cue folder in the Quick Cue window. 

1 In the cue folder list block of the Quick Cue window, right-click the cue 
folder that you want to delete, and select [Delete] from the menu displayed.

A confirmation dialog box is displayed. 

2 Click [OK].

The cue folder is deleted. The cues contained in the cue folder are also 
deleted.

Moving a Cue Folder

This section explains how to move a cue folder so that the position it is displayed 
at changes in the cue folder list. 

1 In the cue folder list block of the Quick Cue window, drag the desired cue 
folder and drop it at the desired position in the cue folder list. 

The cue folder is moved to the position where it was dropped.
Managing Cue Folders
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Preparing for Switching Multiple Snapshots Manually 
(2Box) 

This section explains how to prepare for an advanced on-air manual operation, 
switching multiple snapshots manually (2Box). This operation is useful to show 
images in a studio and at another location in two-split screens, or show both 
images in full screen.
As in the example below, each or both of the images in two boxes can be 
recalled in full screen made alternately. To perform this operation, you must use 
three snapshots, each allocated to a button on the shot box module. By using the 
buttons on the shot box module, you can switch multiple snapshots during on-
air operations.
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Required Settings in the Icon Manager Application

This section explains how to create an Icon classified with SPE and set snapshot 
in the Snapshot Settings block.   

1 In the Icon Manager window, create an Effect Icon and select [SPE] from 
the Class drop-down list box.

For details, see “Effect Icons” on page 97.

2 Set the number of snapshot groups in the Snapshot Settings block.

Specify the combination number of snapshots to be recalled by pressing the 
associated buttons on the shot box module. 
In the case of 2Box, specify [3] in the Number of Snapshot Groups drop-
down list box.

3 Specify the Standby Group# in the Snapshot Settings block.

Specify which snapshot will be loaded for standby, and recalled first when 
the relevant cue is taken on the air. 

4 Specify the desired group in the Group Item drop-down list box.

For group selection, see “Required Settings in the Initial Setup 
Application” on page 140. 

5 Check the items (the M/E and DME channels) you use for snapshots for the 
group you select in step 4, and specify a snapshot number in the drop-down 
list box for each.
Preparing for Switching Multiple Snapshots Manually (2Box)
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6 Click the Group Name text box to put it in the input mode, and enter a group 
name of up to eight alphanumeric characters.

The name input here may appear on a button on the shot box module. 

• Although you can enter both upper and lower case letters here, the names 
will be shown in capital letters on the shot box module.

• Input a “ | ” symbol, so that a line break is inserted on the shot box module.

7 Repeat steps from 4 to 6 for another group, if necessary.
In the case of 2Box, repeat the steps for two other groups.

8 When you check DME CH 1 to 4 in step 5, specify the total number of DME 
channels to be used with the Number of DME CH drop-down list box.

If you checked DME CH 1 for the first group, DME CH 3 for the second 
group, and DME CH 4 for the third group, for example, specify [3].

Specify the appropriate number when you use DME. The system will 
display insufficient-DME-resource warning messages in a playlist based on 
this setting.

For saving, see “Effect Icon Window” on page 35.

Notes

Note
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Required Settings in the Initial Setup Application

To switch multiple snapshots manually, you will use the shot box module and 
assign snapshots to its buttons. This section explains how to assign the 
snapshots to the shot box module buttons. 

1 In the Initial Setup window, click the Shot Box Module Assign sub menu.

The Shot Box Module Assign window is displayed.

2 Select the number of the table to which you want to assign the functions.

3 Select the tab corresponding to the bank to which you want to assign the 
functions.

The functions assigned to the buttons of the selected bank of the selected 
table are displayed in the Assign List.

4 Select the number corresponding to the button to be assigned to the function 
on the Assign List.

Or, if you are going to assign more than one function simultaneously, select 
the lowest numbered button to which you want to assign the functions. In 
this case, the functions will be assigned to the buttons of the selected and the 
subsequent numbers.

5 Select [Snapshot Group] in the Function Group drop-down list box.

6 On the Function List, select Snapshot Group 1 through 4.

You can select more than one function by using the Ctrl or Shift key.

Button layout
Preparing for Switching Multiple Snapshots Manually (2Box)
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7 Click [CADD].

The selected function(s) are assigned to the button(s), and displayed on the 
Assign List.
In the Name column, the default name is displayed. You cannot edit the 
name. On the buttons on the shot box module, group names specified in the 
Effect Icon are displayed. 

For details, see “Required Settings in the Icon Manager Application” on 
page 138.

8 Check the table number(s) assigned to the shot box module(s), and if 
necessary, select the table number to which you have just assigned the 
functions, using the Module1 and/or Module2 drop-down list box(es).

9 Click [Save] to save the modified settings.

Function Description

Snapshot Group 
1 - 4

Recall the snapshot specified for Snapshot Group 1 to 4. 
This option is set when you create an Effect Icon by 
pressing the shot box module buttons and recalling the 
combination of associated snapshots. 
For details, see “Required Settings in the Icon Manager 
Application” on page 138.
141Preparing for Switching Multiple Snapshots Manually (2Box)
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Required Settings in the ELC Plug-in Application

For example, to select source images for a video effect using two Keys, use the 
following procedure. 

1 In the Cue Edit window, click the Key 1 display block on the current cue.

The selected Key Icon is highlighted both in the current cue and the object 
list. 

2 Click the desired category in the category list.

In the category list, the video categories created in the Icon Manager are 
displayed. 
When a category is selected, the Icons in the selected category are displayed 
in the Icon list. 

3 Select the Icon you created for switching multiple snapshots manually in the 
Icon list according to the purposes.

The video materials to be used will be identical for all the snapshots.

4 On the object list, click the Key 2 icon.

5 Repeat steps 2 and 3 to select the video source for the Key 2.

For saving, see “Cue Edit Tab” on page 41.

Note

Key1 display block on the  current cue
Preparing for Switching Multiple Snapshots Manually (2Box)
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Preparing for Manual Switching

This section explains how to prepare for an advanced on-air manual operation, 
manual switching. This function allows you to switch only a part of the images 
within a cue by using the buttons on the shot box module, each associated with 
a Video Icon. You can use up to six Video Icons and assign them to buttons of 
the shot box module.
As an example, shown below, you can switch images in the background inset 
screen only from one location or camera to another (PinP). 

Before performing the operations, follow the procedures below to make the 
required settings.

Required Settings in the Icon Manager Application

This section explains how to create an Effect Icon for manual switching.  

1 In the Icon Manager window, create an Effect Icon and select [SPE] from 
the Class drop-down list box.

You can create an Icon classified as SPE.

For details, see “Effect Icons” on page 97.

2 Specify the number of snapshots to be required with the Number of 
Snapshot Groups drop-down list box.
143Preparing for Manual Switching
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3 Specify the Standby Group# in the Snapshot Settings block.

Specify which snapshot will be loaded for standby, and recalled first when 
the relevant cue is taken on the air. 

4 Specify the desired group in the Group Item drop-down list box.

For group selection, see “Required Settings in the Initial Setup 
Application” on page 146. 

5 Check the items (the M/E and DME channels) you use for snapshots for the 
group you specify in step 4, and specify a snapshot number in the drop-
down list box for each. 

6 Click the Group Name text box to put it in the input mode, and enter a group 
name of up to eight alphanumeric characters.

The name input here may appear on a button on the shot box module. 

• Although you can enter both upper and lower case letters here, the names 
will be shown in upper letters on the shot box module.

• Input a “ | ” symbol, so that a line break is inserted on the shot box module.

7 Repeat steps from 4 to 6 for another group, if necessary.

8 When you check DME CH1 to 4 in step 5, specify the total number of DME 
channels to be used with the Number of DME CH drop-down list box.

Notes
Preparing for Manual Switching
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If you checked DME CH 1 for the first group, DME CH 3 for the second 
group, and DME CH 4 for the third group, for example, specify [3].

Specify the appropriate number when you use DME. The system will 
display insufficient-DME-resource warning messages in a playlist based on 
this setting.

9 Select [On] in the Manual Switching block.

The Manual Switching is set effective. You can switch up to six images by 
pressing the buttons on the Shot Box Module associated with Video Icons.

10Select the desired Bus from the Bus drop-down list box.

For saving, see “Effect Icon Window” on page 35.

Note
145Preparing for Manual Switching
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Required Settings in the Initial Setup Application

This section explains how to assign materials to be used in manual switching to 
the shot box module buttons. 

1 In the Initial Setup window, click the Shot Box Module Assign sub menu.

The Shot Box Module Assign window is displayed.

2 Select the number of the table to which you want to assign the functions.

3 Select the tab corresponding to the bank to which you want to assign the 
functions.

The functions assigned to the buttons of the selected bank of the selected 
table are displayed in the Assign List.

4 Select the number corresponding to the button to be assigned to the function 
on the Assign List.
Or, if you are going to assign more than one function simultaneously, select 
the lowest numbered button to which you want to assign the functions. In 
this case, the functions will be assigned to the buttons of the selected and the 
subsequent numbers.

5 Select [Manual Switching] in the Function Group drop-down list box.

6 Select Manual Switching 1 - 6 to be assigned on the Function List. 

Button layout
Preparing for Manual Switching
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You can select more than one function by using the Ctrl or Shift key.

7 Click [CADD].

The selected function(s) are assigned to the button(s), and displayed on the 
Assign List.
In the Name column, no name is displayed. You cannot edit names.

8 Check the table number(s) assigned to the shot box module(s), and if 
necessary, select the table number to which you have just assigned the 
functions, using the Module1 and/or Module2 drop-down list box(es).

9 Click [Save] to save the modified settings.

Function Description

Manual 
Switching 1 - 6

Switches to the video signal of the 1 to 6 Video Icon listed 
for manual switching. 
For details, see “Required Settings in the ELC Plug-in 
Application” on page 148.
147Preparing for Manual Switching
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Required Settings in the ELC Plug-in Application

This section explains how to specify up to six pieces of materials to be used in 
manual switching. 

1 In the Cue Edit window of the ELC Plug-in application, click the Video Icon 
display block of the current cue.

If the Manual Switching has been set, the list of the subjects to be switched 
will be displayed in the second layer of the object list.

2 Select the subjects to be switched. 

Set the material to be used first in the on-air operation as the first of the 
subjects to be changed in manual switching.

3 Click the desired category in the category list.

4 Select an Video Icon in the Icon list.

The names of the Video Icons you select are displayed on the buttons of the 
shot box module.

5 Repeat steps 2 to 4 to specify multiple materials to be switched.

For saving, see “Cue Edit Tab” on page 41.

Video icon display block on the current cue
Preparing for Manual Switching
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To change the piece of material to be used first in the on-air operation
Click the Manual Switching display block in the first layer of the object list, then 
select the desired piece of material to be used first (source number) from the 
drop-down list box in the Standby block.
There are “Source 1” to “Source 6” options. The Icons specified for the 
respective source options, if any, are displayed in parentheses at the end.

To specify Audio to be switched together with Video switching
Click the Video Icon to be linked in the second layer of the object list, then select 
the desired audio number from the drop-down list box in the Audio Link block.
There are “Off” and “Audio 1” to “Audio 8” options. The Icons specified for the 
respective audio number, if any, are displayed in parentheses at the end.

Object list Standby block

Object list Audio Link block
149Preparing for Manual Switching
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Assigning a Video Switcher Macro to a Cue

You can register various settings in a video switcher macro and then assign the 
created macro to a cue. With the TAKE operation, the macro is recalled and 
executed. This section explains how to assign a macro to a cue.

1 In the Cue Edit window of the ELC Plug-in application, click the Video Icon 
display block of the current cue.

2 Click the Effect Icon on the object list.

3 Using the Macro Recall check box of the detailed settings block, specify 
whether the macro is to be recalled.

Check box Description

Not checked Macro will not be recalled.

Checked Macro will be recalled.
Specify the Macro number you want to recall from 1 to 250 
using the Macro No. drop-down list box. This drop-down list 
box will be enabled when the Macro Recall check box is 
checked.

Video icon display block on the current cue
Assigning a Video Switcher Macro to a Cue
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Preparing for GPI Trigger Pulse Output

GPI trigger pulses are used to control a device outside of the ELC-MVS01 
system. 
There are two types of GPI pulse output:

• Automatic output
The system automatically outputs GPI pulses from up to four ports with a 
TAKE operation. Specify the GPI pulse(s) to be output in a cue to use this 
function.

• Manual output
During on-air operation, the operator can output GPI pulses anytime he/she 
wishes using the shot box module. Assign the ports from which GPI pulses 
should be output to buttons of the shot box module in advance, using the 
Initial Setup application.

The System Setup application is used for setup related to the GPI pulse output 
ports, such as names of the ports and specifications of the output pulses.

For automatic output
While creating a cue, select up to four ports from which GPI pulses should be 
output upon a TAKE operation for the cue.

1 In the Cue Edit window of the ELC Plug-in application, click the Video Icon 
display block in the current cue.

2 Click the Effect column on the object list.

The GPI Out drop-down list boxes appear in the detailed settings block.

3 Make the settings required to output GPI trigger pulses.
Select the ports from which GPI trigger pulses should be output using the 
four GPI Out drop-down list boxes.

Note

Video Icon display block in the current cue

GPI Out drop-down list 
boxes
151Preparing for GPI Trigger Pulse Output
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For manual output
Assign the ports (“GPIn (xxx),” where n is a GPI port number and “xxx” is the 
GPI port name, both specified in the System Setup application.) from which GPI 
pulses should be output to buttons of the shot box module using the Initial Setup 
application.

1 On the Initial Setup Main Menu, click the Shot Box Module Assign sub 
menu.

The Shot Box Module Assign window is displayed.

2 Select the number of the table to which you want to assign the GPI output 
function.

3 Select the tab corresponding to the bank to which you want to assign the GPI 
output function.

The functions that have already been assigned to the buttons of the selected 
bank are displayed in the Assign List.

Name of the port from which the 
GPI trigger pulse will be output.

Button layout
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4 Select the number corresponding to the button to be assigned to the function 
on the Assign List.
Or, if you are going to assign more than one function, select the lowest 
numbered button to which you want to assign the functions. In this case, the 
functions will be assigned to the buttons of the selected and the subsequent 
numbers.

5 Select [GPI OUT] in the Function Group drop-down list box to narrow 
down the functions displayed.

6 Select the “GPIn (xxx)” function(s) to be assigned on the Function List, 
where n is a GPI port number and “xxx” is the GPI port name, both specified 
in the System Setup application.
You can select more than one function by using the Ctrl or Shift key.

7 Click [CADD].

The selected function(s) are assigned to the button(s), and displayed on the 
Assign List.

8 Repeat steps 3 to 7, if necessary.

9 Check the table number(s) assigned to the shot box module(s), and if 
necessary, select the table number to which you have just assigned the 
functions, using the Module1 and/or Module2 drop-down list box(es).

10Click [Save] to save the modified settings.

See “Outputting GPI Trigger Pulses” on page 226 for details on the operation 
of GPI pulse output.
153Preparing for GPI Trigger Pulse Output
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Assigning Individual Cues to Shot Box Module 
Buttons

The ELC-MVS01 software enables you to use up to 24 individual cues assigned 
to 24 buttons of the shot box module for on-air operation. The 24 cues can be 
assigned as the NEXT cue regardless of the playlist by pressing the 
corresponding buttons of the shot box module, so that the selected cue will be 
put on the air by the next TAKE operation.

Required Settings in the ELC Plug-in Application

To prepare cues to be assigned to shot box module buttons, proceed as follows:

1 In the ELC Plug-in window, right-click on any cue folder or on blank space 
of the cue folder list block, and select [Create New Folder] from the menu 
displayed.

The Rename dialog box is displayed.

2 Input the desired name for the cue folder.

3 Click [OK].

A new cue folder is created on the cue folder list.

4 Right-click on the newly created cue folder, and select [Shot Box 
Candidate].

A check mark appears at the left of the command, showing the cue folder is 
now selected as a candidate for this operation. You can select the desired 
cue folder from the candidates upon on-air operation.  

5 Create the desired cue(s) in the newly created cue folder in the ELC Plug-in 
window.

See “Creating a Cue” on page 118 for details.
Assigning Individual Cues to Shot Box Module Buttons
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Icons for which the file to be used or the channel should be specified by the 
NRCS, such as CG or PO Server (an as-yet-undetermined channel) Icons, 
cannot be used.

6 If necessary, change the order of the cues in the folder.

More than 24 cues can be created in the folder, however, only the top 24 
cues can be assigned to buttons of the shot box module, you may have to 
change the order of the cues in the folder.
To move a cue, drag the desired cue in the cue list block and drop it in the 
desired position. 

Note
155Assigning Individual Cues to Shot Box Module Buttons
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Required Settings in the Initial Setup Application

Assign the cues (Cue 1 - 24) to buttons of the shot box module using the Initial 
Setup application.

1 On the Initial Setup Main Menu, click the Shot Box Module Assign sub 
menu.

The Shot Box Module Assign window is displayed.

2 Select the number of the table to which you want to assign cues.

3 Select the tab corresponding to the bank to which you want to assign cues.

The functions that have already been assigned to the buttons of the selected 
bank are displayed in the Assign List.

4 Select the number corresponding to the button to be assigned to the cue on 
the Assign List.
Or, if you are going to assign more than one cue, select the lowest numbered 
button to which you want to assign the cues. In this case, the cues will be 
assigned to the buttons of the selected and the subsequent numbers.

5 Select [Cue] in the Function Group drop-down list box to narrow down the 
functions displayed.

6 Select the cue(s) (Cue 1 - 24) to be assigned on the Function List.
You can select more than one cue by using the Ctrl or Shift key.

7 Click [CADD].

Button layout
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The selected cue(s) are assigned to the button(s), and displayed on the 
Assign List.

8 Repeat steps 3 to 7, if necessary.

9 Check the table number(s) assigned to the shot box module(s), and if 
necessary, select the table number to which you have just assigned the 
functions, using the Module1 and/or Module2 drop-down list box(es).

10Click [Save] to save the modified settings.
157Assigning Individual Cues to Shot Box Module Buttons
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Preparing for Switching a Video Device to Its Backup

During on-air operations, you can switch a video device, such as a 
DDR(VDCP), to a backup specified in advance by pressing a button on the shot 
box module. 

Required Settings for Backup Devices in the Initial Setup Application

Assign backup devices for the desired video devices using the Initial Setup 
application.

For details on this operation, see “Making the Video Switcher Settings” on 
page 53.

1 On the Initial Setup Main Menu, click the Video Switcher Settings sub 
menu.

The Video Switcher Settings window is displayed.

2 Narrow down the device list, if necessary, by selecting the desired class 
using the Class drop-down list box. 

3 Select the desired V/K pair number on the list, and select the device to be 
associated with the selected V/K pair number, using the Device(V) drop-
down list box.

4 Select the desired backup video device, using the Backup Device(V) drop-
down list box.
Preparing for Switching a Video Device to Its Backup
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The signal from the selected device will be used when the operator switches 
to the backup during on-air operation.

The ELC-MVS01 software does not control the backup device in place of 
the original device, though.

5 Repeat steps 2 to 4 for all the necessary V/K pair numbers.

6 Click [Save] to save the modified settings.

Note
159Preparing for Switching a Video Device to Its Backup
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Required Settings for the Shot Box Module in the Initial Setup Application

Assign the function for swiching a video device to its backup to a button of the 
shot box module using the Initial Setup application.

1 On the Initial Setup Main Menu, click the Shot Box Module Assign sub 
menu.

The Shot Box Module Assign window is displayed.

2 Select the number of the table to which you want to assign the switching 
functions.

3 Select the tab corresponding to the bank to which you want to assign the 
switching functions.

The functions that have already been assigned to the buttons of the selected 
bank are displayed in the Assign List.

4 Select the number corresponding to the button to be assigned to the function 
on the Assign List.
Or, if you are going to assign more than one function, select the lowest 
numbered button to which you want to assign the functions. In this case, the 
functions will be assigned to the buttons of the selected and the subsequent 
numbers.

5 Select [Backup Video] in the Function Group drop-down list box to narrow 
down the functions displayed.

6 Select the backup video device switching function(s) (“xxx Backup Video” 
where xxx is the name of the video device for which a backup device is 

Button layout
Preparing for Switching a Video Device to Its Backup



  C
hapter 6  P

reparing for A
dvanced or O

ccasional M
anual O

perations
specified) to be assigned on the Function List.
You can select more than one function by using the Ctrl or Shift key.

7 Click [CADD].

The selected function(s) are assigned to the button(s), and displayed on the 
Assign List.

8 Repeat steps 3 to 7, if necessary.

9 Check the table number(s) assigned to the shot box module(s), and if 
necessary, select the table number to which you have just assigned the 
functions, using the Module1 and/or Module2 drop-down list box(es).

10Click [Save] to save the modified settings.

See “Switching a Video Device to Its Backup” on page 232 for details on 
switching a video device to its backup.
161Preparing for Switching a Video Device to Its Backup
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Preparing for Switching an Audio Device to Its Backup

During on-air operations, you can switch an audio device, such as a microphone, 
to a backup specified in advance by pressing a button on the shot box module. 

Required Settings for Backup Devices in the Initial Setup Application

Assign backup devices for the desired audio devices using the Initial Setup 
application.

For details on this operation, see “Making the Audio Mixer Settings” on page 
57.

1 On the Initial Setup Main Menu, click the Audio Mixer Settings sub menu.

The Audio Mixer Settings window is displayed.

2 Select the Fader No. Setup tab, if it is not displayed on top.

3 Narrow down the device list, if necessary, by selecting the desired class 
using the Class drop-down list box. 

4 Select [Enable] in the Control drop-down list box for the desired fader 
number, and associate the desired Audio Icon with the fader number, using 
the Device drop-down list box.
Preparing for Switching an Audio Device to Its Backup
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5 Select the desired backup audio device for the selected fader number, using 
the Backup Device drop-down list box.

The signal from the selected device will be used when the operator switches 
to the backup during on-air operation.

The ELC-MVS01 software does not control the backup device in place of 
the original device, though.

6 Repeat steps 3 to 5 for all the necessary fader numbers.

7 Click [Save] to save the modified settings.

Note
163Preparing for Switching an Audio Device to Its Backup
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Required Settings for the Shot Box Module in the Initial Setup Application

Assign the function for swiching an audio device to its backup to a button of the 
shot box module using the Initial Setup application.

1 On the Initial Setup Main Menu, click the Shot Box Module Assign sub 
menu.

The Shot Box Module Assign window is displayed.

2 Select the number of the table to which you want to assign the switching 
functions.

3 Select the tab corresponding to the bank to which you want to assign the 
switching functions.

The functions that have already been assigned to the buttons of the selected 
bank are displayed in the Assign List.

4 Select the number corresponding to the button to be assigned to the function 
on the Assign List.
Or, if you are going to assign more than one function, select the lowest 
numbered button to which you want to assign the functions. In this case, the 
functions will be assigned to the buttons of the selected and the subsequent 
numbers.

5 Select [Backup Audio] in the Function Group drop-down list box to narrow 
down the functions displayed.

6 Select the backup audio device switching function(s) (“xxx Backup Audio” 
where xxx is the name of the audio device for which a backup device is 

Button layout
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specified) to be assigned on the Function List.
You can select more than one function by using the Ctrl or Shift key.

7 Click [CADD].

The selected function(s) are assigned to the button(s), and displayed on the 
Assign List.

8 Repeat steps 3 to 7, if necessary.

9 Check the table number(s) assigned to the shot box module(s), and if 
necessary, select the table number to which you have just assigned the 
functions, using the Module1 and/or Module2 drop-down list box(es).

10Click [Save] to save the modified settings.

See “Switching an Audio Device to Its Backup” on page 233 for details on 
switching an audio device to its backup.
165Preparing for Switching an Audio Device to Its Backup
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This section explains how to create a playlist using the cues. It also 
explains a series of procedures to play out the created playlist with 
the OA Playlist application. 
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how to switch video manually (Manual Switching).
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Starting the ELC Plug-in Application

The ELC Plug-in application, working as a plug-in application for the existing 
iNEWS client software, allows you to create a playlist by using the cues created 
in the ELC Plug-in’s Quick Cue and Cue Edit windows. 

- Editing a production cue registered in iNEWS
- Editing part of a cue in Quick Cue and setting it to iNEWS as a new 

production cue

1 Start the iNEWS client software.

2 Click [Tools ] > [Plug-in] > [ELC Plug-in] from the menu bar. 

The ELC Plug-in application starts and ELC Plug-in window is displayed.

 

You can start as many ELC Plug-in applications simultaneously on different 
computers as the number of licenses you have.

Tip

ELC Plug-in window
167Starting the ELC Plug-in Application
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Exiting the ELC Plug-in application

1 Click  on the upper right of the ELC Plug-in window.

The ELC Plug-in application is closed.

 

If you do not save the settings, the revisions do not take effect.

Note
Starting the ELC Plug-in Application
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Creating a Playlist

This section explains how to create a playlist using the ELC Plug-in application. 
The created playlist will be displayed in the Playlist Viewer application. 

Creating a Playlist

This section explains how to create playlists using cues. Before starting creation 
of a playlist, prepare the cues in the Quick Cue and Cue Edit windows of the 
ELC Plug-in application.

For details on creating cues, see “Creating a Cue” on page 118. 
For details on setting a cue, see “Details of Settings” on page 119.

1 Click the Quick Cue tab of the ELC Plug-in window.

The Quick Cue window is displayed.

2 In the queue panel in the iNEWS client window, click the desired iNEWS 
story to which you want to add a cue from the ELC Plug-in application.

The selected story is displayed in the story panel of the iNEWS client 
window.

iNEWS story panel

Story form 
panel

Instruction 
panel

Story text panelCue is added as a new *ELC production cue. 
169Creating a Playlist
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3 From the cue folder list of the Quick Cue window, click the folder 
containing the cue that you want to add to a playlist. 

The cues contained in the folder are displayed.

4 Drag the desired cue from the Quick Cue window and drop it on the iNEWS 
story text panel.

An asterisk “*” appears at the position where the cue was dropped on the 
story text panel, and the new cue is described as an ELC production cue. In 
the instruction panel, “*ELC” followed by the cue name is also added.  A 
cue is always added as an “ELC production cue.”

5 Repeat steps 2 through 4 to add cues to the rundown.

To set a new production cue after checking the content of a cue
You can check the content of a cue and edit it, if necessary, before you actually 
add it to an iNEWS story as a new ELC production cue. 

1 In the queue panel on the iNEWS client window, click the desired iNEWS 
story to which you want to add a cue from the ELC Plug-in application.

The selected story is displayed in the story panel of the iNEWS client 
window.

2 Double-click on the desired cue in the cue list block of Quick Cue.

The Cue Edit window is displayed. The selected cue is loaded into the 
window as the current cue. The registration icon appears on the current cue.

3 Check the content and change the settings, if necessary.

For details, see “Details of Settings” on page 119.

4 Drag the registration icon from the Cue Edit window and drop it on the 
iNEWS story text panel.

An asterisk “*” appears at the position where the cue was dropped on the 
story text panel and the new cue is described as an ELC production cue. In 
the instruction panel, “*ELC” followed by the cue name is also added.  A 
cue is always added as an “ELC production cue.”

4 Registration icon
Creating a Playlist



  C
hapter 7  C

reating a P
laylist for iN

E
W

S
 (E

LC
 P

lug-in/P
laylist V

iew
er)
 

To display added cues in the Playlist Viewer and OA Playlist applications, you 
should save the story in the iNEWS window. When the focus moves over stories 
in the queue panel, stories are saved automatically. Otherwise, save the story by 
selecting [File] > [Save Story] from the iNEWS menu bar.

Rules in setting ELC production cues
• The ELC production cues to be included in the same ELC story on a playlist 

should have the same Page number. An ELC story consists of ELC production 
cues having the same Page number. 

• An ELC production cue should be placed before the production cue of the 
materials that the ELC cue uses.

• You can set multiple ELC production cues in an iNEWS story.

When using the PO Server Icon for an as-yet-undetermined 
channel
To display the status of the playout server in a cue, you should make settings in 
the story form panel of the iNEWS client window. A story form panel is 
designed for one iNEWS story only. When you use multiple PO Servers in an 
ELC story, therefore, you should use multiple iNEWS stories to make settings 
for the PO Servers. According to the order where the PO Servers are set in the 
iNEWS story, you can associate the materials of the PO Servers with the object 
list for a video and audio channel on the ELC Plug-in application windows.

When a PO Server Icon for a specific channel is used, this system is not 
applicable.

❐  Example 1) When using PO Servers in both Key 1 and Key 2 of a cue

To create the playlist shown above, create a cue, drag and drop a Production 
cue, and then make settings in the iNEWS stories as follows:

1 For the iNEWS story where an ELC Production cue has been pasted, 
make settings for the PO Server Key 1 uses.

Note

Note

iNEWS story

ELC Production cue is pasted. Make settings in the Story Form Panel
171Creating a Playlist
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2 Insert a new iNEWS story, make settings for the PO Server Key 2 uses.

Make sure not to set an ELC production cue for this inserted iNEWS 
story.

The PO Server set in the first iNEWS story is used with the Key 1 bus, 
and that set in the next iNEWS story is used with the Key 2 bus.

❐ Example 2) When setting multiple ELC Production cues and PO 
Servers of an ELC story

To create the playlist shown above, create three cues as follows:
• *ELC1: A cue having no PO Server settings.
• *ELC2: A cue having PO Server settings with both Key 1 and Key 2.
• *ELC3: A cue having PO Server settings with Audio. 

Then set the above three cues for an identical iNEWS story as follows:

1 For the iNEWS story where the three ELC Production cues are set, 
make settings for the PO Server to be used first (the source for Key 1 
of *ELC2).

Inserted iNEWS story

Make settings in the Story Form Panel

*ELC1

*ELC2        *ELC3
Creating a Playlist
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2 Insert a new iNEWS story, make settings for the PO Server to be used 
second (the source for Key 2 of *ELC2). 

Make sure not to set an ELC production cue for this inserted iNEWS 
story.

3 Insert another iNEWS story, make settings for the PO Server to be used 
third (the source for the Audio of the *ELC3).

Make sure not to set an ELC production cue for this inserted iNEWS 
story.

iNEWS story

Three ELC Production cues are set. Make settings in the Story Form Panel

Inserted iNEWS story

Make settings in the Story Form Panel
173Creating a Playlist
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The ELC Plug-in application uses the ELC Production cues and PO 
Server settings in the order they are assigned in the iNEWS story, and 
associates a video bus or audio channel with the materials of the PO 
Server.

Editing an ELC Production Cue added to an iNEWS rundown

You can use Cue Edit to edit a cue that has been added to an iNEWS rundown 
and has been described as an ELC production cue.

1 In the iNEWS instruction panel, double-click on the ELC production cue 
that you want to edit.

The selected cue is displayed as the current cue in the Cue Edit window.

Inserted iNEWS story

Make settings in the Story Form Panel

ELC production cue

Instruction 
panel
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2 Make the required settings for the cue.

For details, see “Details of Settings” on page 119.

3 Click either of the following two buttons to execute the settings.

• Apply: The revisions take effect.

• OK:  The revisions take effect and the ELC Plug-in window is closed.
 

• To reflect revisions in the Playlist Viewer and OA Playlist applications, you 
should save the story in the iNEWS window. When the focus moves over 
stories in the queue panel, those stories are saved automatically. Otherwise, 
save the story by selecting [File] > [Save Story] from the iNEWS menu bar.

• If an error occurs in saving a story, the ELC Plug-in window will not be 
closed.

Notes

 Current cue
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Displaying a Playlist in the Playlist Viewer Application

The Playlist Viewer application allows you to view and check a playlist created 
with the Quick Cue and Cue Edit windows of the ELC Plug-in application. You 
can operate the application independently at different locations simultaneously 
without starting the iNEWS client.

1 Double-click the Playlist Viewer icon (Playlist Viewer) on the Windows 
desktop.
Or, double-click the PlaylistViewer.exe file in the 
“Sony\ELC\PlaylistViewer” folder on the drive where the ELC-MVS01 
software is installed.

The Playlist Viewer starts and the Playlist Viewer window is displayed.

2 Select [File] > [Open] from the menu bar of the Playlist Viewer application.

The Open dialog box used for selecting a rundown is displayed. 

3 Select the “NRCS Rundown” folder on the Folder list.

Rundowns that the iNEWS loads for monitoring are listed in alphabetical 
order on the Playlist list.

4 Select the desired rundown, and click [OK].

The playlist corresponding to the selected rundown is loaded in the Playlist 
Viewer window.
Displaying a Playlist in the Playlist Viewer Application
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You can check the playlist content created in the ELC Plug-in applications. 
In the playlist, the ELC stories are listed. The ELC story consists of the cues 
having the same page number provided by the iNEWS client.  

Note on scrolling of the playlist while on the air
The Playlist Viewer application scrolls the playlist automatically so that the cue 
currently being taken is displayed as the second cue on the screen.
You can view any other part of the playlist at any time, by manually scrolling 
the playlist using the scroll bar and mouse wheel.
Click [Current] in the Playlist Viewer window or press the F12 key to reactivate 
automatic playlist scrolling.

 

You cannot start more than the licensed number of copies of Playlist Viewer 
simultaneously.

Exiting the Playlist Viewer application

1 Click [File] > [Exit] from the menu bar of the Playlist Viewer.

The Playlist Viewer application is closed.

Note

Page number Current ELC story

Current button
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Creating a Playlist for ENPS 
(ELC Plug-in/Playlist Viewer)
Starting the ELC Plug-in Application

The ELC Plug-in application, working as a plug-in for the existing ENPS client 
software, allows you to create a playlist by using the cues created in the ELC 
Plug-in’s Quick Cue and Cue Edit windows. 

- Editing an item registered in ENPS
- Editing part of a cue in Quick Cue and setting it to ENPS as a new item

1 Start the ENPS client software.

2 Click the rover (green dot) of the Media Control icon on the bottom bar of 
the ENPS client window, and select [ELC Plug-in] from the displayed 
menu. 

The ELC Plug-in application starts and ELC Plug-in window is displayed.

ELC Plug-in window

Media Control icon
Starting the ELC Plug-in Application
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You can start as many ELC Plug-in applications simultaneously on different 
computers as the number of licenses you have.

Exiting the ELC Plug-in application

1 Click  on the upper right of the ELC Plug-in window.

The ELC Plug-in application is closed.

 

If you do not save the settings, the revisions do not take effect.

Tip

Note
179Starting the ELC Plug-in Application
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Creating a Playlist

This section explains how to create a playlist using the ELC Plug-in application. 
The created playlist will be displayed in the Playlist Viewer application. 

Creating a Playlist

This section explains how to create playlists using cues. Before starting creation 
of a playlist, prepare the cues in the Quick Cue and Cue Edit windows of the 
ELC Plug-in application.

For details on creating cues, see “Creating a Cue” on page 118. 
For details on setting a cue, see “Details of Settings” on page 119.

1 Click the Quick Cue tab of the ELC Plug-in window.

The Quick Cue window is displayed.

2 In the rundown in the ENPS client window, double-click the desired ENPS 
story to which you want to add a cue from the ELC Plug-in application.

The script of the selected story is displayed in the editing window of the 
ENPS client window.

Editing 
window 
(script)

Rundown
Creating a Playlist
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Depending on the column you select, the script may not be displayed in the 
editing window. Make sure to display the script. 

3 From the cue folder list of the Quick Cue window, click the folder 
containing the cue that you want to add to a playlist. 

The cues contained in the folder are displayed.

4 Drag the desired cue from the Quick Cue window and drop it on the ENPS 
editing window.

The script of the ELC item is added in the editing window. In the MOS Obj 
Slug column of the rundown, “ELC” followed by the cue name is displayed 
as the item name.

5 Repeat steps 2 through 4 to add cues to the rundown.

To set a new item after checking the content of a cue

You can check the content of a cue and edit it, if necessary, before you actually 
add it to an ENPS story as a new ELC item. 

1 In the rundown on the ENPS client window, double-click the desired ENPS 
story to which you want to add a cue from the ELC Plug-in application.

The script of the selected story is displayed in the editing window of the 
ENPS client window.

2 Double-click on the desired cue in the cue list block of the Quick Cue.

The Cue Edit window is displayed. The selected cue is loaded into the 
window as the current cue. The registration icon appears on the current cue.

3 Check the content and change the settings, if necessary.

For details, see “Details of Settings” on page 119.

4 Drag the registration icon from the Cue Edit window and drop it on the  
ENPS editing window (script).

After you save the script, the cue is added as an ELC item to the ENPS 
rundown. In the MOS Obj Slug column of the rundown, “ELC” followed by 
the cue name is displayed as the item name.

Note

4 Registration icon
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To display added cues in the Playlist Viewer and OA Playlist applications, you 
should save the script in the ENPS window with either of the following operations:
• Press the Ctrl + S keys. 
• Select the editing window rover and select [Save] from the menu displayed. 

Rules in setting ELC items
• The ELC items to be included in the same ELC story on a playlist should have 

the same slug. An ELC story consists of ELC items having the same Slug. 
• An ELC item should be placed before the item of the materials that the ELC 

cue uses.
• You can set multiple ELC items in an ENPS story.
• The materials to be used in an ELC cue should be set within the identical 

ENPS story.
• When the Page is set as “Unfreeze page numbers,” it will not be displayed in 

the playlist. To display the page, set “Freeze page numbers.” 

When using multiple PO Server Icons for an as-yet-
undetermined channel for a cue
To use more than one PO server in a cue, you should associate the buses or audio 
channels with the respective PO server channels in the ENPS Story. 
Specify the PO server materials (channels) in an ENPS story according to the 
order of the buses or audio channels on the object list.

When a PO Server Icon for a specific channel is used, this system is not 
applicable.

Editing an ELC Item added to an ENPS rundown

You can use Cue Edit to edit a cue that has been added to an ENPS rundown and 
has been described as an ELC item.

1 In the ENPS editing window (script), double-click on the  ELC item that you 
want to edit.

Note

Note
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The selected cue is displayed as the current cue in the Cue Edit window.

2 Make the required settings for the cue.

For details, see “Details of Settings” on page 119.

3 Click [Apply] to execute the settings. 

To reflect revisions in the Playlist Viewer and OA Playlist applications, you 
should save the script in the ENPS window with either of the following 
operations:
- Press the Ctrl + S keys. 
- Select the editing window rover and select [Save] from the menu displayed.

Note

ELC itemENPS editing window (script)

 Current cue
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Displaying a Playlist in the Playlist Viewer Application

The Playlist Viewer application allows you to view and check a playlist created 
with the Quick Cue and Cue Edit windows of the ELC Plug-in application. You 
can operate the application independently at different locations simultaneously 
without starting the ENPS client.

1 Double-click the Playlist Viewer icon (Playlist Viewer) on the Windows 
desktop.
Or, double-click the PlaylistViewer.exe file in the 
“Sony\ELC\PlaylistViewer” folder on the drive where the ELC-MVS01 
software is installed.

The Playlist Viewer starts and the Playlist Viewer window is displayed.

2 Select [File] > [Open] from the menu bar of the Playlist Viewer application.

The Open dialog box used for selecting a rundown is displayed. 

3 Select the “NRCS Rundown” folder on the Folder list.

Rundowns for which MOS Control Active is set with ENPS are listed in 
alphabetical order on the Playlist list.

4 Select the desired rundown, and click [OK].

The playlist corresponding to the selected rundown is loaded in the Playlist 
Viewer window.
Displaying a Playlist in the Playlist Viewer Application
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You can check the playlist content created in the ELC Plug-in applications. 
In the playlist, the ELC stories are listed. The ELC story consists of the cues 
having the same slug provided by the ENPS client. 

Note on scrolling of the playlist while on the air
The Playlist Viewer application scrolls the playlist automatically so that the cue 
currently being taken is displayed as the second cue on the screen.
You can view any other part of the playlist at any time, by manually scrolling 
the playlist using the scroll bar and mouse wheel.
Click [Current] in the Playlist Viewer window or press the F12 key to reactivate 
automatic playlist scrolling.

 

You cannot start more than the licensed number of copies of Playlist Viewer 
simultaneously.

Exiting the Playlist Viewer application

1 Click [File] > [Exit] from the menu bar of the Playlist Viewer.

The Playlist Viewer application is closed.

Note

Slug Current ELC story

Current button
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Creating a Playlist without 
Using NRCS
Starting the Playlist Viewer for Playlist Editing

In addition to checking a playlist created with the ELC Plug-in application, the 
Playlist Viewer application also allows you to create a playlist from scratch.
You can operate the application to create and edit playlists without starting the 
NRCS client.

1 Double-click the Playlist Viewer icon (Playlist Viewer) on the Windows 
desktop.
Or, double-click the PlaylistViewer.exe file in the 
“Sony\ELC\PlaylistViewer” folder on the drive where the ELC-MVS01 
software is installed.

The Playlist Viewer starts and the Playlist Viewer window is displayed.

You cannot start more than the licensed number of copies of Playlist Viewer 
simultaneously.

Note
Starting the Playlist Viewer for Playlist Editing
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Exiting the Playlist Viewer application

1 Click [File] > [Exit] from the menu bar of the Playlist Viewer.

The Playlist Viewer application is closed.
187Starting the Playlist Viewer for Playlist Editing
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Creating a New Playlist

1 Select [File] > [Open] from the menu bar of the Playlist Viewer application.

The Open dialog box is displayed.
 

2 Select the playlist folder in which you want to store the newly created 
playlist on the Folder list.

The playlists stored in the selected folder appear on the Playlist list.

The “NRCS Rundown” folder stores NRCS rundowns. You cannot create a 
playlist using the Playlist Viewer application.

To create a new folder
You can create a new playlist folder to store the newly created playlist in it.

For details, see “Creating a Playlist Folder” on page 199.

3 Click [Create New] that is displayed above the Playlist list.

The Create New dialog box appears.

4 Enter a playlist name of up to 40 alphanumeric characters and symbols in 
the Playlist Name text box.

5 To copy an existing playlist and open it as a new one, select the desired 
playlist displayed on the Template list, and click [OK].

Note
Creating a New Playlist
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The new playlist appears on the Playlist list in the Open dialog box.

6 Make sure that the new playlist is selected, and click [OK].

An empty playlist is displayed in the Playlist Viewer window.

You can create the playlist in this window by creating stories and adding 
cues in the stories.

For details on creating a story in a playlist, see “Creating a New Story” on 
page 191. For details on adding a cue in a story, see “Adding a Cue to a 
Story” on page 193. 

For other playlist editing functions, see “Editing a Playlist” on page 191.
189Creating a New Playlist
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Opening an Existing Playlist

1 Select [File] > [Open] from the menu bar of the Playlist Viewer application.

The Open dialog box that is used for selecting a rundown/playlist is 
displayed.

 

2 Select the desired playlist folder on the Folder list.

The playlists stored in the selected folder appear on the Playlist list.

The “NRCS Rundown” folder stores NRCS rundowns. These rundowns 
cannot be edited using the Playlist Viewer application. If you select one of 
the NRCS rundowns, it will be opened in “read-only” mode in the Playlist 
Viewer window.

3 Select the desired playlist, and click [OK].

The selected playlist is loaded in the Playlist Viewer window.

You can edit the playlist content in this window.

For details on editing a playlist, see “Editing a Playlist”(next).

Note
Opening an Existing Playlist
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Editing a Playlist

To create a playlist, first create a story in it, then add cues in the story. The 
Playlist Viewer application also provides other playlist editing functions, such 
as editing an existing cue, and moving/copying a cue or an entire story.

The Playlist Viewer window in the full-edit mode provides commands on the 
menu bar to edit a playlist. You can use the commands from the menu bar, too.

For the commands available from the menu bar, see “Menu bar” on page 43.

Creating a New Story

1 To add a new story at the end of the playlist, right-click on a blank area 
of the playlist, and select [Create New Story] from the displayed menu.

To insert a new story in the middle of the playlist, right-click on the story 
that is located at the place you want to insert the new story, and select 
[Create New Story] from the displayed menu.

The Story dialog box appears in either case.
 

2 Enter a page of up to four alphanumeric characters and symbols, and/or a 
slug of up to 30 alphanumeric characters and symbols for the new story in 
the corresponding text box, if desired.
The text boxes can be left blank.

3 To make the story a Commercial Break Story, put a check mark in the Break 
check box.

4 Click [OK] in the Story dialog box.

The newly created story appears on the playlist with the entered page/slug 
shown. A Commercial Break Story, if specified, is colored purple on the 
playlist.

Tip
191Editing a Playlist



192

  C
hapter 9  C

reating a P
laylist w

ithout U
sing N

R
C

S

Editing a Story

The page and/or slug for a story can be edited as follows:

1 Right-click on the story to be edited, and select [Edit] from the displayed 
menu.

The Story dialog box appears.
 

2 Modify the page of up to four alphanumeric characters and symbols, and/or 
slug of up to 30 alphanumeric characters and symbols for the story in the 
corresponding text box.
The text boxes can be left blank.

3 To make the story a Commercial Break Story, put a check mark in the Break 
check box.

4 Click [OK] in the Story dialog box.

The selected story appears with the modified page/slug. A Commercial 
Break Story, if specified, is colored purple on the playlist.

Deleting a Story

When a story that contains some cues is deleted, those cues are also deleted.

1 Right-click on the story to be deleted, and select [Delete] from the displayed 
menu.

If the story does not contain cues, it is deleted from the playlist, and the 
following stories move upwards.
If the story contains cues, a confirmation message appears.

2 Click [OK] for the message.

The selected story disappears, and the following stories move upwards.

Moving a Story

A story can be moved by either a drag & drop operation or a cut & paste 
operation.

Note
Editing a Playlist
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Moving a story by a drag & drop operation

1 Drag the desired story, and drop it in the desired position on the playlist. 

You can drop it at the top or bottom of the playlist, or between two 
consecutive stories. The story is moved to the position where it was 
dropped.

Moving a story by a cut & paste operation

1 Right-click on the story to be moved, and select [Cut] from the displayed 
menu.

The selected story is stored in the copy buffer, and it disappears from the 
playlist.

2 To paste the story at the end of the playlist, right-click on a blank area of 
the playlist, and select [Paste] from the displayed menu.

To insert the story in the middle of the playlist, right-click on the story 
that is located at the place you want to insert the moved story, and select 
[Paste] from the displayed menu.

The moved story appears before (above) the selected story.

Copying a Story

1 Right-click on the story to be copied, and select [Copy] from the displayed 
menu.

The selected story is copied to the copy buffer.

2 To paste the copy at the end of the playlist, right-click on a blank area of 
the playlist, and select [Paste] from the displayed menu.

To insert the copy in the middle of the playlist, right-click on the story 
that is located at the place you want to insert the copy, and select [Paste] 
from the displayed menu.

The copied story appears before (above) the selected story.

Adding a Cue to a Story

This section explains how to add cues in a playlist in the Playlist Viewer 
window. 
This operation uses the cues registered in Quick Cue. Before starting the 
operation, prepare the cues in the Quick Cue window.

For details on creating cues, see “Creating a Cue” on page 118. 

1 Click [Tools] > [Quick Cue] from the menu bar of the Playlist Viewer 
window.

The Quick Cue window is displayed.
193Editing a Playlist
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2 From the cue folder list of the Quick Cue window, click the folder 
containing the cue that you want to add to the playlist. 

The cues contained in the folder are displayed on the right.

3 Drag the desired cue from the Quick Cue window and drop it on the playlist.

To add the cue at the end of a story, drop the cue on the desired story.
To insert the cue in the middle of a story, drop the cue at the desired 
position in the desired story.

The selected cue appears on the playlist.

4 Repeat steps 2 and 3 to add cues to the playlist.

You can also copy a cue in the Quick Cue window, and paste it on the playlist.

To set a new item after checking the content of a cue
You can check the content of a cue and edit it, if necessary, before you actually 
add it to the playlist.

1 Display the Quick Cue window, and select the desired folder from the cue 
folder list of the Quick Cue window.

2 Double-click on the desired cue in the cue list block of Quick Cue window.

The Cue Edit tab is displayed in front. The selected cue is loaded as the 
current cue. The registration icon appears on the current cue.

3 Check the content and change the settings, if necessary.

For details, see “Details of Settings” on page 119.

Tip

Registration icon
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4 Drag the registration icon from the Cue Edit tab and drop it on the playlist.

To add the cue at the end of a story, drop the registration icon on the 
desired story.
To insert the cue in the middle of a story, drop the registration icon at the 
desired position in the desired story.

The cue appears on the playlist.

Editing a Cue

The Playlist Viewer application enables you to edit cues on the playlist.

1 In the Playlist Viewer window, right-click on the cue to be edited, and select 
[Edit] from the menu displayed.

The Cue Edit window appears, showing the data of the selected cue.

2 Edit the cue.
The edit procedures are the same as those in the ELC Plug-in window.

For details, see “Details of Settings” on page 119.

3 Click either of the following two buttons to confirm the editing.

• Apply: The revisions take effect.

• OK:  The revisions take effect and the Cue Edit window is closed.

To cancel editing
Click  on the upper right of the Cue Edit window.
Or, press the Esc key.

The Cue Edit window closes. The revisions do not take effect.

The Cue Edit window displayed 
on the Playlist Viewer window
195Editing a Playlist
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Deleting a Cue

1 Right-click on the cue to be deleted, and select [Delete] from the displayed 
menu.

The selected cue disappears, and the following cues and stories move 
upwards.

Moving a Cue

A cue can be moved by either a drag & drop operation or a cut & paste 
operation.

Moving a cue by a drag & drop operation

1 Drag the desired cue, and drop it in the desired position in the playlist. 

To move the cue to the end of a story, drop the cue on the desired story.
To insert the cue in the middle of a story, drop the cue at the desired 
position in the desired story.

Moving a cue by a cut & paste operation

1 Right-click on the cue to be moved, and select [Cut] from the displayed 
menu.

The selected cue is stored in the copy buffer, and it disappears from the 
playlist.

2 To move the cue to the end of a story, right-click on the desired story, and 
select [Paste] from the displayed menu.

To insert the cue in the middle of a story, right-click on the cue that is 
located at the place you want to insert the moved cue, and select [Paste] 
from the displayed menu.

The moved cue appears before (above) the selected cue.

Copying a Cue

1 Right-click on the cue to be copied, and select [Copy] from the displayed 
menu.

The selected cue is copied to the copy buffer.

2 To paste the copy at the end of a story, right-click on the desired story, 
and select [Paste] from the displayed menu.

To insert the copy in the middle of a story, right-click on the cue that is 
located at the place you want to insert the copied cue, and select [Paste] 
from the displayed menu.

The copied cue appears before (above) the selected cue.
Editing a Playlist
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Managing Playlists

The Playlist Viewer application provides playlist management functions, such 
as renaming or deleting a playlist, and changing the display order of the 
playlists.

 

Some functions are not available when you select the “NRCS Rundown” 
playlist folder.

Renaming a Playlist

1 Select [File] > [Open] from the menu bar of the Playlist Viewer application.

The Open dialog box is displayed.
 

2 Select the playlist folder in which the playlist you want to rename is stored 
on the Folder list.

The playlists stored in the selected folder appear on the Playlist list.

3 Right-click on the playlist to be renamed on the Playlist list, and select 
[Rename] from the displayed menu.

 

The Rename dialog box appears.

4 Enter the desired playlist name of up to 40 alphanumeric characters and 
symbols in the Rename dialog box, and click [OK].

The new playlist name appears on the Playlist list.

Note
197Managing Playlists
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Deleting a Playlist

You cannot delete a playlist when it is being used for on-air operations.

1 In the Open dialog box, select the playlist folder in which the playlist you 
want to delete is stored on the Folder list.

2 Right-click on the playlist to be deleted on the Playlist list, and select 
[Delete] from the displayed menu.

 

A confirmation message appears.

3 Click [OK] for the message.

The selected playlist disappears, and the following playlists move upwards.

Changing the Display Order of the Playlists

The Playlist Viewer application enables you to arrange the display order of the 
playlists in the Open dialog box.

1 In the Open dialog box, select the desired playlist folder on the Folder list.

2 Drag the desired playlist on the Playlist list, and drop it in the desired 
position on the list. 

Note
Managing Playlists
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Managing Playlist Folders

The Playlist Viewer application provides playlist folder management functions, 
such as creating or deleting a playlist folder, and changing the display order of 
the playlist folders.

 

Some functions are not available for the “NRCS Rundown” playlist folder.

Creating a Playlist Folder

1 Select [File] > [Open] from the menu bar of the Playlist Viewer application.

The Open dialog box is displayed.
 

2 Click [Create New] that is displayed above the Folder list.
Or, right-click on a blank space of the Folder list, and select [Create New] 
from the displayed menu.

The Create New dialog box appears.

3 Enter a folder name of up to 25 alphanumeric characters and symbols in the 
Create New dialog box, and click [OK].

The new playlist folder appears on the Folder list.

Renaming a Playlist Folder

1 In the Open dialog box, right-click on the playlist folder to be renamed on 
the Folder list, and select [Rename] from the displayed menu.

 

Note
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The Rename dialog box appears.

2 Enter a folder name of up to 25 alphanumeric characters and symbols in the 
Rename dialog box, and click [OK].

The new playlist folder name appears on the Folder list.

Deleting a Playlist Folder

When a playlist folder that contains some playlists is deleted, those playlists are 
also deleted.

1 In the Open dialog box, right-click on the playlist folder to be deleted on the 
Folder list, and select [Delete] from the displayed menu.

 

A confirmation message appears.

2 Click [OK] for the message.

The selected playlist folder disappears, and the following folders move 
upwards.

Changing the Display Order of the Playlist Folders

The Playlist Viewer application enables you to arrange the display order of the 
playlist folders in the Open dialog box.

1 In the Open dialog box, drag the desired playlist folder on the Folder list, 
and drop it in the desired position on the list. 

Note
Managing Playlist Folders
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This chapter describes on-air operations using the ELC-MVS01 system. The following illustration shows an example im-

age of the sub control room of a news studio.
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Starting the OA Playlist Application

1 Double-click the OAPlaylist icon (ELC OA Playlist) on the Windows 
desktop.
Or, double-click the OAPlaylist.exe file in the “Sony\ELC\OAPlaylist” 
folder on the drive where the ELC-MVS01 software is installed.

A window that displays startup options appears.

2 If you want to copy the settings from the switcher, place check mark(s) in 
the following check box(es).
This step may be required only when the settings have been changed on the 
switcher.

Copy the GPI & serial ports settings: Check this box when the GPI 
and/or serial port settings have been modified on the switcher.
Copy the macro registers: Check this box when the macro register 
settings and/or router snapshot settings have been modified on the switcher.
Copy the P2 Timeline: Check this box when the P2 Timeline settings 
have been modified on the switcher.

3 Click [OK].

A message appears while the system is copying the modified settings from 
the switcher.
Another message appears when the system gets prepared for operation.

4 Click [OK].

The OA Playlist application starts and the OA Playlist window is displayed.
Starting the OA Playlist Application
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Only one OA Playlist application can be operated in a system at a time. If the 
OA Playlist application has already been operating on the same computer, or on 
a different computer in the system, you cannot start the application.

Exiting the OA Playlist application

1 Select [File] > [Exit] from the menu bar of the OA Playlist window.

The OA Playlist application is closed.

When you exit the OA Playlist application during on-air operations, a 
confirmation message appears.
Click [OK] to end on-air operation and exit the OA Playlist application. Click 
[Cancel] to continue on-air operation.

Note

Note
203Starting the OA Playlist Application
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Starting/Ending On-Air Operation

The following procedure loads the desired playlist, starts on-air play of that 
playlist, and then ends on-air operation. 

In this section the iNEWS windows are used for explanations. The windows in 
this section may differ from those you will see if you are using ENPS. 

1 First, open a playlist.
In the OA Playlist window, select [File] > [Open] from the menu bar.

The Open dialog box used for selecting a rundown/playlist is displayed. 

2 Select the desired rundown/playlist, and click [OK].

The playlist corresponding to the selected rundown or the selected playlist 
is displayed in the OA Playlist window. 

For details on the OA Playlist window, see “OA Playlist and Playlist 
Viewer Windows” on page 43.

Tip
Starting/Ending On-Air Operation
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3 Next, start on-air operation.
Press the TAKE button on the shot box module.
Or, select [Playlist] > [Start] from the menu bar in the OA Playlist window.

The system makes the first cue on the playlist ready for on-air play. The 
background of the first cue flashes in yellow.   
Then the yellow background stops flashing, indicating that the cue has 
become the NEXT cue.
The Next monitor shows the image of the cue.

4 Check the image on the Next monitor, and press the TAKE button on the 
shot box module.

The first cue goes on the air. The OA monitor displays the image of the first 
cue. The audio level is automatically adjusted to the one specified for the 
cue.
• On the playlist

The background color of the first cue turns to green, indicating that the 
cue is now going on the air (OA cue). When the NEXT cue is not ready, 
the second cue flashes in yellow. Then it lights in yellow when it is ready.
When the duration has been specified to the cue, countdown starts.

• On the shot box module
The TAKE button lights in green during fade in/out of audio and/or a 
transition of video, and then lights in orange.

TAKE button
Shot Box Module
205Starting/Ending On-Air Operation



206

  C
hapter 10  O

n-A
ir O

perations
• On the audio fader panel
The moving faders corresponding to the Audio Icons for the cue move 
automatically, according to the specified audio levels.

If a “Fixed” mark appears under the duration indication of a cue, the next 
cue will be automatically taken after the specified duration elapses. (Step 5 
is not necessary for the next cue, in such a case.)

See also “Getting a Cue to Be Taken Automatically” on page 208.

5 Repeat step 4 to continue on-air operation.

6 To end on-air operation, select [Playlist] > [End] from the menu bar in the 
OA Playlist window.

The system may not switch audio/video of the current OA cue to the next, 
immediately. That is because some devices, such as a disk recorder, require 
some time (preroll) until a stable video image is output from the device.

Note on scrolling of the playlist during on-air operation
The OA Playlist application scrolls the playlist automatically so that the cue 
currently going on the air is displayed as the second cue on the screen.
You can view any other part of the playlist at any time, by manually scrolling 
the playlist using the scroll bar and mouse wheel.
Click [Current] in the OA Playlist window or press the F12 key to reactivate 
automatic playlist scrolling.

To change the Side Flag settings for the NEXT cue
You can change the Side Flag setting for the NEXT cue by pressing the button 
on the shot box module to which this function is assigned. Pressing the button 
toggles the Side Flag setting for the A bus or B bus (depending on the button) 
of the NEXT cue between on and off.

For details, see “Assigning Functions to the Shot Box Module Buttons” on page 
65.

Note

Duration indication with the “Fixed” mark
Starting/Ending On-Air Operation
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Manual operations available during on-air operation
During on-air operation, the ELC-MVS01 software allows some manual 
operations using the shot box module and audio fader panel.

For details on these manual operations, see 
• “Assigning Functions to the Shot Box Module Buttons” on page 65,
• “To toggle the duration of the OA cue between fixed/unfixed” on page 208,
• “Controlling Downstream Keys Manually” on page 212,
• “Controlling Keys Manually” on page 214,
• “Controlling the Audio Level Manually” on page 215,
• “Switching Multiple Snapshots Manually (2Box)” on page 222,
• “Switching Images Manually (Manual Switching)” on page 224,
• “Outputting GPI Trigger Pulses” on page 226,
• “Getting Cues Assigned to Shot Box Module Buttons on the Air” on page 227,
• “Enabling/Disabling Robotic Camera Control” on page 229, 
• “Enabling/Disabling Audio Mixer Control” on page 230, 
• “Overriding the Transition Settings for the NEXT Cue” on page 231,
• “Switching a Video Device to Its Backup” on page 232, and
• “Switching an Audio Device to Its Backup” on page 233.

To close the playlist
In the OA Playlist window, select [File] > [Close] from the menu bar.

The playlist disappears, and the shot box module buttons turn off.
207Starting/Ending On-Air Operation
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Getting a Cue to Be Taken Automatically

The ELC-MVS01 software supports automatic TAKE operations.
Specify “fixed” duration for a cue on the Cue Edit tab of the ELC Plug-in 
window. 

For details, see “Specifying the duration for a cue” on page 131.

When fixed duration is specified for a cue, a “Fixed” mark appears under the 
duration indication of the cue on the playlist. In such a case, the next cue will be 
automatically taken when the duration countdown for the cue reaches zero. 

The ELC-MVS01 software also allows you to toggle the duration of the OA cue 
between fixed/unfixed during on-air operations. This function can be assigned 
to a button on the shot box module of the system. The Initial Setup application 
is used to assign this function to a button in advance. 

For details on the Initial Setup operations, see “Assigning Functions to the Shot 
Box Module Buttons” on page 65.

To toggle the duration of the OA cue between fixed/unfixed

During on-air operations, you can toggle the duration of the OA cue between 
fixed/unfixed by pressing the button corresponding to this function on the shot 
box module.

1 On the shot box module, select the bank for the button corresponding to the 
function, by pressing the corresponding bank button. 

The name indicating the function assigned is shown on each button.

“Fixed” mark under the duration indication
Getting a Cue to Be Taken Automatically
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When this function is not currently available, the button turns off, with only 
the function name displayed.

2 Press the button corresponding to the function that toggles the duration of 
the OA cue between fixed/unfixed.

Each time you press the button, the “Fixed” mark under the duration 
indication of the OA cue appears and disappears alternately.

Note
209Getting a Cue to Be Taken Automatically
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Selecting a Cue to be Brought On the Air Next

The OA Playlist application enables you to select a cue to be played next, that 
is, you can change the playout order of the cues on the playlist. This function is 
helpful when a problem occurs with a satellite channel and you have to skip a 
series of cues, for example, or when you have to change the playout order of the 
stories to get some time for quick editing of late-breaking news clips.

In this section the iNEWS windows are used for explanations. The windows in 
this section may differ from those you will see if you are using ENPS. 

1 Double-click the desired cue on the playlist.

The system makes the first cue on the playlist ready for on-air play. The 
background of the first cue flashes in yellow. 
Then the yellow background stops flashing, indicating that the cue has 
become the NEXT cue.
The Next monitor shows the image of the cue.

2 Check the image on the Next monitor, and press the TAKE button on the 
shot box module.

The selected cue goes on the air. The OA monitor displays the image of that 
cue.
On the playlist, the background color of the selected cue turns to green, 
indicating that the cue has become the “OA cue.” The system gets the 
NEXT cue ready, and the background color of the NEXT cue flashes in 
yellow.

Tip

Double-clicked cue
Selecting a Cue to be Brought On the Air Next
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• When you skip several cues using the procedure described above, you may 
have to change the standby events on the playout server and CG/still store 
system playlists by yourself, as these two are outside the ELC-MVS01 
system. 

• The OA cue, that is, the cue currently on the air, cannot be selected as the 
NEXT cue.

Notes
211Selecting a Cue to be Brought On the Air Next
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Controlling Downstream Keys Manually

Downstream key operations can be assigned to the buttons on the shot box 
module of the ELC-MVS01 system. The Initial Setup application is used to 
assign functions to the buttons in advance. 
During on-air operations, you can control downstream keys manually by 
pressing the button corresponding to the desired operation.

For details on the Initial Setup operations, see “Assigning Functions to the Shot 
Box Module Buttons” on page 65.

The ELC-MVS01 system does not provide an automatic downstream key 
control function.

1 On the shot box module, select the bank for the button of the desired 
downstream key control operation, by pressing the corresponding bank 
button. 

The buttons to which functions are assigned light in orange or green, 
depending on the functions assigned. The name indicating the function 
assigned is shown on each button.

For details on the functions and colors of the buttons, see “Downstream key 
control functions that can be assigned to the shot box module buttons” 
(next).

2 Press the button corresponding to the desired downstream key control 
operation.

The color of the button you pressed changes, and the downstream key 
control assigned to the button starts.

Downstream key control functions that can be assigned to the shot 
box module buttons
The following downstream key control functions can be assigned to the shot box 
module buttons using the Initial Setup application:

Note

Shot Box Module
Controlling Downstream Keys Manually
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• DSK1 - 4 On/Off
Cuts the downstream key in or out alternately.
The button lights in green when the downstream key is inserted, or orange 
when the downstream key is deleted.

• DSK1- 4 Auto Transition
Inserts or deletes the downstream key alternately, with a transition effect. The 
transition type and rate currently specified on the switcher are used.
The button lights in green during transition, and turns to orange after the 
transition is complete.

• DSK1 - 4 Link
Associates turning the downstream key on and off for the TAKE operation.
The button lights in green when “DSK link” is on, or orange when “DSK link” 
is off. 
When “DSK Link” is not available, the button light turns off, with only the 
function name displayed.
When “DSK link” is on, so that the button lights in green, the downstream key 
currently inserted will be deleted upon the next TAKE operation. If the 
downstream key is not inserted now, it will be inserted upon the next TAKE 
operation, with a transition effect. The transition type and rate currently 
specified on the switcher are used.

The names indicated on the buttons may be different from the function names 
described above, as the Initial Setup application enables a technical director to 
name the buttons on the shot box module.

For details, see “Specifying the Name of a Button” on page 70.

Note
213Controlling Downstream Keys Manually
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Controlling Keys Manually

Key operations can be assigned to the buttons on the shot box module of the 
ELC-MVS01 system. The Initial Setup application is used to assign functions 
to the buttons in advance. 
In addition to automatic key control operation according to the playlist, you can 
control keys manually by pressing the button corresponding to the desired 
operation during on-air operations. When a key is specified in a cue with the 
“key on” mode set to Auto, the key will be automatically inserted upon a TAKE 
operation, then the operator can control the key manually after that. When a key 
is specified with the “key on” mode set to Manual, the key will not inserted 
automatically. The operator can control the key manually, using the buttons on 
the shot box module.

For details on the key on mode settings, see “Setting Keys” on page 124.
For details on the Initial Setup operations, see “Assigning Functions to the Shot 
Box Module Buttons” on page 65. 

1 On the shot box module, select the bank for the button of the desired key 
control operation, by pressing the corresponding bank button. 

The buttons to which functions are assigned light in orange or green, 
depending on the functions assigned. The name indicating the function 
assigned is shown on each button.

For details on the functions and colors of the buttons, see “Key control 
functions that can be assigned to the shot box module buttons” (next).

2 Press the button corresponding to the desired key control operation.

The color of the button you pressed changes, and the key control assigned 
to the button starts.

Key control functions that can be assigned to the shot box module 
buttons
The following key control functions can be assigned to the shot box module 
buttons using the Initial Setup application:

• Key1 - 4 On/Off
Cuts the key in or out alternately.
The button lights in green when the key is inserted, or orange when the key is 
deleted.

• Key1- 4 Auto Transition
Inserts or deletes the key alternately, with a transition effect. The transition 
type and rate specified in the cue are used.
The button lights in green during transition, and turns to orange after the 
transition is complete.

The names indicated on the buttons may be different from the function names 
described above, as the Initial Setup application enables a technical director to 
name the buttons on the shot box module.

For details, see “Specifying the Name of a Button” on page 70.

Note
Controlling Keys Manually
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Controlling the Audio Level Manually

In addition to the automatic fader control function, the OA Playlist application 
enables you to control the audio level, and to turn audio channels on/off 
manually during on-air operation. You can also enable a Mix-minus setting for 
certain channels.

For details on the Initial Setup operations, see “Making the Audio Mixer 
Settings” on page 57.

On the audio fader panel, each fader is used to control two channels, so that the 
eight faders can control 16 channels. For example, the leftmost fader controls 
channel 1 and channel B1. Channels 1 to 8 are associated with the Audio Icons 
for automatic fader control, and channels B1 to B8 (back faders) are used for 
manual fader control.
The source buttons located above the faders are used to switch these two. The 
button is green when the channel for automatic fader control (channels 1 to 8) is 
selected, and magenta when the channel for manual fader control (channels B1 
to B8) is selected. 
The name of the channel currently selected appears on the source button.

Use the Initial Setup application to modify associations between the back fader 
numbers (B1 to B8) of the audio fader panel and the devices.
This is helpful in urgent situations, such as when there is breaking news.

Note

Audio Fader Panel

Source buttons
215Controlling the Audio Level Manually
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Adjusting the Audio Levels

1 On the audio fader panel, check the name indicated on the source button and 
its color. The source buttons are green when the faders for automatic fader 
control (1 to 8) are selected, while they are magenta when the back faders 
for manual fader control (B1 to B8) are selected.
Press the corresponding source button to toggle the selection, if necessary.

2 Adjust the audio level by using the moving fader for the desired channel.

Once you touch a moving fader for automatic fader control (channel 1 to 8), 
the audio level specified for the cue is cancelled. For example, if you keep 
the moving fader at the –∞ dB position, no audio will be output even when 
the NEXT cue is taken.

Each source button indicates the audio device name assigned to the channel for 
channels 1 to 8. For channels B1 to B8, the source name imported from the audio 
mixer or the fader number is indicated.

To apply the current audio level to an audio level option for the same audio device
After adjusting the audio level, you can apply the adjusted audio level to one of 
the three audio level options for automatic fader control, so that the audio level 
of any other cues that use the same Audio Icon will be changed to the current 
level. 

Adjust the audio level as described in “Adjusting the Audio Levels” above, then 
hold down the source button corresponding to the OA cue, and press the desired 
function button for the channel.

The function button goes off once and lights again to show that the audio level 
has been changed. Then, press the source button, which is flashing, to end the 
setting operation.

Note

Function Buttons Descriptions (See also page 63 and page 127)

Top row Sets the audio level for audio level option 3.

Second row Sets the audio level for audio level option 2.

Bottom row Sets the audio level for audio level option 1.
Controlling the Audio Level Manually
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The modified audio level is kept until the playlist closes.
The audio level of a cue that uses the same Audio Icon and is specified with the 
same audio level option will be set at the level that is set in this operation. If this 
operation is done on a cue in which a “Mic1” Audio Icon and the “2” audio level 
option are specified, for example, each of the following cues in the playlist with 
the same Icon and audio level option specified will be affected.

To enable the pre-fader listen (PFL) function
To monitor the pre-fader sound of the audio material, make sure that the LED 
for the function button on the second row is not lit, and hold down the top 
function button for the channel associated with the desired audio device.

Press one of the three 
function buttons for the 
channel.

Hold down the 
source button

Hold down the button for 
the desired channel.

The indicator 
should not be lit.
217Controlling the Audio Level Manually
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Turning an Audio Channel On and Off 

1 On the audio fader panel, check the name indicated on the source button and 
its color. 

The source buttons are green when the faders for automatic fader control (1 
to 8) are selected, while they are magenta when the back faders for manual 
fader control (B1 to B8) are selected.
Press the corresponding source button to toggle the selection, if necessary.

2 Make sure that the LED for the function button on the second row is not lit, 
and press the button on the third row for the desired channel.

Pressing the button alternately turns audio output of the corresponding 
channel on and off.
The LED for the button lights while the channel is turned on. The LED does 
not light when the channel is turned off.

Enabling the Mix-Minus Setting

Using the audio fader panel, you can enable the Mix-minus setting for a certain 
channel. When the Mix-minus setting is enabled for a channel, sound from that 
channel will be removed from the master audio output upon being sent to a 
certain AUX bus. 
This setting is often used for a reporter at a remote location, so that he/she will 
not hear his/her own voice.
Controlling the Audio Level Manually



  C
hapter 10  O

n-A
ir O

perations
1 On the audio fader panel, check the name indicated on the source button and 
its color. 

The source buttons are green when the faders for automatic fader control (1 
to 8) are selected, while they are magenta when the back faders for manual 
fader control (B1 to B8) are selected.
Press the corresponding source button to toggle the selection, if necessary.

2 Press the function button on the second row for the desired channel, so that 
the LED for the button lights.

This enables the Mix-minus setting for the selected channel.

3 Select the AUX bus to which the Mix-minus audio should be sent, by 
pressing one of the function buttons.

 
The LED for the pressed button lights, and the Mix-minus audio is sent to 
the corresponding AUX bus.

• Depending on the audio mixer you are using, there may be restrictions on 
using the AUX Bus.

• The Mix-minus audio is sent to one AUX bus only.
If you select another AUX bus, the Mix-minus audio will be sent to the 
newly selected AUX bus and is no longer sent to the old one.

4 When the Mix-minus audio becomes unnecessary, press the function button 
on the second row for the channel, so that the LED for the button goes off.

This cancels the Mix-minus setting for the selected channel.

AUX bus Button

AUX1 - AUX8 Top function buttons for fader 1 to fader 8.

AUX9 - AUX16 Function buttons on the third row for fader 1 to fader 8.

Notes

 (for AUX1 to AUX8)

 (for AUX9 to AUX16)
219Controlling the Audio Level Manually
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Editing Cues in the OA Playlist or Playlist Viewer 
Window

Both the OA Playlist and Playlist Viewer application enable you to edit cues. 
You can edit a cue displayed in a playlist, even during on-air operation, without 
using the ELC Plug-in application for the NRCS client window. To add, delete, 
or move a cue in a playlist, however, the ELC Plug-in application should be 
used.

• When you are using iNEWS, version 3.0 or a later version of iNEWS is 
necessary to use this function.

• The OA cue cannot be edited. If you edit it, the revisions made are not 
reflected in the NRCS.

1 In the OA Playlist or Playlist Viewer window, right-click on the cue to be 
edited, and click [Edit] from the menu displayed.
Or, select the cue to be edited, then press the Enter key.

The Cue Edit window appears, showing the data of the selected cue.

2 Edit the cue.
The edit procedures are the same as those in the ELC Plug-in window.

For details, see “Details of Settings” on page 119.

3 Click either of the following two buttons to confirm the editing.

• Apply: The revisions take effect.

Notes

The Cue Edit window displayed on 
the OA Playlist window
Editing Cues in the OA Playlist or Playlist Viewer Window
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• OK:  The revisions take effect and the Cue Edit window is closed.

On the playlist, the  mark appears for the edited cue until the revisions 
are reflected in the NRCS. When the revisions are registered in the NRCS, 
the mark will disappear and the display of the edited cue on the playlist is 
updated.

If the  mark does not disappear, the corresponding story may be locked 
in an NRCS client window. Check the story, and unlock it, if necessary. 

To cancel editing
Click  on the upper right of the Cue Edit window.
Or, press the Esc key.

The Cue Edit window closes. The revisions do not take effect.

Note
221Editing Cues in the OA Playlist or Playlist Viewer Window
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Manual Operations
Switching Multiple Snapshots Manually (2Box) 

During on-air operations, you can recall and switch multiple snapshots 
manually. This function is useful when you want to switch to a person at the 
studio and to another at a different location alternately, and also when showing 
both persons in a separate two-panel (2Box) window as shown in the following 
example. 

By allocating three pieces of video material (snapshots) to three buttons of the 
shot box module, you can easily switch scenes with buttons when the cue is on 
the air.

Required preparations
Before starting operation for multiple snapshots, do the following:
• Assign snapshots to buttons of the shot box module (Initial Setup)
• Create an Effect Icon for manual switching of the snapshots (Icon Manager)
• Set the cue containing the Effect Icon for switching multiple snapshots, and 

add it to the NRCS rundown (ELC Plug-in)

For details, see “Preparing for Switching Multiple Snapshots Manually 
(2Box)” on page 137.

Operations

1 Start the OA Playlist application and start the on-air operation.

After you completely switch to the video and audio of the assigned cue, all 
the buttons of the groups set with the Icon Manager are enabled and light in 
orange. Among those buttons, the button assigned to the Standby Group 
source materials lights in yellow. 
Switching Multiple Snapshots Manually (2Box)
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2 Press the button on the shot box module to which the desired snapshot is 
assigned. 

You can manually switch among the assigned snapshots and switch cuts by 
pressing the relevant  buttons.

Each time you press the button, the relevant button lights in yellow. 

After the on-air operation of the subject cue is completed, the buttons 
become disabled and turn off.  

Assigned 
buttons on the 
Shot Box 
Module
223Switching Multiple Snapshots Manually (2Box)



224

  C
hapter 11  A

dvanced or O
ccasional M

anual O
perations
Switching Images Manually (Manual Switching)

During on-air operations, you can switch images at random using the manual 
switching function, while in conventional on-air operations the image transition 
is fixed.
This function is useful when images from multiple cameras have to be switched 
alternately, or when you should switch only one of multiple portions of an 
image. The following examples show how this function is used.

Example 1: A shot is switched from camera 1 to camera 2 within a cue.

Example 2: The image in an inset screen is switched while the rest of the image 
remains in Picture in Picture mode. 

 

Required preparations
Before using manual switching, do the following:
• Assign materials used for manual switching to buttons of the shot box module 

(Initial Setup)
• Create an Effect Icon for manual switching (Icon Manager)
• Set the cue containing the Effect Icon for manual switching, assigning a 

maximum amount of materials to the Icon, and add the cue to the NRCS 
rundown (ELC  Plug-in)

For details, see“Preparing for Manual Switching” on page 143.

Operations

1 Start the OA Playlist application and start the on-air operation.

After you completely switch to the video and audio of the assigned cue, all 
the buttons for the Manual Switching sources set with the Cue Edit window 
are enabled, and all but one light in orange. Among those buttons, the button 
for the standby source lights in yellow. 

2 To switch to the images, press the button on the shot box module to which 
the desired materials are assigned. 

Camera 1 shot                                       Camera 2 shot 

While showing an image from a news studio, only the images in the 
background insert screen switch.
Switching Images Manually (Manual Switching)
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You can manually switch among the assigned materials by pressing the 
relevant  buttons.

Each time you press the button, the relevant button lights in yellow.  

After the on-air operation of the subject cue is completed, the buttons 
become disabled and turn off. 

Assigned 
buttons on the 
Shot Box 
Module
225Switching Images Manually (Manual Switching)



226

  C
hapter 11  A

dvanced or O
ccasional M

anual O
perations
Outputting GPI Trigger Pulses

GPI trigger pulses are used to control a device outside of the ELC-MVS01 
system. 
There are two types of GPI pulse output: automatic output and manual output.

Required preparations
To output GPI pulses, do the following:

For automatic output: 
• Create a cue for which up to four ports from which GPI pulses should be 

output are specified (ELC Plug-in)

For manual output:
• Assign ports (“GPIn,” where n is the GPI port number defined in the System 

Setup application) from which GPI pulses should be output to buttons of the 
shot box module (Initial Setup)

For details, see “Preparing for GPI Trigger Pulse Output” on page 151.

The System Setup application is used for setup related to the GPI pulse output 
ports, such as names of the ports and specifications of the output pulses.

Operations

For automatic output:
No operations are required to output GPI pulses. Pulses will automatically be 
output from the specified port(s) in the cue when a cue is brought to the air by a 
TAKE operation.

For manual output:

1 Start the OA Playlist application and start the on-air operation.

When the shot box module buttons to which the GPI output function is 
assigned are enabled, the buttons light in orange. 
If some of those buttons are disabled, the button lights turn off, with only 
the function names displayed.

2 Press the button on the shot box module to which the function of GPI output 
from the desired port is assigned. 

Each time you press the button, the relevant button lights in green and a GPI 
pulse is output. 

Note
Outputting GPI Trigger Pulses
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Getting Cues Assigned to Shot Box Module Buttons 
on the Air

The ELC-MVS01 software enables you to use up to 24 cues assigned to 24 
buttons of the shot box module for on-air operation. Any one of the 24 cues can 
be assigned as the NEXT cue regardless of the playlist by pressing the 
corresponding buttons of the shot box module.

Required preparations
To get cues randomly on the air, do the following:
• Create a folder, and make it a shot box candidate cue folder for this operation 

(ELC Plug-in)
• Create the desired cues in the newly created folder (ELC Plug-in)
• Assign the cues in the newly created folder to buttons (Cue 1 - 24) of the shot 

box module (Initial Setup)

See “Assigning Individual Cues to Shot Box Module Buttons” on page 154 for 
details.

Operations

1 Start the OA Playlist application and start the on-air operation.

2 Click [Tools] > [Shot Box Folder], and select the cue folder to be used from 
the listed candidates.

 

When cues in the selected cue folder, which has been specified as a shot box 
candidate, are assigned to the buttons on the shot box module, the buttons 
light in orange, and the names of the cues are shown on the corresponding 
buttons.

3 Press the button on the shot box module corresponding to the desired cue.

The cue assigned to the pressed button becomes the NEXT cue, and the 
button lights in yellow. The Next monitor shows the image of the cue.
In the OA Playlist window, the yellow background color for the NEXT cue 
disappears because now the NEXT cue is not listed on the playlist.

4 Check the image on the Next monitor, and press the TAKE button on the 
shot box module.
227Getting Cues Assigned to Shot Box Module Buttons on the Air
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The corresponding cue in the selected cue folder, which is not on the 
playlist, goes on the air. The OA monitor displays the image of that cue, and 
the relevant button on the shot box module lights in green. 
In the OA Playlist window, the cue that was originally the NEXT cue before 
step 3 becomes the NEXT cue, and appears with a yellow background color, 
again.

5 Repeat steps 3 and 4, as necessary.
On-air operation continues without using the playlist.

If you stop repeating the operation, the NEXT cue on the playlist will 
automatically go on the air upon the next TAKE operation.
If necessary, however, double-click the cue to be the NEXT cue on the playlist.
The background of the cue flashes in yellow, then stops flashing as it becomes 
the NEXT cue.

Tip
Getting Cues Assigned to Shot Box Module Buttons on the Air
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Enabling/Disabling Robotic Camera Control

During on-air operations, the ELC-MVS01 software usually controls robotic 
cameras in the system. You can toggle this robotic camera control function 
between enabled/disabled by pressing a button on the shot box module. 

Required preparations
To disable/enable robotic camera control, do the following:
• Assign the camera control enable/disable switching functions to buttons of the 

shot box module (Initial Setup)

* Only the numbers specified for functions (n) for camera control assigned in the System Setup 
application are available.

See “Assigning Functions to the Shot Box Module Buttons” on page 65 for 
details.

Operations

1 Start the OA Playlist application and start the on-air operation.

When control of a robotic camera is enabled, the relevant shot box module 
button lights in green. When control from the system is disabled, the 
relevant button lights in orange.

2 Press the button on the shot box module to enable/disable control of the 
robotic camera from the system.
A single button enables and disables control of robotic camera alternately.

Each time you press the button, the relevant button lights in green (control 
enabled) or orange (control disabled). 

Function Group Function Description

Camera Control CAMn* Control Disables/enables robotic camera control 
from the ELC-MVS01 system.  
229Enabling/Disabling Robotic Camera Control
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Enabling/Disabling Audio Mixer Control

During on-air operations, you can toggle the audio mixer control function of the  
ELC-MVS01 software between enabled/disabled by pressing a button on the 
shot box module. 

Required preparations
To disable/enable audio mixer control, do the following:
• Assign the audio mixer control enable/disable switching function to a button 

of the shot box module (Initial Setup)

See “Assigning Functions to the Shot Box Module Buttons” on page 65 for 
details.

Operations

1 Start the OA Playlist application and start the on-air operation.

When control of the audio mixer is enabled, the relevant shot box module 
button lights in green. When control from the system is disabled, the 
relevant button lights in orange.

2 Press the button on the shot box module to enable/disable control of the 
audio mixer from the system.
A single button enables and disables control of the audio mixer alternately.

Each time you press the button, the relevant button lights in green (control 
enabled) or orange (control disabled). 
When control of the audio mixer is enabled, the system starts control of the 
audio mixer from the next TAKE operation.

Function Group Function Description

Mixer Control Mixer Control Disables/enables audio mixer control 
from the ELC-MVS01 system.  
Enabling/Disabling Audio Mixer Control
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Overriding the Transition Settings for the NEXT Cue

Although the way a cue transitions from its previous cue is specified in the cue 
using a Transition Icon, the ELC-MVS01 software allows the operator to use 
different transitions during on-air operation, overriding the setting of the NEXT 
Cue.

Required preparations
To override the transition settings, do the following:
• Assign the following functions to buttons of the shot box module (Initial 

Setup)

See “Assigning Functions to the Shot Box Module Buttons” on page 65 for 
details.

Operations

1 Start the OA Playlist application and start the on-air operation.

When a cue becomes the NEXT cue, the shot box module buttons 
corresponding to its transition type and transition rate light in yellow, and 
other buttons relevant to transition settings light in orange.
The buttons that cannot be used turn off, with only the function names 
displayed. 

2 Press the shot box module button corresponding to the desired transition 
type or transition rate.
To change the transition type to “cut” or “mix,” or to return the transition 
type to that preset in the cue, press the corresponding button on the shot box 
module. 
To change the transition rate, too, press the corresponding button on the shot 
box module.

Each time you press the button, the relevant button lights in yellow.

 

This function is not available for a cue specified with a fixed duration.

Function Group Function Description

Transition 
Override

PRESET Returns the transition type of the NEXT 
cue to the one specified in the cue. 

CUT Makes the transition type of the NEXT 
cue Cut-in, regardless of the transition 
type specified in the cue.

MIX Makes the transition type of the NEXT 
cue Mix, regardless of the transition type 
specified in the cue.

Transition Rate 1 - 4 Applies the transition rate that has been 
set for the “1” - “4” options in the Initial 
Setup application to the NEXT cue, 
overriding the transition rate specified in 
the cue.
For details on the transition rate options, 
see “Specifying the Transition Rate 
Options” on page 56.

Note
231Overriding the Transition Settings for the NEXT Cue
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Switching a Video Device to Its Backup

During on-air operations, you can switch a video device to a backup specified 
using the Initial Setup application. 
This feature is useful when a problem occurs on a video device, such as a 
DDR(VDCP). By switching to the backup, the ELC-MVS01 software uses the 
switcher to output the video signal from the backup device instead of the signal 
from the original video device, without editing the playlist.

The ELC-MVS01 software does not control the backup device in place of the 
original device, though.

Required preparations
To switch a video device to its backup, do the following:
• Specify the backup for the desired video devices (Initial Setup)
• Assign the backup video switching function for the video device to a button 

of the shot box module (Initial Setup)

For details, see “Preparing for Switching a Video Device to Its Backup” on 
page 158.

Operations

1 During on-air operations, press the button for the desired video device on 
the shot box module, which lights in green, to switch to its backup.

The buttons light in the following colors.
Buttons for switching to the backups: Green
Buttons for switching to the original devices: Orange

Note

Tip
Switching a Video Device to Its Backup
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Switching an Audio Device to Its Backup

During on-air operations, you can switch an audio device to a backup specified 
using the Initial Setup application. 
This feature is useful when a problem occurs on an audio device, such as a 
microphone. By switching to the backup, the ELC-MVS01 software uses the 
audio mixer to output the audio signal from the backup device instead of the 
signal from the original audio device, without editing the playlist.

The ELC-MVS01 software does not control the backup device in place of the 
original device, though.

Required preparations
To switch an audio device to its backup, do the following:
• Specify backup for the desired audio devices (Initial Setup)
• Assign the backup audio switching function for the audio device to a button 

of the shot box module (Initial Setup)

For details, see “Preparing for Switching an Audio Device to Its Backup” on 
page 162.

Operations

1 During on-air operations, press the button for the desired audio device on 
the shot box module, which lights in green, to switch to its backup.

The buttons light in the following colors.
Buttons for switching to the backups: Green
Buttons for switching to the original devices: Orange

Note

Tip
233Switching an Audio Device to Its Backup
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Audio Fader Panel
The JL Cooper fader panel, which 
allows you to register audio input 
controlled by the ELC-MVS01. 
The following features are available:
• Display and adjustment of audio 

level with the Auto Fader feature
• Mix-minus setting
• Channel On/Off
• PFL (Pre Fader Listening) setting 

(Cue)

Audio Icon
An Audio Icon represents audio 
materials from an audio or video 
server. It is used to change audio 
materials.

Audio Server
A server that saves and plays audio 
files. An audio server does not have 
playlist function.

Auto Transition 
A function assigned to a button on the 
shot box module. Pressing the Auto 
Transition button starts the DSK 
transition. 

BKGD/ALL
A transition setting that allows you to 
select whether only a background 
image (A bus) among the images 
composing a cue is transitioned or the 
whole image of a cue is transitioned 
to the next cue.

CG (Character Generator)
The device that generates and plays 
characters or images. A server having 
a playlist function. The CG/Still 
Store controller type with a playlist 
function and a storage type without a 
playlist function can be a different 
device.

Class
A categorization of an Icon. 
According to the class selected, the 
menus show relevant options for the 
class.

Continuous
A function to be used when you 
continuously use the same material 
both in a cue currently on the air and 
a cue to be on the air next. To use the 
same material in two consecutive 
cues without repeating device control 
operations on a TAKE operation 
between the two cues, the 
Continuous Icon is used. There are 
several types of Continuous Icon 
provided, to be selected depending 
on the bus where the material will be 
played in the previous cue. 

Cue
The minimum unit that can be put on 
the air by using the TAKE button. A 
cue, a frequently-used scene, is 
composed of Icons and their detailed 
settings. 

Cue to be brought on the air 
next
Assigning a random cue to be used on 
the air next. To change the order of 
programs or skip a cue, you can 
change the order of TAKE operations 
from the OA Playlist. When you 
change the order from that of the OA 
playlist, note that synchronization 
with the CG, playout server, or other 
device may fail.  

Cue Edit
The tool used to edit an ELC cue in  
the ELC Plug-in window or the 
Playlist Viewer window in the full-
edit mode. 
You can add, delete, or change 
components of a cue, and create a 
playlist.

Current Button
The button used to instantly display 
the cue currently on the air while 
scrolling the playlist manually.

Current Cue
The cue currently being edited, 
appearing at the top of the Cue Edit 
window.

DDR (SonyVTR)
A disk recorder that the ELC-MVS01 
can control via the Sony VTR 
Protocol. 
235Glossary
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DDR (VDCP)
A disk recorder that the ELC-MVS01 
can control via the VDCP (Video 
Disk Control Protocol). It contains 
daily-use video files. To use files in 
the ELC-MVS01 system, you should 
register the required files in a file list 
in advance. This recorder does not 
have a playlist function.

DSK (Downstream Key)
The key to be inserted in the last 
program output. By using buttons on 
the shot box module with the function 
assigned, you can insert or delete  the 
key. To synchronize the DSK with a 
TAKE operation, use the DSK Link 
function and perform a TAKE 
operation.

DSK Link
Inserting and deleting the DSK 
simultaneously with a TAKE 
operation according to the switcher 
settings. To perform this operation, 
use a button on the shot box module 
to which the function is assigned.

Effect Icon
An Effect Icon represents video 
effect settings. The status of the video 
switcher is registered as a “snapshot” 
in the switcher and recalled to be 
used in the Effect Icon. This is used 
to set a video effect. By switching 
multiple snapshots, you can create a 
dynamic image effect. An effect Icon 
contains a Video Icon as an element. 
Create an Effect Icon after the Video 
Icon is created.

ELC Object
A cue dragged from the ELC Plug-in 
to an NRCS rundown, which is called 
“ELC Production cue” for iNEWS 
and “ELC Item” for ENPS.

ELC Plug-in
Plug-in software that the ELC-
MVS01 supplies for users to create 
an ELC playlist. It works as part of 
the NRCS client window.

ELC Story
A group of cues. 
If you are using iNEWS, cues having 
the same page number in the iNEWS 
rundown make a group.
If you are using ENPS, cues having 
the same slug in the ENPS rundown 
make a group.

ENPS
The News Room Computer System 
(NRCS) supplied by Associated 
Press.

ENPS Story
A line of an ENPS rundown.

Fixed Duration
Duration of a cue that is fixed.
When a fixed duration is specified for 
a cue, the next cue will be 
automatically taken after the 
specified duration elapses (Auto 
TAKE). 

Free M/E
A free M/E is an M/E in addition to 
the OA and NEXT M/Es on the 
switcher, hence it is not used for 
switching the OA and Next images. 
Using the output of a free M/E for a 
video bus adds one more layer for 
image composition, and that enables 
more intricate effects.

Icon
A graphic representing settings of a 
video switcher, audio mixer, or 
devices for materials including 
cameras, servers, and CG. It is used 
to create and edit a cue. The ELC-
MVS01 provides Video, Audio, 
Transition, and Effect Icons. 

iNEWS
The News Room Computer System 
(NRCS) supplied by Avid 
Technology, Inc. 

iNEWS Story
A line of an iNEWS rundown.

Initial Setup
An ELC-MVS01 application that is 
used to perform setup for daily-
operations.

Initial Snapshot
A snapshot used to initialize the 
Video Switcher for on-air operations, 
or to contain the settings made for the 
system. Users can select at random 
from Snapshots 1 to 99 of the System 
Setup application.

Key Memory
A function of the video switcher that 
allows the key settings to be stored 
automatically according to the pair 
number, so that the next time the 
same pair number is selected, these 
settings are recalled automatically. 

Manual Switching
Function used to switch scenes at 
random, manually. You can register 
up to six video signals in the shot box 
module, and switch scenes by 
pressing the buttons on the shot box 
module. This function is assigned to 
an Effect Icon.

NEXT M/E
The M/E bank used for the NEXT 
Cue in the video switcher. 

OA M/E
The M/E bank used for the OA Cue in 
the video switcher. 

Pair No.
The combination expressed as a 
number of video signal and key 
signal assigned to a cross point. It is 
set by the video switcher.
Glossary



 A
ppendix
Playlist
A list used to play each piece of 
material in order, created based on 
the rundown received from the 
NRCS. You can also create a playlist 
from scratch by using the Playlist 
Viewer application.
A server under the ELC control does 
not contain a playlist function, but the 
CG and playout server have their own 
playlists.

Playlist Viewer
The Playlist Viewer allows you to 
view playlists created with the ELC 
Plug-in application. (The software 
works as an application independent 
of the ELC Plug-in application.) 
While the ELC Plug-in application 
allows you to view only one cue, the 
Playlist Viewer application allows 
you to view the whole program 
structure. When a playlist created 
with the ELC Plug-in application is 
open, the Playlist Viewer is in the 
read-only mode.
The Playlist Viewer also enables you 
to create and edit playlists from 
scratch. When a playlist created from 
scratch is open, the Playlist Viewer is 
in the full-edit mode.

PO (Playout) Server
A playout server is a server having a 
playlist function. It can be used to 
handle daily-changing materials. The 
controller containing a playlist 
function and the storage without a 
playlist function can be a different 
device. 

Program End
Ending an on-air operation.

Program Start
Starting an on-air operation.

Quick Cue
The tool used to create a playlist 
easily in the ELC Plug-in window or 
the Playlist Viewer window in the 
full-edit mode. 
You can register frequently-used 
device settings as a cue and use it in 
creating a playlist. This allows you to 
create, delete, rename, and sort cues. 
You can also move cues between 
folders, and manage folders.

Robotic Camera
The camera system that allows you to 
control PTZE (Pan-Tilt-Zoom-
Elevation) of cameras from a remote 
site. You can register the camera 
settings as a Shot in advance, and 
recall the shot later.

Shot
Function used to save a PTZE (Pan-
Tilt-Zoom-Elevation) or other status 
set by a camera, recall it and 
reproduce the same status. 
 

Shot Box Module
The MKS-8033A Utility/Shot Box 
Module for the Sony MVS-8000 
Multi Format Switcher system. The 
shot box module is used for 
allocating a variety of manual 
operations while on the air, including 
TAKE operation, or insertion or 
deletion of the DSK. 

Snapshot
The function to save a status set by 
the video switcher in the switcher 
memory, recall it and reproduce the 
same status. It has 99 registers for 
each region, block classified 
according to functions.

Studio Monitor
A monitor display in a studio that 
displays images output from an AUX 
bus of the video switcher.
It is used to display still or video 
images required for programs.

TAKE
Progressing on-air operation to the 
next cue on the playlist, making the 
NEXT Cue the OA Cue.

Transition Icon
A Transition Icon represents a video 
transition setting. Various video 
transition settings are registered as a 
“snapshot” in the switcher, and the 
Transition Icon represents the 
snapshot.  It is used to make the 
transition from one cue to the next 
one.

Video Icon
A Video Icon represents video 
materials of cameras, video servers, 
CG, and DDR. It is used to change 
video materials.

V/K
Video signal and Key signal.
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